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Mircea Buzlea

@naliza sITuaþiei

De ce ne (mai) vrea Europa?

...pe cei încã ne-"plecaþi"... 

Poate ai avut uneori senzaþia cã
în România totul merge "din rãu în
mai rãu". Deºi nu am pretenþia cã s-
ar face primãvarã cu o singurã
floare, mã bucur sã am motive de a
vã încuraja, pe cei care încã nu aþi
"plecat", sau - de ce nu - de a vã da
dreptate celor care v-aþi  "întors"
(din câte se pare, destul de mulþi se
aflã în aceastã situaþie).

Un recent studiu IDC ne face (ºi)
mai încrezãtori în viitorul IT-ului
românesc. Conform acestuia, piaþa
serviciilor IT în România a crescut,
pe parcursul anului 2003, cu 10,7%,
ajungând la o cifrã de 109,27
milioane USD. Integrarea de
hardware a obþinut o cotã
dominantã pe piaþa româneascã a
tehnologiei informaþiei,  însã
serviciile de producþie software ºi
cele de instruire în IT au crescut cu
peste 44,4% ºi, respectiv, 42%.

Sã fie oare din cauzã cã acestea
necesitã mai puþine investiþi i  de
pornire? În opinia mea personalã,
acesta ar fi  principalul motiv al
creºterii respectivelor domenii. În
timp ce pentru integrarea de
hardware ºi chiar pentru service ai
neapãratã nevoie de stocuri,  de
investiþii în echipamente speciale,
producþia de software poate începe
dintr-o camerã de cãmin
studenþesc, dupã cum au dovedit-o
numeroase afaceri de succes din
zilele noastre.

"Totuºi,  în urmãtorii  ani,  ne
aºteptãm la o creºtere aproape egal
divizatã între diferitele tipuri de
servicii" ,  susþine Laurenþiu
Popescu, Senior Analyst la IDC
România. Dacã vrei un "pont",
urmãtoarele favorite ale cursei sunt
"telecomunicaþii le,  producþia ºi
serviciile informatice financiare" -
conform opiniei aceluiaºi analist.
Dar.. .  de unde bani? Ei bine,
pregãtirile pentru eventuala ºi
mult aºteptata (de cãtre unii. . .)
aderare la Uniunea Europeanã se
pare cã va rãspunde (cu un zâmbet
maliþios, probabil. . .)  ºi  la aceastã
întrebare. ªi nu e o Fata Morgana,
ci premisele acestui viitor încep sã
se contureze, prin proiectele de
investiþi i  demarate deja în
România de cãtre giganþii  din
industria mondialã de IT&C.

O veste mai îmbucurãtoare,
poate, decât celelalte, este cã piaþa
informaticã din România este ºi va
rãmâne în urmãtorii ani un mediu
concurenþial. Prin urmare, dacã te
bate gândul sã intri pe aceastã piaþã
ca ofertant, se pare cã încã mai e loc
destul.

Îþi urez mult succes ºi aºtept e-
mailurile tale la adresa
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1. Cum consideri acest numãr al revistei MMyyCC?

F. bun Bun Mulþumitor Slab

2. Ce apreciezi cel mai mult la CD-ul cadou?

Interfaþa Diversitatea

Cantitatea Calitatea 

3. Care articol(e) þi-au plãcut cel mai mult?

_______________________________________________

4. Care articol(e) þi-au displãcut cel mai mult?

_______________________________________________

5. Ce teme ai prefera sã citeºti mai des în MMyyCC?

_______________________________________________

6. Ce ai dori sã mai conþinã CD-ul cadou?

_______________________________________________

7. Din ce localitate ai cumpãrat MMyyCC?

_______________________________________________

8. Se gãseºte MMyyCC la chioºcul tãu preferat?

Da, întotdeauna Nu 

Da, dar sunt puþine exemplare

8. Softul tãu preferat

_______________________________________________

9. Ce rubricã ai mai dori sã conþinã MMyyCC?

_______________________________________________

10. Cât eºti dispus(ã) sã plãteºti pentru un 
program full version original care sã nu 
depãºeascã dimensiunea de stocare a unui CD?

2-300.000 lei 3-500.000 lei 

5-700.000 lei Peste 700.000 lei 

11. Cum ai aflat despre revista MMyyCC?

Radio, TV Ziare, Reviste Internet

Chioºcuri de presã Prieteni, cunoºtinþe 

12. Sistemul tãu are urmãtoarea configuraþie:

_______________________________________________

13. În urmãtoarele 6-12 luni doreºti sã îþi upgradezi
sistemul sau sã-þi cumperi unul nou:

Da Nu

14. Eºti conectat la Internet prin:

cablu dial-up radio GPRS CDMA

15. Cum apreciezi ºtirile zilnice de pe wwwwww..mmyycc..rroo:

utile inutile interesante neinteresante 

Alte observaþii despre situl wwwwww..mmyycc..rroo: 

__________________________________________________

__________________________________________________

16. În domeniul IT, pasiunile tale sunt:

__________________________________________________

__________________________________________________

17. Propunerea ta pentru TToopp  MMyyCC
(cel mai bun articol din acest numãr):

__________________________________________________

CHESTIONAR nr.10 / 2004

TTee  aaººtteeppttããmm  ppee  wwwwww..mmyycc..rroo//ffoorruumm!!

* 

�

MMyyCCââººttiiggãã  ::  Rãspunde la întrebãrile de mai jos pentru a participa la extragerea pentru UUNN AABBOONNAAMMEENNTT  ppee  33  lluunnii la oricare dintre publicaþiile* Media Contact

ABONAMENT
Numele, prenumele / instituþia de învãþãmânt / societatea comercialã

_______________________________________________________________________________

Adresa: Localitatea _________________________________ str. ___________________________

nr. ___ Bloc ______ ap.____ cod poºtal____________________ jud.______________ sector ____

Tel:. ______________________ e-mail: ___________________________ Data: ________________

Tr imiteþ i  acest  ta lon pe adresa redacþ ie i  MMyy  CCOOMMPPUUTTEERR :  Str .  co l .Buzoianu,  nr .  34,  et . 1 ,  cod 410094,  Oradea,  jud.  B ihor .

Semnãtura _______________________

Doresc sã mã abonez pe o perioadã de:

� 3 luni - 244.000 lei    � 6 luni - 416.000 lei    � 12 luni - 844.000 lei

Preþul abonamentului, în sumã de ________________________, l-am achitat cu mandat
nr._________________________ pe numele: Paul Mork, str. Doina, nr. 7, bl. PB 78, ap. 13, 
cod 410326, Oradea, jud. Bihor. 

Comenzile se pot trimite ºi prin fax: 0259-441.526 
sau prin e-mail la abonamente@mediacontact.ro 

�

 

NNuummee//PPrreennuummeellee:: ______________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

AAddrreessaa:: LLooccaalliittaatteeaa ________________________________________________________________________________________    JJuudd..________________________________________________________________________________________  SSttrr..__________________________________________________________________________________________________________  NNrr.. ____________________________

BBll..__________________AApp..______________CCoodd  ssttrraaddaall::________________________                      ____________TTeelleeffoonn//MMoobbiill::  ____________________________        __________________________________________________________________  DDaattaa//lluunnaa//aannuull  nnaaººtteerriiii::  ______________//________________//__________________

EE--mmaaiill ______________________________________________________________________                                                                                                                    ________________                        ____________________________________ NNrr..  mmeemmbbrriilloorr  ffaammiilliieeii::  ________________________________  VVeenniitt//lluunnãã____________                                                ________________________________________________  

SSttuuddiiii____________________________________________________________________________________________________________________________________________________________________________    MMii--aarr  ppllaaccee  ssãã  ffiiuu  aabboonnaatt  llaa  rreevviissttaa  **  ________________________________  ________________________________  ________________________________  ________________________________





Î
n curând, în Franþa nu te
vei mai putea uita la film ºi
sã vorbeºti la celular în

acelaºi timp. Asta deoarece
guvernul a aprobat recent o
decizie prin care teatrele ºi
cinematografele vor avea instalate
aparate ce vor bruia semnalul
telefoanelor mobile. Singurele

numere de telefon care vor mai putea fi accesate
de pe acestea sunt cele dedicate serviciilor de
urgenþã (salvare, poliþie, pompieri). Decizia a fost
luatã deoarece multe cinematografe au cerut sã se
rezolve problema iritantã a persoanelor care
primeau apeluri în timpul celor mai interesante
scene de film ºi îºi începeau cu nonºalanþã
conversaþia în salã. �

SSttaannddaarrdduull  
HHDD--DDVVDD--RRWW
((rreewwrriittaabbllee))  aapprroobbaatt  

DVD Forum a aprobat specifi-
caþiile pentru versiunea RW a
HD-DVD-ului (High Definition/
High Density-DVDs), formatul
fãcând astfel un important pas
cãtre producþia în masã.

La o reuniune din Taiwan,
asociaþia a aprobat versiunea 1.0
a specificaþiilor HD-DVD-RW,
care reprezintã un disc cu un sin-
gur strat cu capacitatea de 20 GB.

Versiunea 1.0 este specificaþia
cheie care permite producãto-
rilor sã dea drumul producþiei
angro folosind noile tehnologii.

Tot în cadrul acestei reuniuni
au fost aprobate specificaþiile 0.9
pentru HD-DVD-R (recordable).
Discurile HD-DVD-R vor fi dis-
curi pe un singur strat având
capacitatea de 15 GB. Versiunea
1.0 se aºteaptã sã fie aprobatã de
cãtre asociaþie în luna februarie a
anului viitor. �

XXeerrooxx  RRoommâânniiaa,,  îînn
mmiiººccaarree

Respectând tradiþia, Xerox
RoadShow - octombrie 2004 a
fost cel de-al doilea turneu al
anului, iar oraºele vizitate au
fost: Braºov, Timiºoara, Cluj, Iaºi
ºi Chiºinãu. În fiecare oraº,
evenimentul a fost gãzduit de
Xerox împreunã cu cei mai
importanþi parteneri locali.

Marius Perºinaru, director
general Xerox România ºi
Republica Moldova, a declarat:
"Anul acesta intenþionãm sã
punem accentul în mod deosebit
pe soluþiile economice destinate
atât activitãþilor de birou cât ºi
utilizatorilor individuali (…).
Formatul turneului ne va per-
mite (…) sã aflãm punctul de
vdere al clienþilor pentru a le
înþelege mai bine nevoile ºi solic-
itãrile ºi a le putea rãspunde în
mod corespunzãtor".

Au fost prezentate în pre-
mierã: DocuMate 252 , DocuMate
510, Xerox 4800, DP 1011,
WorkCentrePro, WorkCentre
M20. �
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U
nui om din China i-a fost refuzatã cererea
de a-ºi numi fiul "@" pentru cã numele nu
poate fi tradus în mandarinã - dupã cum

cere legea.
Localnicul din  Zhengzhou a protestat

afirmând cã "@" este un simbol des întâlnit pe
tastaturi ºi cã rãspândirea lui este de netãgãduit.
Din fericire pentru bietul copil, tatãl lui nu
locuieºte într-o þarã democraticã unde nou-
nãscuþii pot purta orice nume aleg pãrinþii -
inclusiv cel al unor upgrade-uri software sau taste
speciale.

Un alt caz celebru este al lui Jon Blake Cusack

Version 2.0, fiul lui John
Blake ºi Jamie Cusack
din Michigan. Când va
creºte, copilul va avea
sigur o serie de întrebãri
pentru pãrinþii lui.

În curând, e foarte
probabil ca fiul tãu sã
stea în bancã cu Marius
Longhorn sau sã fie
vecin de scarã cu Mihai
/dev/null. �

3
Dsolar a anunþat lansarea unui nou
dispozitiv pentru desktop care afiºeazã
imagini 3D cu posibilitatea de

interacþiune. Compatibil atât cu PC-urile cât ºi cu
Mac-urile, acest dispozitiv proiecteazã o imagine
3D în aer fãrã necesitatea folosirii unei sticle.
Utilizatorii pot interacþiona cu aceste imagini
virtuale prin intermediul mâinii sau a unui obiect.

Compania susþine cã prototipul a fost arãtat
experþilor din domeniu. Acesta urmeazã a fi
produs la scarã micã ºi va costa în jur de 
5000 USD , iar când va fi produs la scarã largã se
estimeazã cã va costa aproximativ 1500 USD.
3Dsolar va expune acest produs la conferinþa
Innovact din Reims (Franþa) în 25 octombrie. Mai
multe detalii despre produs puteþi afla la adresa
www.3dsolar.com. �

C
ompania MXS din Hawaii a anunþat de
curând produsul Cherry OS, un emulator
care va permite PC-urilor sã ruleze Mac

OS X. PC-ul virtual emulat de Cherry OS suportã
pe deplin accesul în reþea ºi oferã acces cãtre
resursele calculatorului - hard disc, procesor,
RAM, FireWire, USB, PCI, PCMCIA sau modem.
Din surse nesigure aflãm cã Cherry OS oferã o
performanþã de pânã 80% din viteza procesorului
calculatorului-gazdã. �

Sistem holografic interactiv 

OS X pe PC
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Franþa ºi China formeazã o alianþã Linux

Brevetele Novell vor apãra Open-Source-ul

C
omisia Pentru Energie Atomicã din Franþa
a anunþat recent cã plãnuieºte sã dezvolte
software bazat pe sistemul de operare

Linux, în cooperare cu Ministerul ªtiinþei ºi
Tehnologiei din China.

Cele douã organizaþii guvernamentale vor
coopera la dezvoltarea unei platforme Linux care
sã poatã fi folositã în mai multe medii printre care
se numãrã PC-urile, serverele ºi PDA-urile.
Sistemul va face uz de servicii online ºi aplicaþii de
comunicaþie.

Guvernul francez a arãtat un interes crescând
în ceea ce priveºte Linux-ul ºi a cerut companiei de
cercetare Unilog sã realizeze un studiu legat de
fiabilitatea instalãrii sistemului de operare pe
17.000 de PC-uri guvernamentale din Paris.

Ministerul francez al echipamentelor a înlocuit
recent serverele Windows NT cu servere Linux în
încercarea de a stopa valul de viruºi ºi atacuri
cibernetice. �

NN
ovell a afirmat cã va face uz de portofoliul
de brevete de care dispune pentru a apãra
produsele sale open-source de posibilele

atacuri din partea altor firme.
Problemele legate de brevete au devenit un

standard în ceea ce priveºte software-ul comercial
ºi gratuit. În August s-au gãsit 283 de posibile
brevete care ar putea sã creeze probleme
sistemului de operare Linux, dar nici unul nu a
fost folosit încã în instanþã.

Experþii afirmã cã aceste probleme se pun în
calea dezvoltãrii programelor, dar în ceea ce
priveºte Novell, compania îºi asigurã clienþii cã pot opta cu încredere pentru open-source. �

C
ompania Microsoft a lansat de curând 10
patch-uri pentru securizarea produselor
sale, printre care 7 considerate foarte

importante. Dacã aceste patch-uri nu sunt aplicate
existã riscul ca un atacator sã preia controlul
asupra unui sistem pe care ruleazã softurile cu
probleme. 

Compania din Redmond îºi sfãtuieºte clienþii
sã descarce ºi sã instaleze aceste programe cât mai
curând posibil (în speþã cele pentru sistemul de
operare Windows, serverul de e-mail Exchange ºi
suita Office).

Alertele de securitate prezintã bug-uri din
câteva componente foarte importante, printre
care capabilitatea Windows-ului de operare a
SMTP-ului (Simple Mail Transfer Protocol, utilizat
pentru expedierea sau recepþionarea de e-mail-
uri), traficul NNTP (Network News Transfer
Protocol), precum ºi o opþiune din Windows
pentru procesarea fiºierelor compresate ZIP. 

Update-urile (denumite MS04-029 - MS04-038)

au fost publicate pe situl oficial ºi pot fi descãrcate
de la adresa (http://www.microsoft.com/

technet/security/CurrentDL.aspx). �

VViieerrmmeellee  ""FFuunnnneerr""
ssee  ddiissttrreeaazzãã  ppee  MMSSNN
MMeesssseennggeerr

Specialiºtii în securitatea PC-
ului au anunþat zilele trecute
apariþia unui nou "vierme", denu-
mit "Funner", care are ca þintã sis-
temul de IM, MSN Messenger. 

Funner se rãspândeºte tri-
miþând copii (funny.exe) ale lui
însuºi cãtre contacte descoperite
prin agendã. Urmãtoarea miºcare
este aceea de a modifica regiºtrii
ºi sã suprascrie intrãrile din
fiºierul Hosts (o listã folositã pen-
tru maparea adreselor IP cãtre
situri web). 

Potrivit cercetãtorilor doar
anumite sisteme Windows sunt
vulnerabile (printre care ºi Win
XP).

Funner a primit din partea
companiei Trend Micro Inc. un
grad mic de risc, motivul fiind
rãspândirea destul de "firavã" a
acestuia. Computer Associates
International Inc. l-au catalogat
pe Funner ca "mediu" din punct
de vedere al posibilitãþii de a
provoca pagube PC-urilor, în
timp ce Symantec Corp. nu
descoperise decât un numãr limi-
tat de infecþii. Toate aceste trei
companii au postat pe siturile lor
instrucþiuni de îndepãrtare a
acestui parazit. �
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Microsoft a lansat 10 noi patch-uri de securitate
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Procese Linux real-time

D
e curând a fost propus un model
de implementare a unor opþiuni
real-time în kernelul Linux.

Acestea ar permite lansarea în mod real a
aplicaþiilor, cam în acelaºi fel în care
sistemul de operare QNX realizeazã acest
lucru. O aplicaþie va fi lansatã în clipa în
care este activatã, fãrã a aºtepta câteva
secunde pentru ca aceasta sã fie încãrcatã
în memorie, în detrimentul unei încetiniri
globale a sistemului de operare.

Propunerea a fost refuzatã de Linus
Torvalds care a spus cã "aproape nimeni
nu foloseºte real-time, nici mãcar în
aparatele embedded."

MontaVista Software va lansa totuºi un
asemenea model pentru aparatele sale
care folosesc Linux pentru redarea rapidã
a înregistrãrilor video, audio, pentru
procesarea semnalelor GPS ºi a
comunicaþiilor radar. �

Sysnet - stand românesc la Photokina

P
remierã pentru România: Firma
ploieºteanã Sysnet Distributions
a spart gheaþa, prezentându-se

cu succes la renumita expoziþie
internaþionalã Photokina.

În perioada 28.09-3.10.2004, Koln-ul a
stat sub egida unui eveniment ce a marcat
întregul mapamond prin importanþa sa.
Cu o frecvenþã din doi în doi ani,
Photokina reuneºte de fiecare datã nume
de prestigiu din lumea tehnologiei foto.

Anul acesta, pe lista expozanþilor a
apãrut ºi România cu un singur nume:
Sysnet Distributions.

Cu ocazia acestui eveniment, Sysnet
Distributions a lansat douã produse: un
nou model de camerã foto digitalã, SYD
DSC 6000 CO, cu zoom optic, o rezoluþie
de 6 MegaPixeli ºi Display de 2", cât ºi
primul model de DVD SYD, compatibil ºi

cu formatul DivX, DVD - 667A.
Astfel, compania româneascã ºi-a

semnalat intenþia de a lãrgi gama de
produse SYD, ce propunea pânã la
Photokina camere foto digitale ºi
dispozitive digitale multifuncþionale
(reportofoane, Mp3 playere etc),
consolidându-ºi totodatã poziþia pe piaþa
de profil. �

Mp3 player cu hard disc de 60 GB 

T
oshiba a lansat o nouã serie de
mp3 playere (gigabeat® F) care,
printre multele dotãri sofisticate

încorporeazã un ecran color ºi un hard
disc de 60GB cu mãrimea de 1,8 inci.
Navigarea printre meniuri este asiguratã
de semnul în formã de plus ºi afiºarea are
loc pe un ecran LCD de 2,2 inci QVGA

color. Toate trei modelele din aceastã serie
au integrat un hard disc de 1,8 inci cu
capacitãþi de 10, 20 ºi 60 de GB. Spaþiul de
10 GB asigurã stocarea unui numãr de 2500
de melodii lungi de 4 minute fiecare,
înregistrate la 128kbps în format .wma iar
celelalte douã pot stoca 5000 ºi aproximativ
15000 de astfel de melodii. Software-ul

"gigabeat Room" este
dezvoltat de compania
Toshiba special pentru
domeniul muzicii, ºi poate
îndeplini funcþii de CDDB
pentru afiºarea informaþiilor
despre albumul ascultat sau
poate transfera melodii între
playerele gigabeat. Dispo-
zitivul va fi disponibil pe
piaþã la sfârºitul lunii
noiembrie. �
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Macromedia a lansat Captivate

CC
aptivate, cunoscut pânã recent sub

numele "RoboDemo", este

un program pentru

înregistrarea activitãþii de pe

desktop, cu posibilitatea de creare a

prezentãrilor ºi a demonstraþiilor

interactive. Numele programului a

fost schimbat pentru cã RoboDemo

era cunoscut doar pentru capacitatea

de înregistrare a activitãþii, nu ºi de

creare a conþinutului interactiv.

Printre noile caracteristici ale programului se

include o mai mare posibilitate de integrare cu

programul Flash; acum poþi exporta

conþinutul din Captivate direct în Flash

MX 2004 pentru vizionarea imediatã pe

Web. Folosit împreunã cu Macromedia

Breeze poate oferi o instruire rapidã,

putând transforma persoana pasivã

care urmãreºte materialul în

participant activ. Programul Captivate

va fi lansat în 9 Noiembrie. Mai multe

informaþii poþi gãsi pe situl

www.macromedia.com �

Adobe a propus un nou format de fiºiere

A
dobe Systems Inc. a propus un nou

format pentru de fiºiere pentru imagini

DNG. Aceastã iniþiativã a fost luatã

pentru a creºte compatibilitatea dintre toate

tipurile de camere foto ºi software-ul folosit.

Majoritatea camerelor din ziua de azi captureazã

imagini în formatul JPEG, dar formatul RAW

câºtigã tot mai multã popularitate. Producãtorii de

camere foto folosesc programe ºi formate de fiºiere

proprietare, care împiedicã transferul rapid al

fiºierelor. Prin introducerea noului format se poate

evita instalarea unui numãr mare de programe

pentru gestionarea fiºierelor. Compania a propus

standardizarea noilor specificaþii ale formatului

DNG ºi a pus la dispoziþie un program pentru

conversia din 65 de formate în formatul DNG. �

P
roducãtorul korean de Mp3 Player Woodi

a lansat un nou player portabil elegant

care pe lângã obiºnuitul mp3 suportã ºi

formatul OGG.

Dispozitivul

Woodi Cool are

o carcasã for-

matã din douã

"plãcuþe" trans-

parente din

plastic care ascund mufa USB. Woodi Cool este

compatibil cu

toate

sistemele de

operare care

recunosc

dispozitivele USB ºi integreazã o memorie de 256

MB sau 512MB, un tuner radio FM, poate rula

formatele Mp3, OGG, ºi WMA, firmware-ul

dispozitivului este upgradabil ºi cântãreºte doar

43 de grame. Pentru mai multe detalii vizitaþi situl

http://woodi.co.kr/product_22. html. �

P
hilips a lansat un nou TV LCD de 23 inci

numit Streamium TV. Modelul pentru

Europa are seria 23iF9946, iar

televizorul LCD se poate conecta direct la PC

fãrã nici un cablu datoritã tehnologiei wireless. 

Noul TV Philips suportã pornirea trailerelor

video direct de pe Internet, vizualizarea

fotografiilor etc. Modelul integreazã ºi un tuner

radio FM, iar rezoluþia nativã a TV-ului este de

1280x768 pixeli. 

Pentru mai multe detalii vizitaþi link-ul

http://www.streamium.com/products/

streamiumtv/features.cfm. �

SSoonnyy  DDVVDDiirreecctt
VVRRDD--VVCC1100  

Sony a lansat un inscriptor

de DVD-uri extern (stand alone)

numit DVDirect. Dispozitivul

Sony VRD-VC10 se poate conec-

ta direct la camera video sau la

VCR pentru a transfera direct

imaginile video pe un disc DVD.

De asemenea, dispozitivul

conectat la un PC poate fi folosit

ca ºi inscriptor de DVD-uri

(DVDRW). VRD-VC10 poate

înregistra pânã la 12 ore, calitate

MPEG 2 pe un disc DVD+R DL

ºi pânã la ºase ore pe DVD-urile

+, - cu un singur strat. Aparatul

se poate conecta prin USB, iar

viteza maximã de scrie a DVD-

urilor +R este 16x. Sony

DVDirect VRD-VC10 va fi dis-

tribuit începând cu aceastã lunã

la preþul aproximativ de 300

USD. �

VViirrggiinn  EElleeccttrroonniiccss
aa  llaannssaatt  uunn  nnoouu
MMpp33  PPllaayyeerr  ppoorrttaabbiill
ddee  55GGBB

Noul dispozitiv de la Virgin

Electronics poate stoca 5GB de

Mp3-uri adicã peste 1200 de

piese audio sau mai mult de 80

de CD-uri audio. Dispozitivul

costã 249 de USD ºi  integreazã

pe lângã hard discul de 5GB, un

tuner radio FM, ºi douã mufe

jack de ieºire pentru a putea

împãrþi plãcerea de asculta mu-

zicã ºi cu un alt prieten.

Dispozitivul poate opera ºi cu

formatul WMA ºi are o protecþie

de 25 minute în cazul trepidaþi-

ilor accidentale. Pentru mai

multe detalii vizitaþi situl

www.virginelectronics.com. �
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Player portabil OGG: Woodi Cool Music Player

Wireless TV LCD: Philips Streamium de 23 inci



EVENIMENT

B
ucureºti, 14 octombrie, 2004 - În
seara zilei de 13 octombrie, în
atmosfera elegantã oferitã de

Fashion Bar, completatã cu un spectacol
de balet ºi muzicã clasicã, BenQ a anunþat
în cadrul "BenQ & MTV Stylissmo Party"
lansarea celei mai "sweet 'n stylish"
camere digitale - DC E40. În cadrul eveni-
mentului, invitaþii au avut posibilitatea
de a testa camera ºi de a participa la o
tombolã care a avut ca premiu o camerã
digitalã BenQ DC E40.

Ecranul camerei este primul LCD pen-
tru camerã digitalã, conceput de BenQ în
premierã, care permite personalizarea
fotografiilor. În plus, poþi sã desenezi în
mod creativ, direct pe fotografii.

Camera E40 de la BenQ poate
funcþiona de asemenea ca un mini video
recorder pentru filme scurte. Utilizând
tehnologia de comprimare MPEG4 de
ultimã orã, E40 asigurã o calitate supe-
rioarã a materialului filmat, cu o utilizare
redusã a capacitãþii memoriei de pe 
card. �

.
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B
ucureºti, 13 oct - Logitech, unul
dintre cei mai importanþi
producãtori mondiali de

componente periferice pentru computere,
a anunþat lansarea noilor sale produse ºi
pe piaþa IT din România. 

"Logitech este un brand foarte dinamic
a cãrui notorietate în România creºte
rapid. Aºteptãm o continuare a creºterii de
25 la sutã anual ºi o extindere a categoriilor
de produse comercializate. Intenþionãm
sã extindem comercializarea ºi a
produselor premium, nu numai pentru
PC, ci ºi a celor pentru consolele de jocuri.
De asemenea, ne vom axa ºi pe
promovarea accesoriilor pentru
telefoanele mobile dar ºi pe telecomenzi
inteligente", a declarat Teodora Bernarello,
channel marketing & PR - SEER la
Logitech.

Familia de produse Logitech include
dispozitive de imagine - webcam-uri,
mouse-uri, tastaturi, speakere, precum ºi
periferice pentru jocuri. 

La întâlnirea din 12 octombrie, alãturi
de jurnaliºti, au fost prezenþi din partea
Logitech Katharina Tarmann-Droescher
(General Manager EER, Grecia & Israel),
Garreth Hayes (European Product
Manager - Internet Communication and
Telephony), Teodora Bernarello (Channel
marketing & PR pentru Europa de Sud-
est), Michael Koszegi (Sales Manager
pentru Europa de Sud-est) ºi Biliana
Hristova (PR & Marketing Manager
pentru Grecia, Ucraina, Bulgaria). �

Primul eveniment Logitech în România

Specificaþii tehnice:

Senzor CCD 4.23 megapixeli 

Lentile 35 mm (35mm
echivalent film) 

Gamã focalizare Macro: 30 cm la 100 cm
Normal: 100 cm la infinit

Zoom digital 4x

Mod - filmare
Clip filmat: format ASF.

320 x 240 Pixeli cu
sunet (continuu), 30 cps

Stocare imagini Memorie internã 8MB /
Card SD

Sursã alimentare
Baterie litiu-ion reîncãr-
cabilã /Adaptor C/A /
Cablu USB

Ecran LCD LCD color 1,5" LTPS

Greutate 125 g (fãrã baterie)

Dimensiuni (L x Î x A) 100,8 x 55,2 x 27,5 mm 

BenQ lanseazã în România camera digitalã E40
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D
eep Freeze este o aplicaþie simplã
pentru protejarea datelor. Aceasta
reface structura datelor de pe

hard disc la resetarea calculatorului. Dupã
momentul în care instalezi programul ºi
resetezi calculatorul datele vor fi protejate.
La orice restartare ulterioarã a calculatoru-
lui acestea vor fi restaurate la forma în care
erau la instalarea programului. Acesta este
compatibil cu toate aplicaþiile ºi asigurã o
funcþionare normalã, fãra limitãri de funcþii
sau spaþiu. Astfel, printr-o singurã parolã
poþi "îngheþa" sistemul, toatã lumea îl poate
accesa ºi poate folosi resursele dupã bunul
plac, iar la resetare totul se reia de la zero.
Programul este conceput pentru calcula-
toarele care sunt folosite de mai mulþi uti-
lizatori, pentru a elimina suportul tehnic.
În cazul în care cineva ºterge din greºealã
un fiºier de sistem sau un fiºier fãrã de care
calculatorul nu ar mai funcþiona corect,
totul se reparã printr-o simplã resetare a
staþiei respective. Orice program instalat
sau orice virus vor dispare la resetare. 

Programul este disponibil în trei vari-
ante: Standard, Professional ºi Enterprise,
pentru a acoperi necesitãþile diferitelor
tipuri de companii. Dacã foloseºti o staþie
protejatã de Deep Freeze ºi doreºti sã
salvezi un fiºier, un simplu document, cum
procedezi? Poþi salva datele în reþea pe un
calculator neprotejat, pe o dischetã sau pe

un CD. Dacã
aceste metode nu
sunt suficiente atunci
trebuie sã apelezi la
versiunea Deep Freeze
Professional care îþi
pune la dispoziþie un
director care este
neprotejat, în care
poþi salva datele.

Programul nece-
sitã pentru rula-
re unul din sis-
temele de operare 
Windows 95/98/Me/
2000/XP ºi 10% spaþiu
liber pe hard disc pentru o
funcþionare corectã. Programul este con-
ceput în aºa fel încât o resetare a calcula-
torului va eradica orice schimbare ºi va
restaura tot, pânã la ultimul bit. Dupã
spusele celor de la Faronics, dezvoltatorii
acestui program, chiar ºi simpla defrag-
mentare nu îºi mai are rostul pentru cã
structura de date va fi refãcutã. Dacã
defragmentarea hard discului a fost fãcutã
înaintea instalãrii programului, acesta va fi
gata defragmentat la orice resetare. Acelaºi
lucru este valabil ºi pentru orice aplicaþie
de optimizare a funcþionãrii sistemului de
operare, dacã a fost fãcutã înaintea
instalãrii programului, nu mai trebuie 

refãcutã.
Din modul protejat poþi ieºi

numai printr-o resetare, astfel dupã ce
introduci parola ºi selectezi deprotejarea
sistemului, acesta va fi încã protejat, pânã
la resetarea staþiei respective. Opþiunea de
hibernare a calculatorului va avea acelaºi
efect ca o resetare sau o oprire normalã,
pentru cã în acest caz sistemul de operare
copiazã informaþia din RAM ºi o scrie pe
hard disc, iar programul Deep Freeze va
ºterge automat la resetare informaþia care a
fost scrisã pe discul fix. Dupã instalarea
programului apãsarea tastelor F5 ºi F8 la
iniþializarea sistemului de operare nu vor
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mai avea nici un rol, dar dacã totuºi prin
alte metode se ajunge în Safe Mode sis-
temele pe care ruleazã Windows 95/98/Me
nu vor mai fi protejate, spre deosebire de
cele pe care ruleazã Windows 2000/XP ºi
care vor fi protejate în continuare.

CCee  ssee  îînnttââmmppllãã  ddaaccãã  uuiitt
ppaarroollaa??  

La ora actualã nu existã nici un program
sau un backdoor care sã înlãture parola.
Dacã ai cumpãrat o licenþã a programului ºi
ai uitat parola, existã o metodã de recupe-
rare a datelor, dar trebuie sã trimiþi un 
e-mail la adresa  support@faronics.com

pentru a primi mai multe informaþii despre
modul de recuperare. Dacã foloseºti versi-
unea de evaluare existã o metodã foarte
simplã, trebuie sã intri în BIOS ºi sã dai
înainte ceasul cu 60 de zile. Toate celelalte
metode postate pe Internet presupun
folosirea unei dischete pentru pornirea cal-
culatorului, dar pentru o protecþie maximã
trebuie sã protejezi BIOS-ul prin parolã ºi
sã înlãturi posibilitatea de îniþiere a sis-
temului de operare de pe dischetã. În plus,
programul Deep Freeze protejeazã BIOS-ul
de programe precum killcmos.exe care
încearcã sã rescrie, sã modifice sau sã afle
parola BIOS-ului din sistemul de operare
folosit. La expoziþiile la care a participat,
compania Faronics a oferit pe loc un pre-
miu 1000 USD celui care reuºea sã treacã de
protecþia programului Deep Freeze.
Calculatoarele au fost instalate conform
recomandãrilor specialiºtilor firmei, nimeni
nereuºind sã înlãture protecþia iar cei 1000
USD au rãmas neacordaþi.

Schimbãrile fãcute de viruºi sunt restau-
rate la resetarea calculatorului, deci putem
considera acest program mai mult decât un
antivirus normal, pentru cã protejeazã 
PC-ul ºi de viruºii viitorului (care oricât de
avansaþi ar fi, nu vor avea nici un efect,
pentru cã modificãrile fãcute de ei vor fi
anulate).

Programe precum AutoCad sau 3D
Studio Max întâmpinã probleme de licenþã
la rulare pentru cã folosesc o metodã de
protecþie la copiere care necesitã scrierea pe
hard disc la nivel fizic. Aceasta este înlãtu-
ratã la restartarea calculatorului, pentru
aceste programe fiind indicatã folosirea
manager-ului de licenþe de reþea. Versiunea
Deep Freeze Enterprise oferã posibilitatea
controlului funcþionãrii programului prin
reþea ºi opereazã în douã moduri: LAN sau
LAN/WAN. Staþiile de lucru configurate în
LAN folosesc UDP-ul pentru transmiterea
datelor la staþia de la care are loc comanda.
Staþiile configurate în modul LAN/WAN
sunt identificate prin intermediul adresei
IP ºi folosesc portul 1971 pentru transferul
datelor.

Calculatoarele din Internet Cafe-uri ºi
laboratoarele ºcolilor pot fi extrem de uºor
de protejat prin instalarea acestui program,
iar munca administratorilor este redusã la
minim. Conform unui studiu recent, profe-
sioniºtii din domeniul IT îºi petrec 50% din
timp diagnosticând, înlãturând software-
uri nedorite ºi aplicând patch-uri pentru
asigurarea funcþionãrii corecte a sistemului
pe care lucreazã.

MMaaii  mmuullttee  iinnffoorrmmaaþþiiii  ddeesspprree
mmoodduull  îînn  ccaarree  ffuunnccþþiioonneeaazzãã
pprrooggrraammuull??  

Vik Khanna directorul de vânzãri al
companiei Faronics a explicat cum, dupã
instalare, programul îngheaþã teoretic tot
spaþiul folosit de fiºiere. Asupra acestei
pãrþi a hard discului nu poate avea efect
permanent nici o modificare. Însã mai
multe detalii despre modul în care
funcþioneazã programul nu au putut fi

divulgate pentru protejarea tehnologiei.
Personal, bãnuiesc cã spaþiul liber (în pro-
cent minim de 10%) de pe partiþie este
folosit pentru stocarea modificãrilor tem-
porare sau a datelor noi, care vor fi ºterse la
repornire, iar spaþiul ocupat este protejat la
ºtergere. Dacã instalezi un program, el va
folosi acel spaþiu pentru rularea ºi
funcþionarea normalã, pânã la resetarea
calculatorului. Dacã de exemplu ºtergi tot
conþinutul discului, la repornirea calcula-
torului datele protejate sunt refãcute chiar
dacã virtual au fost ºterse. Orice fiºier creat
dupã instalarea programului va folosi
spaþiul gol de pe disc, care oricum va fi ºters
la resetare. Aceasta ar fi un mod de expli-
care a faptului cã nici o modificare nu este
permanentã, incluzând fiºierele cu extensia
.tmp sau favorites-urile din Internet
Explorer. Tot ce ocupã spaþiu nu poate fi
ºters, iar tot ce va ocupa spaþiul gol va fi
ºters … Aºa aº explica eu funcþionarea pro-
gramului, de care oricum se pare cã nu
vom fi lãmuriþi foarte repede (pentru pro-
tejarea tehnologiei).

Cu peste 4 milioane de descãrcãri
(www.faronics.com), programul se în-
cadreazã în categoria utilitarelor în ade-
vãratul sens al cuvântului. Probleme legate
de funcþionarea programului sigur vor
apare, dar suportul tehnic oferit de compa-
nia Faronics (support@faronics.com) a fost
lãudat ºi se pare cã este unul dintre cele mai
bune (cel puþin aºa ar trebui pentru cã este
vorba de siguranþa datelor de pe hard disc,
lucru care l-au garantat prin instalarea pro-
gramului). În încheiere vã doresc date cât
mai îngheþate ºi mai conservate! �

RReemmuuss  ZZooiiccaa

remus@myc.ro

CCoonnffiigguurraarreeaa  îînn  rreeþþeeaaSSeelleeccttaarreeaa  ddrriivveerreelloorr  ppeennttrruu  pprrootteejjaarree
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C
eea ce-i lipsea Linux-ului deja de

prea mult timp era un editor

HTML de talia Dreamweaver-ului.

O soluþie WYSIWYG (What-You-See-Is-

What-You-Get) care sã nu ne mai deranjeze

cu codul sursã. Un rãspuns care s-a bucurat

de suportul utilizatorilor s-a dovedit a fi

NVU.

Produs de aceeaºi companie care scoate

pe piaþã sistemul de operare Linspire (fos-

tul LindowsOS), NVU este o aplicaþie care

se bazeazã pe motorul Gecko, folosit în

prezent ºi de browserul Mozilla. Gecko

oferã un suport remarcabil pentru CSS,

XML ºi JavaScript. Existã desigur ºi alte

programe de editare HTML care pot fi

folosite în KDE sau Gnome, dar acestea

sunt fie prea simpliste, fie prea scumpe.

IBM Websphere Homesite Builder este un

produs comercial care nici mãcar nu este

nativ în Linux, el necesitând folosirea unei

versiuni WINE modificatã. Screem ºi

Quanta nu au un mod WYSIWYG deºi la

partea de editare direct în cod se descurcã

mai mult decât bine. O ultimã opþiune pe

lângã NVU ar constitui-o Macromedia

Dreamweaver care oferã o funcþionalitate

de 95% în Crossover Office 3.0. Era sã uit

de Bluefish, un alt editor WYSIWYG, dar,

dupã cum vei vedea, NVU îl detroneazã

hotãrât.

Dar scopul acestui articol este nu sã

descrie soluþii de emulare ci un editor

HTML care sã ruleze în Linux fãrã a necesi-

ta WINE.

Ultima versiune NVU se aflã la numãrul

0.41 ºi se descurcã magnific având în

vedere faptul cã numãrul de versiune nu

începe mãcar cu "1".

NNVVUU  --  MMoodduull  ddee  vviizzuuaalliizzaarree  ““NNoorrmmaall””
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Existã multe lucruri care diferenþiazã
NVU de alte editoare HTML din Linux.
Unul dintre ele este prezenþa unui "FTP
Site Manager" care permite navigarea prin
fiºierele site-ului creat, accesând un panou
lateral. Un altul este o aplicaþie integratã
numitã "Color Picker", folositã la
manevrarea culorilor. NVU are suport ºi
pentru Tab-uri, cam în acelaºi fel pe care îl
întâlnim ºi în FireFox, fiecare tab având
istoria lui undo/redo. Poate cel mai impor-
tant element pe care noul NVU îl oferã este
un editor CSS numit "CaScadeS". Deoarece
NVU se aflã încã în faza de dezvoltare, edi-
torul CSS nu are deocamdatã decât suport
pentru schimbarea proprietãþilor fonturilor
ºi ale marginilor, însã în ritmul în care
proiectul evolueazã s-ar putea ca pânã la
sfârºitul anului sã vedem un NVU v.1.0
care sã aibã înglobate toate facilitãþile pe
care CSS le oferã.

Ce mi-a plãcut în NVU a fost faptul cã
îmi permite sã lucrez cu layere, la fel ca ºi în
cazul Macromedia Dreamweaver. Inserarea
tabelelor este extrem de uºoarã: se
efectueazã un click pe butonul "Table" si se
alege cu mouse-ul o serie de casete din fe-

reastra care apare. Tabelul aºezat în paginã
poate fi customizat mai departe prin
selectarea lui ºi efectuarea unui right-click
pe el. Din meniul contextual alegem "Table
Cell Properties".

Pentru textul din HTML avem aceleaºi
opþiuni ca ºi în cazul unui editor de text
avansat: îngroºare, selectare font, setare
mãrime font, aliniere, etc. Inserarea unui
link se face selectând un text ºi apãsând
butonul... Link. În caseta care apare se scrie
URL-ul.

În cazul imaginilor avem o mulþime de
opþiuni, de la poziþionarea lor în paginã ºi
pânã la asignarea de comentarii pentru
acestea.

NVU are chiar ºi o aplicaþie de spell-
checking cu un dicþionar în limba englezã,
folositor când creãm pagini web în acestã
limbã.

Dupã terminarea editãrii unui site web,
avem posibilitatea de a-l "încãrca" direct pe
server folosind tot NVU. Apãsãm "Publish"
ºi ne apare primul ecran al Site Manager-
ului din program. Trecem un titlu al
paginii, URL-ul ei si FTP-ul pe care dorim
sã o aºezãm.

Editorul are o opþiune de inserare a
unui buton "Made with NVU" în paginile

create, buton al cãrei imagine este copiatã
automat de pe situl www.nvu.com. Legat
tot de imagini, dacã poposim cu mouse-ul
deasupra unei imagini inserate, dacã aceas-
ta este legatã de un link, acesta ne va fi
prezentat într-un tooltip care pluteºte dea-
supra ei.

În cazul celulelor din tabele, dacã facem
un click cu mouse-ul în interiorul acestora
în modul "Normal" al editorului, în mijlocul
chenarelor acestora va apare câte un cerc
cu câte o sageatã în stânga, respectiv în
dreapta lui. Sãgeþile pot fi apãsate ºi ne
indicã direcþia în care va fi inseratã o nouã
celulã. Dacã apãsãm pe cerc, caseta va fi
ºtearsã. E un mod uºor ºi comod de a adãu-
ga ºi înlãtura celule sau tabele întregi.

În rest, deºi nu se bucurã de toate opþiu-
nile de care dispune Dreamweaver, NVU 
s-a dovedit un editor HTML care îºi face
treaba ºi o face bine. Dacã versiunea 0.40 se
prezintã astfel, sunt curios ce ne va oferi
versiunea 1.0. �

RRããzzvvaann  TT..  CCoolloojjaa

razvan@myc.ro

TTaagg--uurrii  HHTTMMLL MMoodd  vviizzuuaalliizzaarree  ccoodd--ssuurrssãã

IInnsseerraarree  ttaabbeell CCrreeaarreeaa  uunnuuii  ssiitt PPrroopprriieettããþþii  iimmaaggiinnee



Internetul a fost marcat în ultima perioadã de titluri precum: "Rãzboiul browserelor", "Microsoft ar trebui sã se
îngrijoreze", "Bãtãlia reîncepe"... Sunã mai mult a titluri de filme eroice decât o poveste despre browsere...

Existã totuºi o undã de adevãr în toatã aceastã forfotã.  De fapt, cine ºi de ce a iscat aceastã agitaþie? De ce în
ultimul timp se vorbeºte tot mai mult despre browsere ºi competiþia din ce în ce mai strânsã dintre acestea?

Browserul este pentru utilizatorii Internetului acea "bucãþicã" de software care nu este bãgatã în seamã decât
atunci când se blocheazã sau realizeazã o acþiune care ne iritã.

Despre un astfel de rãzboi se mai vorbea prin anii '90, atunci când Microsoft a câºtigat supremaþia în duelul cu
Netscape. Piaþa s-a închis, upgrade-urile au fost din ce în ce mai rare, iar încercãrile concurenþei de a se împotrivi
gigantului au rãmas fãrã ecou. 

Dupã obþinerea monopolului, a avut loc un fenomen ciclic de care Microsoft a profitat fãrã cel mai mic efort pen-
tru a-ºi menþine poziþia: a câºtigat simpatia dezvoltatorilor web care s-au strãduit sã optimizeze paginile pentru
ca acestea sã fie redate cât mai corect în IE. Astfel, Microsoft a creat un nume care este întreþinut de dezvoltatorii
care nu au nici cel mai mic interes sã creeze pagini pentru browsere care nu deþin nici 2% din piaþã.
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Specialiºtii cred cã, dupã câºtigarea
pieþei, Microsoft fie s-a culcat pe laurii
victoriei, fie a avut alte lucruri mai bune
de fãcut. Personal, cu toate cã reprezen-
tanþii companiei au negat cu vehe-
menþã acest lucru, nu mi se pare cã
William "s-a omorât" prea tare cu dez-
voltarea navigatorului IE.  

Ce reprezintã pentru utilizatorul de
rând tot acest "tam-tam"? În general,
acesta este mulþumit dacã poate sã
ajungã la o anumitã paginã fãrã sã-i
aparã pe ecran vreo eroare "fatalã", sau
casete publicitare (pop-up-uri) etc. 

Înainte de toate, trebuie sã spun cã
aº putea face o împãrþire a utilizatorilor
Internetului (mai degrabã a atitudinii
faþã de navigatoare) în douã mari cate-
gorii, ºi asta deoarece au existat multe
discuþii pe aceastã temã.

În primul rând existã categoria
"tradiþionalistului" care nu ar schimba
IE-ul nici dacã ar ieºi un "bug" din mo-
nitor. "Sã fie simplu ºi sã-mi deschidã
paginile favorite", aceasta este mentali-
tatea. De cealaltã parte a baricadei se
gãseºte utilizatorul modern, "multio-
peraþional". Acesta doreºte ca naviga-
torul pe care-l utilizeazã sã fie un veri-
tabil corn al abundenþei: navigare
rapidã, client de mail, client de IRC,
grupuri etc. Pe scurt: simplitate sau
diversitate. Nu se pune problema sã
condamni o categorie sau alta. Însã, sin-
cer sã fiu, am întâlnit persoane care n-ar
fi renunþat pentru nimic în lume la IE,
pentru ca în cele din urmã sã migreze
cãtre alte browsere, dar nici un caz în
care un utilizator Opera sau Mozilla sã
se alãture IE-ului. 

Cred cã douã dintre cele mai impor-

tante lucruri pentru care IE mai con-
troleazã încã piaþa navigatoarelor sunt
lipsa de informare ºi comoditatea uti-
lizatorului. Puþin sunt cei care, odatã ce
s-au lãsat convinºi sã încerce ºi altceva,
nu au renunþat la IE. 

O altã piedicã în echilibrarea pieþei
navigatoarelor a fost preconcepþia cã
browserele sunt niºte softuri puþin sem-
nificative, sunt acel bun de care nu-þi
dai seama decât atunci când nu-l ai sau
îl ai dar îþi creeazã probleme, la fel ca ºi
aerul.

În ultimii ani însã mentalitatea s-a
schimbat, începând sã-ºi facã apariþia
chiar anumite probleme care au obligat
utilizatorii sã se gândeascã la alterna-
tive. Au început sã se audã vociferãri,
iar în privirile utilizatorilor au apãrut
urme de îndoialã. Vulnerabilitãþile din
IE au început sã dea tot mai mari bãtãi
de cap. Simplitatea excesivã care a
început sã îngrãdeascã libertatea celor
ce navigheazã pe Internet. Suportul
destul de slab pentru CSS. Toate acestea
nu sunt altceva decât mobilul "rãzboiu-
lui" de care vorbeºte toatã lumea pe
Internet.

Am aºteptat aceastã lansare câteva
luni, ºi nu pot sã spun cã m-a supãrat
prea tare nerespectarea termenului de
lansare prognozat. Pe de altã parte este
bine de ºtiut cã aceasta nu este versi-
unea finalã, ci doar un fel de versiune
"beta". (Preview Release)

Kitul de instalare este destul de mic
(4,74MB - îl gãseºti ºi pe CD-ul revistei
la categoria Freeware) ºi poate fi descãr-

cat de la adresa http://www.mozilla.

org/products/firefox/.
Instalarea decurge fãrã cea mai micã

problemã (poþi sã alegi între versiunea
"standard" sau "custom", neexistând
mare diferenþã între cele douã). 

În cazul în care ai avut instalatã altã
versiune ºi extensii, ºi nu le-ai dezinsta-
lat în prealabil, atunci este foarte pro-
babil cã vei întâmpina numeroase erori,
din cauza incompatibilitãþii dintre ver-
siuni. Prin urmare, îþi recomand ca
înainte de a instala Firefox 1.0, "sã scapi"
de versiunea anterioarã ºi de extensii,
pe care oricum le poþi instala din nou
foarte simplu. 

Partea bunã a faptului de a instala
peste versiunea anterioarã este cã
setãrile ºi preferinþele rãmân intacte.

Unul dintre lucrurile pentru care
Firefox ar trebui sã primeascã cu sigu-
ranþã un premiu este modul în care a
încercat ºi, cred eu, a reuºit sã împace
cele douã categorii de utilizatori de care
vorbeam ceva mai devreme. Browserul
în sine se adreseazã în primul rând
acelor persoane care sunt interesate de
navigarea pe Internet ºi nimic altceva.
Nici o împopoþonare, nici o altã opþiune
suplimentarã. O interfaþã simplã ºi
intuitivã, astfel încât ºi cel mai neiniþiat
utilizator sã se poatã descurca fãrã
probleme.

Nu te încadrezi în aceastã categorie
ºi vrei opþiuni suplimentare, cât mai
multe ºi mai diverse? Nici o problemã,
deoarece ai la dispoziþie extensiile care
îþi permit sã diversifici foarte mult expe-
rienþa pe care o vei trãi alãturi de acest
browser. Însã despre skinuri ºi extensii
voi vorbi ceva mai târziu. 

IInntteerrffaaþþaa  FFiirreeffooxx::  mmaaii  ssiimmpplluu  ddee  aattââtt  nnuu  ssee  ppooaattee IInnssttaallaarreeaa  uunneeii  aallttee  iinntteerrffeeþþee
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Este inevitabil ca atunci când testezi
un produs nou sã nu-l compari cu ceea
ce existã pe piaþã, cu ceea ce deja
foloseºti. ªi cum eu nu mai folosesc de
mult timp IE-ul, nici nu mai consider
acest browser un punct de referinþã.

Avant-ul ºi Maxthon-ul (clãdite într-
adevãr pe engine-ul IE) pe de o parte ºi
Opera pe de alta, sunt navigatoarele cu
care am comparat Firefox-ul în testul
nostru.

Strategia de migrare cãtre Firefox pe

care au pus-o la cale creatorii naviga-
torului pare una foarte atentã ºi am
reuºit sã-mi dau seama de acest lucru
observând anumite detalii aparent
puþin semnificative. De la meniul [File]
- [Import], poþi sã imporþi cu ajutorul
unui singur clic, parole, opþiuni, pagini
favorite sau vizitate din Opera sau IE,
adicã de la concurenþii principali. Pare
într-adevãr un amãnunt, peste care

totuºi Opera ºi IE au trecut dupã pã-
rerea mea cu multã superficialitate
(existã aceastã opþiune ºi în cele douã
browsere, însã nu este atât de bine ºi de
simplu implementatã).

Fãrã îndoialã cã browsingul modern
se bazeazã pe navigarea în aceeaºi fe-
reastrã (mai multe pagini, o singurã fe-
reastrã). Un alt amãnunt, dar ... se
adunã, nu? :)

Toate aceste amãnunte par nesemni-
ficative pentru cei care nu au testat ºi
nu au profitat de aceste opþiuni, aºa cã
cel mai bun lucru pe care-l poþi face
înainte de a da un verdict este "sã te
joci" puþin cu ele ºi sã vezi cât de folosi-
toare sau inutile sunt. 

Nu am petrecut prea mult timp
printre meniuri ºi asta din cauzã cã
acestea sunt destul de sãrãcãcioase, însã
oferã strictul necesar, cum spuneam ºi
la începutul articolului.

Astfel, nu lipsesc: 
- paginile favorite ([Bookmarks]);
- posibilitatea de a scrie/citi 

e-mail-uri;
- opþiunea Full-screen (F11);
- consolã JavaScript ([Tools] -

[JavaScript Console]);
De la meniul [Tools] - [Options] vei

accesa caseta cu setãrile principale,
unde vei gãsi cinci categorii ("General",
"Privacy", "Web Features", "Downloads"
ºi "Advanced" ) fiecare cu alte subcate-
gorii. Printre altele, vei gãsi aici:

- setarea paginii de start;

- setãri legate de modul de
conectare;

- administrarea parolelor, cache-ului,
paginilor vizitate, formularelor, cookie-
urilor, download-urilor;

- blocarea pop-up-urilor;
Foarte utile mi se par opþiunile de

blocare a casetelor/paginilor cu reclame
ºi modul de administrare a parolelor.
Astfel, browserul poate reþine toate
parolele de pe paginile unde ai un cont.
Dacã eºti unic utilizator al unui PC, nu
va mai trebui ca de fiecare datã sã
tastezi aceleaºi parole, deoarece
browserul va completa automat aceste
date, iar tu va trebui doar sã dai un clic
pe butonul "Login". În cazul în care nu
eºti unic utilizator, poþi sã setezi ºi o
parolã "master", un fel de "parolã pe
parole", pe care va fi suficient sã o intro-
duci o singurã datã la începutul unei
sesiuni de lucru ([Tools] - [Options] -
[Privacy] - [Saved Passwords]).  

Spuneam cã adepþii unui browser
multifuncþional nu au fost uitaþi. Mai
mult de atât, aceºtia pot sã aleagã ce
anume sã instaleze ºi ce nu.

Dacã doreºti de exemplu sã schimbi
interfaþa ([Tools] - [Themes]), poþi acce-
sa pagina https://update.mozilla.

org/themes/ ºi sã descarci de aici una
dintre numeroasele teme existente.
Pentru ca noua interfaþã sã fie vizibilã,
va trebui sã restartezi navigatorul. 

Dacã ai schimbat "look-ul"
browserului ºi eºti mulþumit de noua
interfaþã, poate ar fi bine sã
îmbunãtãþeºti ºi funcþionalitatea prin
descãrcarea ºi instalarea unor extensii.
Acestea nu sunt altceva decât mici pro-
grãmele care diversificã posibilitãþile
navigatorului.   

Pentru a vedea care sunt cele mai
cãutate sau mai utile extensii viziteazã
pagina https://update.mozilla.org/

extensions/. Vei observa aici cã acestea
sunt împãrþite pe categorii: jocuri, con-
tacte, configurare, chat etc.

Una dintre extensiile mele favorite
este "Adblock", un adevãrat anihilator al
reclamelor ºi banerelor publicitare.
Dacã te deranjeazã paginile extrem de
colorate ºi sloganurile de genul
"Cumpãrã acum!", "Ofertã limitatã!",
"Nu ezita ºi scoate banu`!", acest pro-
grãmel eliminã asemenea casete, încât
acestea nu vor mai apare niciodatã.
Dacã totuºi te rãzgândeºti ºi atmosferaSSeettããrriillee  AAddbblloocckk--uulluuii

IInnssttaalleezz  eexxtteennssiiaa  AAddbblloocckk

OOppþþiiuunnii  ººii  pprreeffeerriinnþþee
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devine prea searbãdã, poþi sã dezac-
tivezi Adblock-ul ºi la reîncãrcarea
paginii banerele publicitare vor reapare
([Tools] - [Adblock] - [Preferences]).

Dacã ai un cont Gmail, poþi sã
descarci o extensie care te va înºtiinþa în
momentul în care ai primit un mesaj
nou în cãsuþã.

Aceste extensii sunt peste 100, ºi tot
ceea ce ai de fãcut este sã le cauþi ºi sã le
instalezi pe cele care þi-ar putea fi de
folos. Trebuie sã menþionez cã în cazul
unora dintre acestea este posibil sã
intervinã mici probleme, deoarece unii
creatori ai acestor extensii nu garan-
teazã perfecta funcþionalitate a
browserului dupã instalarea lor.

Dupã ce am "rãsfoit" meniurile ºi am
testat câteva extensii, a urmat sã vãd
cum stã navigatorul la capitolul vitezã.
Cum am mai spus ºi în alte ocazii în
care am testat browsere, viteza unui
navigator nu se poate determina cu
exactitate, fiind influenþatã în mare
mãsurã de traficul Internet ºi fluctuaþi-
ile acestuia. Oricum am ales anumite

ore la care acesta este cât de cât con-
stant ºi am pus la lucru 5 navigatoare:
Avant, IE, Opera, Mozilla ºi Firefox.
Dacã performanþele au fost realizate
cînd de unul, cînd de altul, pot sã spun
cã, per ansamblu Firefox a ocupat locul
trei la micã distanþã în spatele
browserelor Opera ºi Mozilla.

Majoritatea problemelor legate de
acest navigator sunt unele care, cred
eu, pot fi rezolvate prin instalarea de
extensii. De exemplu, nu avem inte-
grate grupurile atât de folositoare din
Avant, sau posibilitatea de a salva
automat sesiunea de lucru (în cazul în
care apare vreo eroare ºi browserul tre-
buie restartat).

În schimb, una dintre marile pro-
bleme cu care se confruntã aproape tot
ceea ce nu înseamnã IE, este afiºarea
unor pagini care nu au fost neaparat
optimizate dupã standardele web, ci
pentru a arãta bine în browserul com-
paniei Microsoft. Din pãcate, aceastã
inconvenienþã nu este una care sã se
rezolve prin aplicarea unui patch, ci
este nevoie de schimbarea unei menta-
litãþi care, dupã cum bine ºtim, are
nevoie de timp. De fapt, niciodatã nu

am fost adeptul utilizãrii unui singur
browser. Este bine sã ai tot timpul la
îndemânã un altul "de siguranþã" la
care sã apelezi în momentele grele când
"preferatul" te mai pãcãleºte ºi-þi scoate
peri albi... :)

Oricum, dacã pun la socotealã faptul
cã Firefox 1.0 este un preview, cã este
mic ºi gratuit sau cã este primul brow-
ser care împacã într-un mod inteligent
toþi utilizatorii prin posibilitatea
instalãrii de extensii, îl recomand cu
încredere atât utilizatorilor începãtori
cât ºi celor avansaþi. �

LLaauurreennþþiiuu  BBaannccuu

laurentiu@myc.ro

AAddbblloocckk  ddeezzaaccttiivvaatt::  ccaasseetteellee  ppuubblliicciittaarree  vviizziibbiillee AAddbblloocckk  aaccttiivvaatt::  ccaasseetteellee  ppuubblliicciittaarree  aauu  ddiissppããrruutt

SSiittuull  wwwwww..eecchhiippaaffaannttaassttiiccaa..rroo  nnuu  
eessttee  aaffiiººaatt  ccoorreecctt  îînn  FFiirreeffooxx  11..00

AAcceellaaººii  ssiitt  aaffiiººaatt  ccoorreecctt  îînn  AAvvaanntt  
BBrroowwsseerr  ((eennggiinnee  IIEE))

PPrroo  ººii  ccoonnttrraa

SCOR 8,5/10

Interfaþã (skinuri) 8/10

Opþiuni 8/10

Funcþionare 9/10

Upgrade 9/10
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U
nul dintre numeroasele avantaje

ale Linux-ului este multitudinea

de medii desktop ºi manageri de

ferestre disponibile. Deºi doar 4-5 se

numãrã printre cele mai folosite, restul

proiectelor oferã câteodatã posibilitãþi ino-

vatoare care ar trebui cel puþin studiate de

echipele de dezvoltare KDE ºi Gnome.

KKDDEE

Un mediu desktop sau un manager de

ferestre ne oferã o interfaþã graficã cu care

utilizatorul poate interacþiona mult mai

uºor decât în cazul liniei de comandã.

Marea majoritate a utilizatorilor Linux ºi

BSD ºi aproape toate distribuþiile Linux

folosesc KDE (K Desktop Environment) ca

mediu desktop implicit. Asta din cauzã cã

este cel mai avansat din punct de vedere al

stabilitãþii ºi al posibilitãþilor pe care le

oferã. Extrem de multe apli-

caþii care necesitã un GUI, folosesc librãriile

din KDE ca punct de referinþã. Interfaþa în

sine suportã teme ºi poate fi fãcutã sã imite

alte interfeþe grafice (Windows, Solaris,

QNX, BeOS) astfel încât, indiferent din ce

mediu ai fãcut tranziþia, la Linux, te vei

putea simþi "ca acasã" în faþa monitorului.

Nu numai atât, dar KDE ne oferã ºi o

suitã de aplicaþii integrate care fac sã

pãleascã celelalte managere de ferestre

(exceptând poate Gnome) - un panel (co-

respondentul avansat al "Taskbar-ului" din

Windows) ce suportã skinuri ºi applet-uri

diverse ºi care poate afiºa iconuri de pânã

la 64x64 pixeli dimensiune.

Una dintre aplicaþiile distincte oferite de

KDE este Konqueror - un browser/manager

de fiºiere care face viaþa utilizatorului mai

uºoarã. Konqueror oferã previzualizare

pentru fiºiere video, imagini, fiºiere HTML,

audio ºi alte extensii pe care utilizatorul ar

dori sã le vadã înainte de a deschide

fiºierul. O noutate binevenitã în ultimul

Konqueror sunt tab-urile ferestrelor. Cu

C t r l + S h i f t + N

putem deschide o nouã

sesiune de lucru în cadrul browserului.

KDE dispune chiar ºi de un sistem "help"

propriu cu referinþe la aproape toate apli-

caþiile implicit instalate.

,,

UUnn  ssttyyllee  ddiinn  KKDDEE
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Iconurile sunt scalabile ºi pot atinge

dimensiuni de pânã la 128x128. Practic,

orice fiºier PNG poate fi transformat în icon

pentru KDE atâta timp cât nu depãºeºte

aceste dimensiuni fixe. Tot la categoria

"aspect", un lucru ce diferenþiazã KDE de

restul managerelor de ferestre ºi medii

desktop este pleiada de efecte care pot fi

aplicate interfeþei. De la iconuri animate ºi

pânã la meniuri transparente, totul este

posibil. 

KDE oferã interfeþe standard pentru

imprimare, fax sau resursele reþelei (ca sã le

numesc pe cele mai importante), oferã

soluþii de verificare ortograficã (spellcheck)

ºi prezentare clipboard, precum ºi un sis-

tem multimedia integrat ce poate fi folosit

atât la redarea sunetelor sistemului cât ºi la

redarea fiºierelor audio cu muzicã în

diferite formate. Oferã transparenþa reþelei

prin orice aplicaþie care foloseºte KIO, un

motor de randare HTML (atât de rapid

încât ºi Apple Inc. a profitat de licenþa GPL

pentru a-l include în navigatorul Safari).

KDE este livrat de echipa de dezvoltare

prin mai mult de 140 de mirror-uri FTP din

peste 39 de þãri ºi este îmbunãtãþit zi de zi.

A fost tradus în 86 de limbi ºi din punct de

vedere al suportului, existã sute de canale

de discuþii ºi forumuri pentru cei cu între-

bãri.

Dupã cum am spus înainte, multe apli-

caþii pot fi integrate în KDE. Kopete este o

aplicaþie de mesagerie instantanee care

foloseºte KWallet pentru stocarea parolelor.

KWallet este folosit ºi de numeroºi clienþi

FTP sau browsere web pentru a gestiona

parolele folosite de utilizatori.

Dupã o instalare completã, putem

observa cã în KDE gãsim cam tot ceea ce ne

trebuie pentru a avea un desktop funcþio-

nal. Kpilot oferã conectivitate cu PDA-uri ºi

Palm-uri, KOffice ne permite sã editãm

texte sau tabele în mod profesionist, asi-

gurând totodatã o compatibilitate cu do-

cumete Word ºi Excel. Pãrere mea este cã

mai toatã lumea foloseºte oricum

OpenOffice, dar e bine sã ai la îndemânã o

alternativã mai puþin consumatoare de

spaþiu. 

Un alt "bonus" adus de KDE este KParts.

Scopul acestei tehnologii este integrarea

unor aplicaþii într-o altã aplicaþie.

Konqueror de exemplu dispune de funcþii

de browser ºi filemanager. Kontact este o

aplicaþie care a fost introdusã în KDE 3.2 ºi

care foloseºte la rândul sãu aplicaþiile

KMail, KOrganizer, KAddressbook, KNotes

ºi Knode.

KDE 3.3 a fost lansat deja de câteva luni

ºi a adus câteva îmbunãtãþiri binevenite

faþã de KDE 3.2. Notabile ar fi înlocuirea

mai-vechiului KPaint cu Kolourpaint, un

nou KSpell (numit Kspell2),

KThemeManager (un modul pentru

Control Center care se ocupã de manage-

mentul temelor pentru KDE) ºi posibili-

tatea KMail de a afiºa disponibilitatea

online a contactelor IM. Konqueror a primit

posibilitatea de a afiºa feeduri RSS ºi de a-i

fi schimbate tab-urile cu rotiþa mouse-ului.

Pe lângã multe alte opþiuni minore, peste

7000 de bug-uri au fost înlãturate ºi peste

2000 de dorinþe ale utilizatorilor împlinite.

Despre KDE 3.3 s-ar putea scrie un arti-

col extensiv dar nu acesta este scopul celui

prezent. Aºa cã vom trece acum la "con-

curentul" KDE-ului: Gnome.

GGNNOOMMEE

Mediul desktop Gnome se aflã în

prezent la versiunea 2.6. Gnome 2.8 este

,,

UUnn  aalltt  ssttyyllee  ......ººii  uunn  aallttuull  

KKDDEE  --  CCeell  mmaaii  ffoolloossiitt  mmeeddiiuu  ddeesskkttoopp  ddiinn  LLiinnuuxx
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aºteptat sã aparã în curând. Feelingul diferã
substanþial faþã de KDE. Gnome ("GNU
Network Object Model Environment")
pare mai rapid, mai stabil. Interfaþa graficã
este mai cizelatã ºi ca mediu desktop este
folosit de multã lume ca alternativã a KDE-
ului.

Proiectul GNOME a fost pornit în
august 1997, iar în prezent se bucurã de
câteva sute de dezvoltatori activi. 

Ceea ce a catapultat sindromul Gnome
ºi mai în faþã a fost Sun Java Desktop
System, sistem de operare care foloseºte
Gnome ca mediu desktop implicit. 

Echivalentul lui Konqueror în Gnome
este Nautilus, un puternic filemanager cu
extrem de multe posibilitãþi de între-
buinþare. Una dintre cele mai interesante
facilitãþi oferite de Nautilus este "memoria
ferestrei". O fereastrã deschisã, un director
deschis în Nautilus a doua oarã va prezen-
ta fiºierele exact în acelaºi cadrul în care 

le-ai lãsat la ultima vizitã. Un set de iconuri
aranjate într-un fel, nu vor fi rearanjate nici
chiar dupã o rebootare a sistemului. Un
lucru binevenit deoarece multã lume reþine
o imagine mentalã a fiºierelor cu care a
lucrat ultima oarã ºi astfel nu mai pierzi
secunde preþioase cãutând cutare arhivã pe
care ai accesat-o ieri. Pânã ºi poziþia în sine
a ferestrei pe desktop se va pãstra. Pentru
noii utilizatori, un asemenea "beneficiu" ar
putea sã parã frustrant la început, în special
când vii din medii KDE.

Nautilus deschide câte o fereastrã sepa-
ratã pentru fiecare director. Dupã ce ai dat
destule clicuri ºi ai ajuns suficient de
"adânc" în fiºierele sistemului, s-ar putea sã
ai surpriza sã constaþi cã desktopul þi-e plin
de ferestre deschise. Efectul se poate con-
tracara folosind dublu-clicul efectuat cu
butonul din mijloc al mouse-ului. Pentru
cei cu mouse-uri mai vechi, combinaþia
shift + dublu-clic pe fiºier oferã acelaºi
efect.

Un alt aspect care defineºte modul ciu-
dat de navigare este faptul cã odatã ce ai
ajuns într-un anumit director ºi vrei sã
mergi cu unul sau douã directoare înapoi,
nu gãseºti o sãgeatã "back" care sã te ajute.
În schimb, trebuie sã te foloseºti de tasta
Backspace sau de widget-ul din partea
stânga-jos a ferestrei.

La capitolul "networking" Gnome o
duce acum ceva mai bine. În trecut au exis-
tat unele probleme legate de conectivitatea
Samba ºi SSH.

ªi Gnome foloseºte iconuri scalabile, tot
în format PNG. Mai mult, oferã posibili-
tatea adãugãrii unei "embleme" acestora,
pentru ca utilizatorul sã le poatã marca
corespunzãtor nevoilor sale. 

Gnome oferã un icon "My Computer" pe

desktop care ne duce cãtre drive-urile PC-
ului ºi un punct de accesare al reþelei. Deºi
Nautilus nu poate fi folosit ºi pe post de
browser, avem un navigator web separat
numit Epiphany.

Tot la capitolul "Gnome" ar mai fi de
menþionat Ximian Gnome ºi Dropline
Gnome. Primul este un desktop creat de
compania Ximian iar al doilea este un
Gnome personalizat special pentru dis-
tribuþia Slackware.

XXFFCCEE

Al treilea mare mediu desktop este
XFCE. Ceea ce caracterizeazã XFCE este
stabilitatea. Folosesc XFCE 4 de ceva vreme
ºi nu mi s-a blocat niciodatã. Ferestrele pot
utiliza teme din cele mai variate ºi precum

în KDE sau Gnome, avem ºi aici posibili-
tatea folosirii unui "Panel". XFWM se ocupã
de afiºarea ferestrelor în XFCE iar "Panel"-
ul se diferenþiazã de cel din KDE prin fap-
tul cã nu prezintã un meniu Start.
Aplicaþiile pot fi accesate prin iconurile pe
care tu le vei adãuga în cadrul "Panel"-ului,
fie ca iconuri fie ca applet-uri. ªi panel-ul
suportã teme (preferata mea fiind "BeOS",

,,

XXFFCCEE  --  DDeesskkttoopp
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INTERFETE GRAFICEINTERFETE GRAFICE|LINUX|My PREZENTÃM

www.myc.ro noiembrie 2004|27

desigur) care schimbã înfãþiºarea iconurilor

de pe acesta.

Rotiþa mouse-ului poate fi folositã în

desktop-ul principal pentru a te deplasa pe

celelalte desktopuri. Vorbind despre desk-

top, XFCE nu foloseºte iconuri pe acesta.

Mulþi pot considera acest lucru ca pe un

minus, dar în curând te vei obiºnui.

Rapiditate versus accesibilitate. XFFM este

managerul de fiºiere din XFCE. Personal îl

gãsesc ca fiind complet inutil. Dupã ce ai

lucrat atâta amar de vreme cu Konqueror

probabil cã e greu sã te obiºnuieºti cu altce-

va. Oricum, XFFM este destul de rudimen-

tar ºi nu aduce inovaþii. Foloseºte numai

"tree-view". Pentru a ieºi din XFCE se

foloseºte un clic-dreapta pe "Panel" ºi se

selecteazã "Exit".

Taskbarul din XFCE este extrem de limi-

tat ºi el. Nu îþi apare nici un meniu contex-

tual cât dai clic-dreapta pe el, ferestrele

sunt "doar acolo", nu poþi face nimic cu ele,

doar sã le maximizezi ºi minimizezi. Nu

poþi folosi mai mult de 10 shortcut-uri ale

tastaturii pentru a manevra aplicaþii ºi fe-

restre, dar celor lacomi le recomand xbind-

keys.

La fel ca ºi Gnome, XFCE foloseºte GTK,

iar pentru un mediu desktop atât de mic

am fost surprins cã poate utiliza fonturi

anti-aliasing. Pentru 30Mb pe hard disc,

XFCE se comportã ºi oferã un feeling

excepþional. Dacã nu poþi rula KDE sau

Gnome din cauza lipsei RAM-ului sau a

spaþiului fizic, XFCE este urmãtoarea con-

cluzie logicã.

XXPPDDEE

ªi zici cã poþi rula Windows XP într-o

sesiune X? Aproape. XPDE (XP Desktop

Environment) este un proiect al cãrui scop

este sã ofere un look gen XP în Linux fãrã a

folosi skinuri. Aºa s-a ajuns la dezvoltarea

unui mediu desktop aparte. Prima impresie

pe care o ai când porneºti XPDE este cã

bootezi Windows XP. Meniurile, iconurile,

meniu Start, pânã ºi wallpaper-ul îþi oferã

senzaþia cã lucrezi în Windows. Este soluþia

idealã când vrei sã îþi pãcãleºti colegii

trecând rapid din KDE în XPDE. 

XPDE se aflã încã într-o fazã de dez-

voltare. Extrem de puþine lucruri

,,

XXFFCCEE  --  SSiimmpplluu  ººii  aarrããttooss

TTeemmee  iinn  XXFFCCEE

SSeettããrrii  îînn  XXFFCCEE
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funcþioneazã, iar cele care funcþioneazã nu
reuºesc sã o facã prea bine.

Din iconurile prezentate pe desktop
doar "Internet", "GIMP" ºi "Command Line"
funcþioneazã, însã ºi acestea dupã clicuri
repetate. Nu existã o avertizare a cursorului
care ne spune cã aplicaþia este pornitã, aºa
cã am reuºit sã lansez vreo 3 secvenþe
GIMP pânã sã-mi dau seama. Shortcut-ul
"Internet" porneºte Netscape iar
"Command Line" o sesiune xterm. În afarã
de "logout" ºi "exit", doar "Preferences" mai
face ceva. Cu un clic-dreapta pe desktop
putem accesa un meniu contextual care ne
duce cãtre preferinþele de afiºare, 
organizate similar cu cele din Windows XP.
Un ecran de unde putem schimba wallpa-
per-ul, cu un monitor de previzualizare
identic cu cel din XP, afiºat corect. Spun
"afiºat corect" deoarece restul tab-urilor nu 
prezintã bine fereastra iar fonturile ºi po-
ziþionarea acestora sunt ciudate.

Meniul "Start" oferã intrãri doar la
"Accesories", dar degeaba încerci sã lansezi
ceva - e pus acolo doar de formã.

Deºi extrem de "buggy", XPDE m-a
impresionat. Proiectul va avea mari ºanse
de reuºitã, odatã ce mai mulþi dezvoltatori
vor fi dispuºi sã lucreze la finalizarea lui.

WWiinnddoowwMMaakkeerr

WindowMaker este unul din cei mai
vechi manageri de ferestre disponibili sub
Linux. Este destul de limitat, nu este un
mediu desktop precum KDE sau Gnome
dar oferã funcþionalitate. WindowMaker se
foloseºte de WMDock pentru a reprezenta
iconurile aplicaþiilor sub forma unor
pãtrate lipite de marginile desktop-ului. 

Cu clic-dreapta pe desktop vom obþine

acces la un meniu contextual extensiv unde
gãsim o serie de programe grupate pe cate-
gorii ºi setãrile managerului de ferestre.
Dacã dãm un clic pe bara meniului 
contextual acesta se va transforma în 
fereastrã ºi va rãmâne pe desktop, per-

miþându-ne sã deschidem un altul cu
mouse-ul.

WindowMaker suportã teme ºi stiluri,
iar faptul cã iconurile desktop-ului sunt
grupate unul lângã celãlalt face lucrul mai
uºor pentru utilizator. Suportã mai multe

,,
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spaþii de lucru ºi are o aplicaþie de configu-
rare graficã.

BBllaacckkBBooxx

Când þi-ai instalat Linux pe un 486 sau
vrei rapiditate ºi nu doreºti sã consumi prea
multe resurse, poþi folosi BlackBox ca ºi
manager de ferestre. Este extrem de mic,
simplu ºi rapid. Oferã tab-uri de aproxima-
tiv 10 pixeli înãlþime, un taskbar care
afiºeazã ora ºi ferestrele deschise, un meniu
contextual care oferã acces la aplicaþii ºi
setãri, similar cu cel din WindowMaker.
Pentru a adãuga aplicaþii în acest meniu
trebuie editat fiºierul /usr/X11R6/share/
blackbox/menu care oferã explicaþii detali-
ate despre inserarea de comenzi în acesta.

BlackBox suportã wallpaper-uri spre
deosebire de alþi manageri de ferestre cum
ar fi TWM.

FFlluuxxBBooxx

Un derivat BlackBox ce aduce câteva
îmbunãtãþiri (notabilã ar fi adãugarea de
tab-uri ferestrelor, ce permite gruparea mai
multor ferestre într-una singurã). O 
aplicaþie care se livreazã cu FluxBox 
permite setarea de shortcut-uri din tas-
taturã pentru lansarea de aplicaþii, într-un
mod similar cu bbkeys din BlackBox.
FluxBox se evidenþiazã de BlackBox prin
posibilitatea de a rula aplicaþii care folosesc
dock-ul din KDE sau dock-ul din
WindowMaker.

FluxBox suportã stiluri ºi teme compati-
bile cu BlackBox ºi este de preferat primu-
lui manager de ferestre datoritã posibi-
litãþilor pe care le oferã.

FFVVWWMM22

Un manager de fiºiere odatã predomi-
nant printre fraþii lui ºi dezvoltat de Robert
Nation. Împrumutã multe din facilitãþile

oferite de TWM, a fost alcãtuit pentru a
consuma cât mai puþine resurse ºi oferã un
look 3D similar cu cel din MVM. Cu clic-
dreapta putem accesa ferestrele ºi aplicaþi-
ile deja deschise, cu butonul din mijloc al
mouse-ului accesãm opþiunile ferestrei
active (kill, close, resize etc.) iar cu un sim-
plu clic pe desktop ni se afiºeazã un meniu
care îl imitã ca ºi grupare pe cel din
Windows 95. Avem acces la aplicaþii, jocuri,
tipuri de console, module, screensavere ºi
alte opþiuni.

FFVVWWMM9955

Oferã aceeaºi funcþionalitate ca ºi
FVWM2, cu câteva bonusuri: un taskbar ºi

,,

FFVVWWMM22

UUnn  llooookk  rreettrroo  --  FFVVWWMM9955
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un meniu Start care seamãnã cu cel din
Windows 95.

AAfftteerrSStteepp

AfterStep este un manager de ferestre
atrãgãtor ce oferã transparenþa meniurilor,
meniuri, iconuri ºi ferestre în gen
NeXTSTEP. Iconurile nu pot fi schimbate
tocmai pentru a pãstra acest feeling "NeXT"
pe care AfterStep îl afiºeazã.

Ferestrele minimizate se transformã în
tab-uri poziþionate în partea de sus a ecra-
nului. Iconurile pot fi lansate atât cu clic cât
ºi cu clic-dreapta. Interfaþa graficã suportã
teme ºi stiluri iar efectul per ansamblu este
destul de interesant. AfterStep se bucurã de
o anumitã fluiditate, de efecte speciale care

îþi oferã o reprezentare vizualã a ceea ce se
întâmplã pe ecran. Când AfterStep este
lansat, ni se afiºeazã într-un ecran transpa-
rent fiºierele pe care acesta le acceseazã. La
fel, când minimizãm sau maximizãm o fe-
reastrã, aceasta face trecerea într-un ritm
animat.

AAmmiiWWMM

Înapoi în era Amiga! AMIWM imitã la
perfecþie Workbench-ul staþiilor Amiga dar
este limitat ca ºi funcþionare. În afarã de fe-
restrele caracteristice, singurele funcþii pe
care le oferã sunt minimizarea aplicaþiilor
în iconuri pe desktop, rularea unei comenzi
prin selectarea meniului ce apare la apã-
sarea butonului drept al mouse-ului ("Exe-

cute command") ºi ieºirea din managerul
de ferestre. O altã caracteristicã este faptul
cã poate lucra cu mai multe ecrane.

EEnnlliigghhtteennmmeenntt

Un manager de ferestre avansat. Bazat
iniþial pe FVWM2, oferã posibilitatea de a
folosi teme ºi stiluri. Managerul de ferestre
a fost ulterior rescris de la zero devenind
mai rapid ºi mai fiabil. Ca ºi majoritatea
managerilor de ferestre din acest articol,
Enlightenment este încã în faza de dez-
voltare.

Skinurile disponibile pentru 
Enlightenment sunt încântãtoare, cu un

,,

AAfftteerrsstteepp AAmmiiWWMM  --  AAmmiiggaa  îînnccãã  nnuu  aa  mmuurriitt

EEnnlliigghhtteennmmeenntt  --  ppaarrccãã  ssccooss  ddiinn  ffiillmmeellee  SSFF

TToott  EEnnlliigghhtteennmmeenntt

......ººii  vvoorrbbeeaamm  ddee  SSFF
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profund caracter futuristic. Managerul de
fiºiere în sine lucreazã cu mai multe desk-
top-uri pe care poþi sã le schimbi folosind
un efect de tranziþie demn de filme SF.
Meniurile suportã transparenþã ºi diverse
efecte, din aceastã cauzã managerul de fe-
restre consumând o bunã parte a resurselor
doar pentru afiºarea lor.

Pentru cei ce pun preþ pe frumuseþea
desktop-ului personal, Enlightenment vã
aduce kitul de cosmeticã perfect pentru
PC-ul Linux.

MMeettaacciittyy

Metacity este un manager de ferestre
dezvoltat de un membru al echipei RedHat
ºi se bazeazã pe GTK+ 2.x (ceea ce înseam-
nã cã poate fi uºor integrat ºi în Gnome).

Extrem de atrãgãtor, mic ºi rapid.

IIcceeWWMM

Un manager de ferestre folosit destul de
des datoritã sistemului gen Windows pe
care îl oferã. Dispune de un meniu Start ºi
un taskbar ºi poate fi decorat cu skinuri. Un
desktop IceWM poate fi fãcut sã arate
atrãgãtor, mai ales cã pachetul de instalare
conþine deja câteva teme implicite (Motif,
GTK, OS/2 Warp [3 ºi 4] ºi Windows
[95/3.1]). Este extrem de configurabil,
conþine applet-uri în taskbar pentru APM,
reþea, CPU. Acceseazã spaþiile de lucru în
acelaºi fel în care o face ºi WindowMaker,
meniul "Start" oferã intrãri cãtre aplicaþii ºi
utilitare de configurare.

SSaawwffiisshh

Acest manager de ferestre te duce cu
gândul la Enlightenment. Deºi este la fel de
configurabil, nu oferã totuºi numãrul ridi-
cat de opþiuni al acestuia. Suportã desigur
teme (implementate prin mirificul limbaj
LISP). Poate lucra în combinaþie cu un
mediu desktop (în special cu Gnome). 

ÎÎnn  ccoonncclluuzziiee......

Existã încã zeci de managere de ferestre
care nu au fost discutate în acest articol, dar
pe care aº dori sã le menþionez mãcar cu
numele. Unele dintre ele le-am ºi introdus
pe CD-ul din aceastã lunã ºi te conjur sã le
încerci (nu simþi cum te îndeamnã curiozi-
tatea?). HackedBox de exemplu este un
manager de ferestre bazat pe FluxBox.
SCWM, OLWM, CTWM, MWM, OpenBox,
Eclipse, Golem, Oroborus, B4Step - sunt
doar câteva elemente din multitudinea de
managere de ferestre disponibile pe
Internet. 

În ceea ce priveºte mediile desktop, ar
mai fi de amintit CDE (mediu desktop ce
ruleazã în sistemul de operare Solaris),
Athene (un produs comercial disponibil nu
numai pentru Linux dar ºi Windows) ºi nu
în ultimul rând "Looking Glass", desktopul
tridimensional produs de cãtre compania
Sun Microsystems ºi pe care l-am mai
amintit în articolele anterioare.

Indiferent cã foloseºti KDE, Gnome,
FluxBox sau cine ºtie ce altã ciudãþenie de
manager de ferestre... "happy Linuxing!".�

RRããzzvvaann  TT..  CCoolloojjaa

razvan@myc.ro

,,

MMeettaacciittyy  îînn  XXiimmiiaann  DDeesskkttoopp  22 SSaawwffiisshh  --  uunn  aalltt  mmaannaaggeerr  ddee  ffeerreessttrree

IIcceeWWMM  ssee  aapprrooppiiee  mmuulltt  ddee  llooookk--uull  WWiinnddoowwss
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W
ireless (fãrã fir) este un cuvânt
din ce în ce mai utilizat în ulti-
ma perioadã. Utilizatorii care

deþin acasã un PC ºi au vecini cu care ar
dori sã se conecteze în reþea, sunt interesaþi
de modul în care ar putea realiza o conexi-
une fãrã fir. ªi asta se pare cã este una din-
tre marile probleme a reþelei "clasice":
"cãblãraia" ne omoarã pe toþi! ªi cei care au
vãzut reþele "adevãrate" cred cã mã înþeleg
foarte bine...

Tendinþa este clarã: cu cât mai puþine
fire, cu atât mai multã manevrabilitate ºi
mobilitate. Ca sã nu mai pun la socotealã
faptul cã, pe mãsurã ce lucrurile avanseazã,
cu atât se reduc costurile implementãrii
unei reþele wireless.

Într-o reþea localã 802.3 Ethernet, cabluri
Cat5 conecteazã staþiile LAN la un hub.
Într-o reþea wireless, cablul Cat5 este sub-
stituit cu un canal radio care conecteazã
staþiile la un AP (Access Point - punct de
acces). Staþiile wireless (desktop-uri, lap-
top-uri sau servere) au o placã NIC
(Network Interface Card). Punctele de
acces sunt de fapt niºte hub-uri dotate cu
subansamble de emisie-recepþie, Ethernet
uplink ºi soft 802.1d.

802.11 a fost primul standard pentru
reþele wireless adoptat de cãtre IEEE
(Institute of Electrical and Electronics

Engineers - o
instituþie care îºi are
originile în 1884, ºi care a luat practic fiinþã
în 1961 prin fuziunea dintre AIEE-
American Institute of Electrical Engineers ºi
IRE-Institute of Radio Engineers) în 1997,
botezat dupã numele grupului format sã
dezvolte acest standard. 

Acest standard defineºte un substrat
MAC (medium access control), servicii, pro-
tocoale MAC de management ºi trei straturi
PHY (fizice). Acestea sunt IR (infraroºu),
FHSS în banda de 2,4 Ghz, ºi DSSS, de
asemenea în banda de 2,4 Ghz. 

Din pãcate, 802.11 suporta doar conexi-
uni de maxim 2 Mb/s, destul de puþin pen-
tru majoritatea aplicaþiilor. Acesta a fost ºi
motivul pentru care s-a renunþat la produ-
cerea de echipamente 802.11 obiºnuite.

Din aceastã cauzã a apãrut necesitatea
extinderii respectivului standard.

802.11b - este o extensie la DSSS PHY în
banda de 2,4 GHz, care furnizeazã pânã la
11 Mb/s (cu posibilitatea de upgradare la
802.11g despre care vom vorbi puþin mai
încolo). Existã posibilitatea de a crea aºa
numitele DSAP (dual-slot access points)
care permit instalarea unui punct de acces
802.11b cãruia i se poate adãuga mai târziu
o placã 802.11a (este necesar ca utilizatorii
sã aibã plãci 802.11a sau b pentru asigu-

rarea interoperabilitãþii).
În cazul în care este nevoie de mai multã

vitezã (având totuºi în vedere faptul cã
pentru multe aplicaþii 802.11b este sufi-
cient), se poate implementa echipament
802.11a în reþele 802.11b.

802.11a - strat PHY care foloseºte OFDM
(orthogonal frequency domain multiple-
xing) în benzi U-NII, trei benzi de 100 MHz
în banda de 5GHz (5,15-5,25 GHz - pentru
uz în interior; 5,25-5,35 GHz ºi 5,725-5,825
GHz).

Din cauza faptului cã standardul
802.11b a câºtigat popularitate mult mai
repede decât 802.11a, s-a crezut iniþial cã
802.11a a fost dezvoltat dupã 802.11b, însã
adevãrul este cã au fost create simultan.

Fiind vorba de frecvenþe foarte mari,
raza de acþiune este mai redusã decât în
cazul sistemelor care opereazã la frecvenþe
mai mici. Prin urmare, preþul sistemelor
finale este mai ridicat din cauza numãrului
mai mare de puncte de acces necesare, ºi
este specific mai mult pieþei business.

Acest standard opereazã pe 12 canale
care nu se suprapun, fapt care face ca în
aceeaºi zonã sã poatã fi amplasate 12
puncte de acces setate pe canale diferite
neexistând riscul de apariþie a interfe-
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renþelor. Transferul este de pânã la 54 Mb/s,
existând posibilitatea ca aceastã vitezã sã fie
îmbunãtãþitã prin combinarea canalelor.

Una dintre cele mai mari probleme ale
standardului 802.11a este incompatibili-
tatea cu reþelele 802.11b sau 802.11g, din
cauza faptului cã utilizeazã frecvenþe
diferite. Astfel, un utilizator care are o placã
802.11b sau g nu va putea comunica cu un
punct de acces 802.11a. 

Unii producãtori oferã echipamente hi-
brid 802.11a/b, dar acestea nu fac altceva
decât sã implementeze cele douã standarde
separat.

802.11g - este o extensie la 802.11b, ºi
furnizeazã pânã la 54 Mb/s în banda de 2,4
GHz (ceea ce înseamnã cã încearcã sã com-
bine ce aveau bun cele douã standarde
precedente) prin utilizarea tehnologiei
OFDM. 

Din cauza faptului cã aceste standarde
sunt compatibile (802.11b ºi g) o placã radio
802.11b va comunica cu un punct de acces
802.11g sau invers, la viteze de 11 Mb/s
(eventual mai puþin, în funcþie de distanþã).

Transferul la viteze de 54 Mb/s are
nevoie de distanþe mai scurte decât
punctele de acces 802.11b care opereazã la
11 Mb/s. Astfel, punctele de acces 802.11b
vor trebui înlocuite cu un numãr mai mare
de puncte de acces 802.11g în cazul în care
se doreºte creºterea vitezei de transfer.

La fel ca ºi 802.11b, 802.11g utilizeazã
aproximativ 30 MHz, adicã o treime din
bandã, ceea ce înseamnã cã numãrul
punctelor de acces care nu se suprapun
este limitat la 3. Mai concret, vor apare
probleme în momentul în care va trebui
acoperitã o zonã în care densitatea utiliza-
torilor este foarte mare. Soluþia este li-
mitarea puterii fiecãrui punct de acces ast-
fel încât acestea sã poatã fi apropiate.

Bineînþeles cã faþã de 802.11b costurile
de realizare ale unei reþele 802.11g sunt mai
ridicate.

O altã problemã legatã de 802.11g (vala-
bilã ºi în cazul standardului 802.11b) este
interferenþa cu alte dispozitive care
opereazã în banda de 2,4 GHz (de exemplu,
telefoanele fãrã fir sau cuptoarele cu
microunde). O soluþie în acest caz este
instalarea echipamentelor la distanþã de
posibilii "bãgãreþi".

Bluetooth - este o tehnologie wireless
alternativã care a urmat un alt traseu de
dezvoltare faþã de 802.11. Distanþa supor-
tatã este destul de limitatã (aproximativ 10
metri) ºi viteze foarte mici (1 Mb/s).
Bluetooth conecteazã PDA-uri sau tele-

foane mobile cu PC-uri, însã nu pare o
alternativã wireless demnã de luat în con-
siderare. Probabil cã singurul motiv al
supravieþuirii acestui standard este costul
foarte mic al implementãrii respectivei
tehnologii. 

Numele "Bluetooth" a fost luat de la un
rege danez din secolul al X-lea, Harald
Blatand (în englezã Harold Bluetooth). În
timpul dezvoltãrii acestei tehnologii a fost
nevoie de un nume de cod. Numele a fost
ales într-o searã în care s-a discutat despre
istoria Europei ºi viitorul tehnologiei wire-
less. De ce acest personaj? Fiindcã a fost un
"unificator", exact ceea ce îºi propunea ºi
tehnolgia, adicã o colaborare eficientã  între
diferite dispozitive. Logo-ul a fost creat de
o firmã scandinavã, cam în momentul în
care TA (Trade Association) era prezentatã
publicului. S-a pãstrat tradiþia numelui,
logo-ul pãstrând caracterul runic "H"
(asemãnãtor unui asterisc) ºi litera "B".  

DDiiccþþiioonnaarr  eexxpplliiccaattiivv

FHSS - Acronim de la "frequency-hopping

spread spectrum". FHSS este o tehnologie de trans-

misie utilizatã în reþele wireless de tip L (locale), ºi

în care semnalul de date este modulat cu un semnal

care oscileazã de la o frecvenþã la alta într-o secvenþã

aleatorie dar predictibilã ca o funcþie a timpului în-

tr-o bandã largã de frecvenþe. Semnalul de energie se

rãspândeºte în sfera timpului ºi nu prin împãrþirea

fiecãrui bit în bucãþi mai mici în domeniul

frecvenþei. Aceastã tehnicã reduce posibilitatea inter-

ferenþei, deoarece un semnal de la un sistem din

apropiere va afecta spectrul de rãspândire al celuilalt

semnal doar în cazul în care ambele transmit pe

aceeaºi frecvenþã ºi în acelaºi timp, ceea ce înseamnã

cã pentru o transmisie bunã este necesarã o sin-

cronizare corectã. 

DSSS - Un alt tip de spectru de propagare radio,

o tehnologie folositã de asemenea în transmisii

LAWN (local area wireless network), în care sem-

nalul de date este combinat, rezultând o diviziune a

datelor conform unui raport de propagare. Aceastã

tehnicã mãreºte rata de rezistenþã a semnalului la

interferenþe. În cazul în care o parte a datelor sunt

distruse în timpul transmisiei, acestea pot fi recu-

perate datoritã redundanþei transmisiei.

Bandwith (lãþime de bandã) - 1. Porþiune în-

tr-o bandã de frecvenþe sau lungimi de undã. Pentru

dispozitive analogice, lãþimea de bandã este expri-

matã în cicluri pe secundã sau herþi (Hz). 2.

Cantitatea de date care poate fi transmisã într-o uni-

tate fixã de timp. Pentru dispozitive digitale, lãþimea

de bandã este exprimatã în biþi sau bytes  pe secundã

(b/s; B/s). 

OFDM (Orthogonal Frequency Domain

Multiplexing) - tehnologie care împarte cursul de

date în mai multe canale, fiecare dintre acestea fiind

transmise pe o frecvenþã separatã. OFDM utilizeazã

benzi U-NII, trei benzi de 100 MHz fiecare în banda

de 5 GHz. Patru canale sunt definite pentru fiecare

bandã de frecvenþe, în total 12 canale separate care

nu se suprapun.

Modelul OSI (Open System Interconnection)

al celor 7 straturi - defineºte contextul de imple-

mentare a protocoalelor pe 7 straturi. Controlul trece

prin canal de la un strat la urmãtorul începãnd cu

stratul "application" ºi terminând cu nivelul "physi-

cal".

Application (7) - Acest strat suportã aplicaþii ºi

procese end-user. Partenerii care comunicã sunt

identificaþi, este identificatã de asemenea calitatea

seviciului, ºi sunt luate în considerare autentificarea

ºi intimitatea utilizatorilor. Acest strat este unul

axat pe aplicaþii, ºi oferã servicii pentru transferul de

fiºiere sau e-mail. Telnet-ul ºi FTP-ul sunt aplicaþii

specifice acestui nivel.

Presentation (6) - Acest nivel furnizeazã inde-

pendenþã în diferenþele din reprezentarea datelor (de

exemplu, criptarea) prin adaptarea aplicaþiei la un

format de reþea ºi invers. Mai exact, acest nivel

opereazã pentru transformarea datelor într-o formã

pe care sã o accepte nivelul "application". Nivelul

"presentation" formateazã ºi criptezã datele care tre-

buiesc trimise în reþea, rezolvând problemele de com-

patibilitate.

Session (5) - Acest nivel stabileºte, admi-

nistreazã ºi pune capãt conexiunilor dintre aplicaþii

(la ambele capete).

Transport (4) - Stratul furnizeazã transfer

"transparent" al datelor între sisteme, asigurând

ducerea la capãt cu succes a  acestui transfer. 

Network (3) - Furnizeazã tehnologii de schim-

bare ºi rutare, prin crearea de trasee logice, cunos-

cute ca ºi "circuite virtuale", pentru transmiterea

datelor între puncte. Rutarea ºi forwardarea sunt

exemple  de  funcþii ale acestui strat.  

Data Link (2) - La acest nivel, pachetele de date

sunt codificate/decodificate în biþi. Acest strat este

împãrþit în douã substraturi: MAC (Media Access

Control) ºi LAC (Logical Link Control). Primul con-

troleazã modul în care un calculator din reþea

primeºte acces la un pachet de date ºi permisiunea de

a-l transmite. Cel de-al doilea se ocupã de sin-

cronizarea cadrului, controlul traficului  ºi verifi-

carea erorilor. 

Physical (1) - Acest strat este responsabil de

transmiterea prin reþea a  impulsului electric, a sem-

nalului radio sau de luminã la nivel electric ºi

mecanic. Mai exact, furnizeazã mijloacele hardware

pentru transmiterea ºi recepþionarea datelor într-o

reþea.�

LLaauurreennþþiiuu  BBaannccuu  

laurentiu@myc.ro 
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Î
n numai câþiva ani dupã lansarea
tehnologiilor de transfer a datelor prin
reþele fãrã fir, viaþa multor oameni ºi

companii s-a schimbat radical. De la admi-
nistratorii de reþea care acum nu mai umblã
cu ochii pe pereþi ºi colacii de cablu cat5 pe
umãr, în cãutarea semnalului pierdut, pânã
la managerii care nu se mai uitã acum cu
atenþie la... cablul gri sau alb, care ieºea din
spatele laptopului special pentru a se încur-
ca în tocurile-cui ale pantofilor secretarei.
Iar dacã se mai uitã, totuºi, în zona respec-
tivã, ei bine, o fi... din cauza obiºnuinþei! :-)

Existã însã douã probleme: vitezã prea
lentã sau distanþã prea scurtã. În cele ce
urmeazã, vom discuta despre leacurile pe

care le va aduce viitorul pentru prima din-
tre cele douã probleme ale reþelelor
"dezlãnþuite". 

Viteza de transfer este o problemã
sesizatã de mulþi utilizatori, obiºnuiþi cu
reþelele cablate, care funcþionau cu viteze
de pânã la 100 de megabiþi pe secundã, sau
chiar de 1 gigabit pe secundã (cu echipa-
mente adecvate).  Dupã cum aþi citit proba-
bil în articolul lui Laurenþiu (iar dacã nu aþi
fãcut-o încã, sunt sigur cã urmeazã!),
tehnologiile wireless actuale permit trans-
ferul datelor la cel mult 54 megabiþi pe
secundã. Pentru majoritatea utilizatorilor, e
suficient. Noroc cã mai sunt ºi unii care nu
se saturã niciodatã de "vitezã", iar aici mã

refer în special la cei care testeazã deja la
ora actualã transferuri fãrã fir la viteze
mari, pe care vor sã le "ducã" pânã la 1 giga-
bit pe secundã, adicã aproape de 20 de ori
mai repede decât actualele conexiuni
802.11g sau 802.11a. Tehnologia despre care
discutãm în acest articol se numeºte UWB,
prescurtarea de la Ultrawideband, adicã
bandã de transfer cu lãþime extrem de
mare. Cât timp va rezista acel "extrem",
rãmâne de vãzut... Sã ne oprim deocamdatã
la UWB, despre care ni se promite cã va fi
disponibilã pe piaþã în urmãtorii doi ani, la
viteza de transfer (anunþatã deocamdatã)
de 480 megabiþi pe secundã. 

UUllttrraawwiiddeebbaannddUWBUWB
llaa  ddiissttaannþþãã  mmiiccãã,,  mmaarree  vviiiittoorr!!
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Unii sceptici se vor întreba "la ce bun,
atâta tevaturã?" Ei bine, gândiþi-vã cã va fi
posibil sã transmiteþi semnalul HDTV ori-
unde în casã, sau vei putea transmite ima-
gini în direct, pe Internet, de pe o camerã
video digitalã, ca prietenii tãi sau colegii de
la birou sã vadã ce frumos e sã stai în grã-
dinã sau pe marginea piscinei, în concediu.
Avantajul major al integratelor UWB este
cã, datoritã dimensiunile reduse ºi con-
sumul mic de energie, vor putea fi imple-
mentate în orice dispozitiv digital, de la
laptop, pânã la camera digitalã sau pla-
yer-ul portabil (de genul celebrului iPod).

Cat de noua e tehnologia? Ei bine, în
plinã desfãºurare a Rãzboiului Rece, în anii
'60, Ultrawideband era o tehnologie mili-
tarã secretã ale cãrei prime utilizãri au fost
nu atât în telecomunicaþii, cum ai fi înclinat
sã crezi, ci în urmãrirea avioanelor "invi-
zibile", care foloseau (încã pe atunci!) mult-
mediatizata (abia recent...) tehnologie
stealth, a dezvãluit pentru Reuters direc-
torul executiv Bruce Watkins de la firma
Pulselink, care a început sã studiaze plat-
forma UWB într-un laborator din San
Diego. 

În februarie 2002, Comisia pentru
Comunicaþii Federale a SUA (Federal
Communications Commission - acel FCC

pe care îl întâlniþi pe majoritatea etichetelor
de pe produsele IT) a aprobat utilizarea
comercialã a tehnologiei Ultrawideband.
De atunci, douã echipe de cercetare au
început sã dezvolte platforma, iar în
prezent lucreazã la stabilirea unui standard
comun. 

Analiºtii ºi experþii susþin cã UWB nu va
înlocui actualele standarde, ci va fi comple-
mentar cu acestea, deoarece funcþioneazã
la vitezã de transfer foarte mare, dar pe dis-
tanþe mici. "(Ultrawideband este) foarte

ieftinã, lucreazã pe distanþe mici, dar atinge
performanþe foarte ridicate," susþine Craig
Mathias, analist la Farpoint Group. 

Tehnologia a câºtigat deja sprijinul ma-
rilor producãtori de circuite integrate,
printre care Intel, Texas Instruments ºi
Motorola, a recent-apãrutului Freescale
Semiconductor sau a unor companii mai
mici cum sunt Pulselink, Wisair (Israel) ºi
Staccato Communications. 

Giganþii produselor de consum, ca Sony,
Philips ºi Panasonic se aratã de asemenea
interesaþi de tehnologia UWB. "Se fac efor-
turi pentru standardizarea Ultrawideband"
- afirma Mathias pentru Reuters - "ºi pre-
supunând cã acest lucru se va întâmpla, ne
aºteptãm ca piaþa sã fie foarte mare". 

Tehnologia va fi asociatã cu conexiunile
USB 2.0 ºi FireWire, prin care transmiterea
datelor se face la circa 440 Mbps. Astfel va
apare probabil conceptul de "USB fãrã fir".
Unde mai pui cã UWB se încadreazã sub
aspectul costurilor în celebra Lege a lui
Moore (care încã din 1965 observa faptul cã
numãrul de tranzistori de pe un circuit
integrat se dubleazã o datã la 18 luni, în
timp ce costurile de producþie se
înjumãtãþesc).

Iatã cã viteza de transfer are deja un
rãspuns. Dacã vã mai amintiþi, la începutul
articolului spuneam cã cea de a doua pro-
blemã a reþelelor fãrã fir este distanþa la
care funcþioneazã transferul datelor. Ei
bine, circa 50 de kilometri ar fi destul?
WiMax este numele tehnologiei care per-
mite acest lucru. Dar despre ea vom discu-
ta, eventual, într-un numãr viitor. Iar pânã
atunci, aºtept e-mailurile tale! �

MMiirrcceeaa  BBuuzzlleeaa  

mircea@myc.ro

MMoodd  vviizzuuaalliizzaarree  ccoodd--ssuurrssãã



E
ste normal ca toþi producãtorii IT
hardware sã vândã produse, pen-
tru cã altfel nu ar mai fi producã-

tori. Însã, ei trebuie sã îndeplineascã unele
standarde, care de obicei nu sunt greu de
îndeplinit pentru a putea expune pe piaþã
spre vânzare produsele, pe care le fabricã.
Normal cã produsele dupã cumpãrarea 
lor, par perfecte, pânã în ziua în care încep
sã nu mai ofere acelaºi randament sau chiar
se defecteazã dupã ce expirã garanþia (cazul
cel mai nefericit). 

Însã, în ziua de azi existã o grãmadã de
reviste de specialitate care testeazã pro-
dusele ºi îºi exprimã pãrerea mai mult sau
mai puþin subiectivã despre acel produs.
Normal cã ºi aici se fac mãsluiri, e dureros,
dar acesta este adevãrul! Oricum, în gene-
ral în revistele de specialitate nu prea se
discutã despre fiabilitatea produselor, ci
doar despre calitatea ºi performanþa lor. 

Dar dupã cum spuneam, trebuie sã fim
fericiþi pentru cã putem afla, cât de cât,

ceea ce ne intereseazã despre orice produs
IT. Spre exemplu, nu am vãzut în România
o revistã în care se comparã cazane termice!

FFiiaabbiilliittaatteeaa  ssaauu  pprroobblleemmaa
eexxiisstteennþþeeii

În trecut produsele erau (pãreau) mai
fiabile, acum însã, ai impresia cã producã-
torii doresc sã vândã din ce în ce mai mult
ºi uitã aspectul fiabilitãþii. Probabil, politica
unei firme obiºnuite sunã cam aºa: "sã vin-
dem cât mai mult indiferent ce s-ar întâm-
pla!" E firesc. 

Ca sã poþi realiza profit trebuie sã vinzi,
însã oare vei fi împãcat cu gândul cã ai vân-
dut clientului un produs "bun"?!? Totuºi,
producãtorii care vor sã-ºi pãstreze clienþii
ºi sã câºtige noi clienþi, urmãresc crearea
unui produs de calitate, însã atenþie, dom-
nule client: acel produs costã mai mult, dar
primeºti în schimbul preþului mai mare
garanþia unui produs fiabil ºi de 

calitate, chiar dacã nu este, neapãrat, cel
mai performant! Câteodatã nu înseamnã cã
dacã e cel mai rapid sau este pe primul loc
în topul unui reviste, este ºi cel mai fiabil
sau de cea mai bunã calitate! 

Sunt multe firme care nici ele nu mai
ºtiu câte tipuri de produse au conceput,
însã  mã întreb dacã au idee despre fiabili-
tatea acestora sau calitatea acestora (proba-
bil cã au, dar fie cã nu-i intereseazã, fie cã
nu au de ales)?!? Mai sunt ºi firmele care au
o experienþã micã în domeniul IT, au o
“vechime” de 3 pânã la 5 ani. Respectiva
firmã nu se poate lãuda cu o experienþã
deosebitã în ceea ce face! Hmm, unii
reuºesc, alþii nu?! 

Probabil cã e mai bine sã ne concentrãm
atenþia asupra firmelor care produc puþine
dispozitive, dar de calitate. Cum le gãsim?
Simplu. Vizitãm pagina de Internet a
respectivelor firme ºi la "products" vom
descoperi lista acestora.
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CCee  îînnsseeaammnnãã  uunn  pprroodduuss  ddee
ccaalliittaattee  ººii  ffiiaabbiill??

Spre exemplu, pe unitatea CD-ROM se
scrie de obicei viteza maximã pe care o
poate atinge acesta, dar nu viteza constan-
tã cu care acesta poate scrie/citi un disc
optic! Adicã dacã pe CD-ROM-ul meu scrie
52x asta înseamnã cã poate atinge 52 de
viteze la capãtul discului, însã în rest discul
ar putea sã fie citit doar la viteza 8x. În acest
caz, un CD-ROM cu o vitezã maximã mai
micã, însã cu o vitezã constantã mare, va
citi cu siguranþã mai repede respectivul
disc optic. De aici pot sã trag concluzia cã
atunci când pe un produs scrie cã este cel
mai rapid, acesta este adevãrul! Sau mai

corect spus, este cel mai rapid, dar nu copi-
azã cel mai repede! ªi apoi fiabilitatea. Sunt
CD-ROM-uri care funcþioneazã de ani de
zile, alte au funcþionat un an, doi. De ce?
Au costat mai puþin, nu erau o marcã
cunoscutã, garanþia era de un an în loc de
doi, ºi am avut încredere în singura per-
soanã care m-i l-a recomandat. Deci este
bine, înainte de toate, sã consulþi mai multe
persoane, mai multe firme, ºi dacã este
posibil sã nu te limitezi la douã persoane
sau douã firme! Cu cât consulþi mai multe
companii sau persoane (eventual cele care
au avut experienþe cu genul de produs care
te intereseazã), cu atât ºansele de a cum-
pãra un produs fiabil ºi de calitate sunt mai
mari. Ai încredere în cei care au experienþã,
însã verificã-i!

CCee  îînnsseeaammnnãã  pprroodduuss  
ppeerrffoorrmmaanntt??

Produsul performant este acel produs
care este cel mai bun din test. Dar ce folos,
dacã firma x (are 3 ani experienþã în fabri-
carea produselor A, care este insuficientã)
lanseazã cel mai performant produs A, iar
firma y care este de mai mult de 10 ani pe
piaþã obþine performanþe mai slabe în teste.
Într-adevãr, performanþa este performanþã,
însã ce vei zice dacã produsul A al
firmei x se va defecta de 10 ori pe
parcursul garanþiei, iar dupã
expirarea acesteia probabil se va
strica definitiv. ªi în plus, gândeºte-te la
timpul pe care îl pierzi cu trimisul pro-

dusului înapoi, aºteptatul, ca sã nu mai
pomenesc de stres! Produsul y nu a fost cel
mai bun, deºi e mai scump (adevãrat) însã
are garanþie trei ani, nu unul, iar pe client
produsul îl mulþumeºte ºi dupã expirarea
garanþiei. Experienþa în fabricarea unui
anumit tip de produs este unul dintre fac-
torii cei mai importanþi care susþin ºi dau
acel plus de încredere în respectivul dis-
pozitiv. ªi atunci ce sã zicem de firma x care
a început ºi ea de câteva luni sã fabrice pro-
duse, cã poate poate?! 

Adevãrul nu îl pot spune dând nume ale
unor companii deoarece aº putea fi consi-
derat subiectiv în alegerea fãcutã, dar eu zic
cã este uºor sã realizezi care firme
îndeplinesc anumite norme ºi standarde
din ceea ce am spus mai sus. 

MMiitt((ãã))  ssaauu  pprroodduuss  ddee  
ccaalliittaattee??

ªi atunci te întrebi: de firma asta nu am
auzit?! Oare ceea ce a produs este de bunã
calitate? Mai mult ca sigur cã nu. Dar este
cel mai bun! Sã fie redactorii ºi specialiºtii
de la toate revistele de IT subiectivi de l-au
poziþionat pe primul loc în teste? Nu. Orice
firmã nouã într-un domeniu are nevoie de
un impuls de convingere a publicului ºi de
aceea apeleazã la diverse modalitãþi "de
influenþare" pentru a putea fi sigure cã
noile produse vor da de furcã celor con-
sacrate. Aºa cã, utilizatorule, ai grijã ce
alegi! �

DDoorreell  PPuucchhiiaannuu  jjrr..

dorel@myc.ro
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COMP®ESIA AUDIO

CCoommpp®®eessiiaa  aauuddiioo..  

Cu ® deoarece, aproape orice tehnolo-
gie avansatã este brevetatã, înregistratã…
adicã trebuie sã plãtim pentru utilizarea ei.
Însã, anumiþi oameni inteligenþi "constru-
iesc" soluþii ºi pentru buzunarele cu 000-uri
:. Despre asemenea soluþii "salvatoare" vom
vorbi (sau nu 9) în cele ce urmeazã.

Contrar uzanþelor, voi prezenta la
început o listã a siturilor de unde puteþi
descãrca aplicaþiile despre care vom discu-
ta în acest articol.... De altfel, programele
menþionate se aflã ºi pe CD-urile revistei
din aceastã lunã:

Ok. Gata cu adresele, sã începem!

22  ""mmiinnuuþþeellee""  ddee  mmuuzziiccãã......  

Frecvenþa folositã de CD-ul audio este
de 44100Hz (herþi sau cicli pe secundã).
Deoarece avem douã canale de sunet
(stereo) înmulþim aceastã valoare cu 2.
Apoi, fiindcã dorim calitatea CD-ului,
sunetul va fi pe 16 biþi (2 octeþi/ciclu), adicã
înmulþit iar cu 2. Ca, într-un final, sunetul
sã ocupe 44100 cicli/secundã × 2 canale × 2
octeþi/ciclu × (2×60 secunde) = 21168000
biþi. Adicã aproximativ 20,2 MO
(megaocteþi) pentru douã "minuþele" de
muzicã (un calcul asemãnãtor se poate face
ºi în cazul imaginii). O grãmadã de spaþiu!
Compresia modernã poate stoca de zece ori
mai multã muzicã în cei 20,2 MO fãrã o
diferenþã de calitate semnificativã sau sesi-
zabilã auzului uman (compresia lossy e
avansatã, însã fiºierul audio nu va mai fi
identic cu sursa)! Deci, sã trecem (dar nu

înaintea unei mici explicaþii/descrieri a
celor trei "viteji") la comprimarea *.wav-
ului cel obraznic! (*.wav-ul - fiºierul cu
sunetul original).

MMPPEEGG11  AAuuddiioo  LLaayyeerr  IIIIII  ((MMPP33))

Acesta, la fel ca ºi Advanced Audio
Coding (MPEG2 & MPEG4 Audio) este un
standard creat de consorþiul MPEG în spe-
cial de institutul german Fraunhofer IIS
(Institut Integrierte Schaltungen). Nu voi
descrie aici ce conþine un standard sau câte
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COMP®ESIA AUDIO

Câºtigul în cazul compresiei MPEG LAYER III

Rata de biþi
Lungimea de

undã
Calitatea comparabilã (sau mai bunã) cu... Mãrimea finalã

8 Kb/s 2.5 KHz Linia telefonicã (1Ch.) 1/96

16 Kb/s 4.5 KHz Undele scurte (1Ch.) 1/48

32 Kb/s 7.5 KHz Radiourile AM (1Ch.) 1/24

96 Kb/s 11 KHz Radiourile FM (2Ch.) 1/14

128 Kb/s 16 KHz CD (2Ch.) 1/11

160-192 Kb/s 20 KHz Transparenþã perceptualã (2Ch.) 1/9-1/7

256 Kb/s 22 KHz Studio (2Ch.) 1/5

AAddvvaanncceedd  AAuuddiioo  CCooddiinngg
BeSweet 1.5b29 (http://dspguru.doom9.net/
default.htm/) BeSweetGUI
0.7b4(http://go.to/ dannidin/ )
PsyTEL AAC (http://www.doom9.org/Soft21/
Audio/aacenc_v215.zip ) sau Nero Burning
ROM 6 (http://www.ahead.de/en/
nero-prog.php/)

OOGGGG  VVoorrbbiiss
BeSweet 1.5b29 (http://dspguru.doom9.net/
default.htm/)
BeSweetGUI 0.7b4 (http://go.to/dannidin/ )
OGG Vorbis DShow sau LibVorbis.dll ºi
LibMMD.dll (http://rarewares. hydrogenau-
dio.org/ogg.html/)

MMPPEEGG11  AAUUDDIIOO  LLAAYYEERR  IIIIII  ((MMPP33))
BeSweet 1.5b29 (http://dspguru.doom9.net/
default.htm/)
BeSweetGUI 0.7b4 (http://go.to/dannidin)
LAME 3.96.1 Binary (http://mitiok.cjb.net/
default.htm/)

SSSSRRCC
(http://www.milky.ne.jp/_257Egalaxy/ssrc
/default.htm/)

WWiinnAAMMPP  55..0044 (http://www.WinAMP.com/)

Nu, nu compresia la care vã gândiþi! ªi titlul
acesta ºi Agenda întâlnirii din noiembrie v-au
fãcut cu siguranþã sã vã gândiþi la CoDec-uri ºi
descrierile acestora. Mircea spunea la un moment
dat cã aº fi obsedat de ele. Deloc! 

Însã nu ºtiu cum se face cã orice temã aº avea
pentru un articol, niºte CoDec-uri audio sau video
(nu conteazã de care!) tot vor fi implicate. Poate
ºi faptul cã în domeniul multimedia nu se poate
"supravieþui" fãrã ele. Iar ca sã vã demonstrez
asta... citiþi mai jos.



implementãri ale acestuia existã, însã un
lucru trebuie þinut minte: LAME este cel
mai performant (unde mai pui cã e gratuit
:-) CoDec MP3.

OOGGGG  VVoorrbbiiss

De fapt se numeºte mai simplu: Vorbis.
OGG este de fapt containerul multimedia
ce înglobeazã un "ºuvoi" audio Vorbis +
alte "mirodenii". Vorbis este un sistem de
compresie audio lossy open-source, desti-
nat unei game largi de utlizatori cu premisa
cã nu este îngrãdit de nici un fel de brevet
costisitor.

AAddvvaanncceedd  AAuuddiioo  CCooddiinngg

AAC-ul este predecesorul MP3-ul fiind,
dupã cum am mai spus, dezvoltat tot de cei
ce au contribuit la creearea sus-numitului
(Fraunhofer IIS, Dolby, Sony, AT&T…).
Acesta face parte din standardul multime-
dia MPEG4 ce foloseºte containerul MP4

pentru a stoca conþinut multimedia de tot
felul (imagini, subtitrãri, "ºuvoaie"
audio/video…). AAC-ul vine în mai multe
profile: AAC-LC (Low Complexity), AAC-
HE (Advanced Audio Coding High
Eficiency numit ºi aacplus, AAC+, AAC
SBR…), AAC LD (Low Delay), AAC LTP
(Long Term Prediction)… ºi este ultimul
rãcnet din industria compresiei sunetului.
Unul dintre cele mai bune implementãri
(da, aþi ghicit, tot GRATUITÃ! :) este
PsyTEL AACenc. De ce dintre cele mai
bune? Pentru cã cel mai bun este cel de la
Nero (dezvoltatorii de la PsyTEL sunt acum
angajaþi ai companiei Ahead).

Dar nu am avut deloc intenþia sã descriu

tehnologiile acestea deci... suficient! Deja
am spus prea multe! O explicaþie mai deta-
liatã (exagerat de detaliatã :) veþi gãsi
(poate) într-o viitoare ediþie a revistei MyC!

Rãmâi "pe recepþie", pentru cã în
ianuarie sau cel târziu în februarie
(aºtept H.264-ul celor de la Ahead :)
vom prezenta, în exclusivitate, un test
de CoDec-uri video cum nici o revistã
IT din lume nu a mai avut! Aºa cã...
MyCOMPUTERizeazã-te! �

CCoosstteell  II..MMaazziilluu
contact@myc.ro
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PPããrreerreeaa  ""eexxppeerrttuulluuii""!!  
((CCooDDeecc--uurrii  aauuddiioo//vviiddeeoo……  îînn  ggeenneerraall))

Nu, nu echipa de 20 specialiºti ai X

Networks-ului face treabã bunã! Nu!

Ci Y, hackerul care a mai modificat

douã valori în CoDec-ul Z! De unde

ºtiu eu asta... pãi cine e "expertul"?

Tu ascultã ce-þi spun cã ºtiu eu! Nu

sunt eu ãla care lucreazã într-un ma-

gazin IT? De ce crezi cã m-au anga-

jat? Pentru cã-s expert! Deci... ce spun

eu... aºa e! Tu foloseºte Z hacked by Y

ºi nu mai pune întrebãri suplimentare!

M-ai întrebat care e cel mai bun... ãsta

e! Acum ºterge-o! 

...zice "expertul" pe forumul

Cutare.ro. Iar ca respectivul sunt

mulþi. Mulþi care cred cã dacã pentru

el Z-ul modificat a fost cea mai bunã

soluþie, de acum înainte lumii nu-i mai

trebuie altceva. Ce conteazã dacã

ceea ce comprimã el e destinat com-

puterului, iar persoana care a pus

întrebarea are nevoie sã ruleze

fiºierul final pe hardware stand-

alone? Nooo, nu conteazã... Sau dacã

respectivul doreºte sã punã scurtele

sale secvenþe video (unice de altfel)

pe Internet cu o minimã protecþie la

copiere? Nici asta nu conteazã. În

general "expertul" are un produs

favorit pe care-l recomandã oricui

fãrã a þine cont de necesitãþile aces-

tuia. Aºadar... nu întrebaþi "experþii"!

Documentaþi-vã singuri, însã iatã

cum: studiaþi atât pãrþile bune, cât ºi

neajunsurile unui produs de acest

gen. De ex., X poate rula pe aparaturã

DVD MPEG4 iar Y are o calitate mult

mai ridicatã la o ratã de biþi mult mai

micã decât X, însã DVD playerul

MPEG4... nu îl recunoaºte! Cam aºa

stã treaba. Întrebarea nu este "care e

cel mai bun" ci "care mi se potriveºte

mai bine". Sper (de fapt ºtiu, pentru

cã sunteþi cititorii MyC!) cã veþi evita

sã luaþi în seamã pãreri de genul celei

de mai sus! 



My REPORT|GRAFICÃ|TEHNOLOGIITEHNOLOGII

40|noiembrie 2004                                                                                                                                                    www.myc.ro    

O
imagine digitalã de tip bitmap
este alcãtuitã din pixeli. Pixelul
reprezintã unitatea elementarã a

unei imagini ºi conþine informaþii despre
culoarea din zona pe care o reprezintã. Cu
cât este mai mare densitatea pixelilor, cu
atât sunt mai clare detaliile din acea ima-
gine. Rezoluþia este unul dintre termenii în
jurul cãruia se stârneºte multã confuzie ºi
în general este înþeleasã în funcþie de pro-
fesie sau de domeniul de activitate. De
exemplu, în presã, prin termenul de
rezoluþie se înþelege dimensiunea pixelului
imprimat, într-un sens liniar. În presã este
important rezultatul tipãrit la imprimantã -
300 ppi (adicã 300 pixeli pe un inch de
coalã), astfel încât rezoluþia liniarã devine
principala problemã, iar prin rezoluþie se
înþelege mãrimea pixelului tipãrit pe o

coalã. În schimb, pe un
webmaster îl intereseazã mai

puþin rezoluþia liniarã, aceasta pentru el
este prestabilitã la 72 ppi sau la 96, în
funcþie de monitorul folosit. De aceastã da-
tã pe o lungime de un inch pe ecranul mo-
nitorului, sunt dispuºi 72 de pixeli. Pixelul
monitorului are dimensiunea fixã, unui
pixel de pe monitor îi corespunde un pixel
al imaginii, iar într-un inch vor fi afiºaþi 72,
spre deosebire de imprimantã care poate
imprima 300 de pixeli pe un inch, sau chiar
mai mult. Pentru un webmaster prezintã
mai mult interes numãrul de pixeli dispuºi
pe lãþimea ºi pe lungimea ecranului. În
fotografia digitalã prin rezoluþie se înþelege
numãrul de Megapixeli. Mega înseamnã
milioane iar Megapixel înseamnã milioane
de pixeli. Numãrul total al pixelilor este mai
important, iar din acest caz prin rezoluþie la
realizarea fotografiilor se înþelege numãrul
total de pixeli captaþi de senzorul aparatu-

lui foto (rezultaþi din înmulþirea numãrului
de pixeli de pe orizontalã cu numãrul de
pixeli de pe verticalã). Dacã înmulþim 1.280
cu 960 obþinem 1.228.800, adicã 1,2
Megapixeli.

Putem înþelege mai bine rezoluþia dacã
deschidem cãsuþa de dialog Image Size din
programul Photoshop. Primul paragraf
cuprinde numãrul de pixeli dispuºi pe ori-
zontalã ºi pe verticalã. Putem lua un exem-
plu cu o imagine în care pe lãþime avem
dispuºi 2.560 de pixeli, iar pe înãlþime 1.920.
În urmãtorul paragraf putem observa cum
este calculatã automat dimensiunea ima-
ginii în funcþie de numãrul de pixeli din-
tr-un inch. Dacã avem 72 de pixeli pe un
inch de monitor, imaginea care are o lãþime
de 2.560 de pixeli va avea 2.560/72, adicã 35
de inci lãþime. O imagine de 2.650 de pixeli
lãþime va fi afiºatã pe 35 de inci, pe un mo-
nitor care afiºeazã 72 de pixeli/inci. În
acelaºi fel se poate calcula ºi înãlþimea
imaginii. Pentru presã, dacã dorim sã
tipãrim aceastã imagine, va trebui sã mãrim
numãrul de pixeli dintr-un inch. Astfel,
introducem 300 în loc de 72 ºi obþinem o
imagine cu dimensiunea de 8,5 x 6,4 inci,
iar dacã dorim sã aflãm dimensiunea în
centimetri trebuie doar sã schimbãm uni-
tatea de mãsurã (ºi în acest caz obþinem o
imagine tipãritã pe o coalã de 21 x 16 cm,
adicã aproximativ formatul A5). Pentru a
afla numãrul de megapixeli, înmulþim 2.560
cu 1.920 ºi obþinem 4.915.200, adicã 4,9CCuu  ccââtt  eessttee  mmaaii  mmaarree  ddeennssiittaatteeaa  ppiixxeelliilloorr,,  ccuu  aattââtt  ssuunntt  mmaaii  ccllaarree  ddeettaalliiiillee  ddiinn  iimmaaggiinnee
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Megapixeli. 
Problema de mãrire sau micºorare a

imaginilor poate fi ºi ea uºor înþeleasã.
Singurele imagini care pot fi mãrite la
infinit sunt imaginile vectoriale. În aceste
imagini, formele sunt definite matematic ºi
sunt independente de rezoluþie. În schimb,
imaginile bitmap sunt formate din pixeli, la
o astfel de imagine, pentru a o mãri va tre-
bui sã adãugãm pixeli. Trebuie þinut cont ºi
de faptul cã dacã fotografiezi un obiect de
la distanþã, mãrind fotografia într-un pro-
gram, nu vei evidenþia detalii care sunt
invizibile (sau care erau vizibile doar în
cazul în care fãceai fotografia de aproape).
Dacã doreºti sã mãreºti sau sã micºorezi o
imagine, în Photoshop trebuie sã bifezi
opþiunea [Resample Image] din cãsuþa de
dialog [Image Size]. Dacã aceasta nu este
bifatã, nu poþi adãuga sau înlãtura pixeli
din imagine, poþi doar observa cum se
modificã raportul dintre mãrimea imaginii
ºi numãrul de pixeli dispuºi pe un inch.
Prin resampling are loc o pierdere de cali-
tate, pentru cã pixelii trebuiesc interpolaþi.
Prin comanda resample se estimeazã ºi se
înlocuiesc pixelii lipsã iar marginile se
netezesc. Interpolarea este metoda prin

care programul adaugã noi pixeli în ima-
gine, bazaþi pe culoarea pixelilor din jur.
Existã mai multe metode de interpolare,
adicã mai multe metode de creare a pi-
xelilor noi. În Photoshop, metoda de inter-
polare setatã implicit este cunoscutã sub
numele de interpolare bicubicã. Metoda
interpolãrii biliniare este mai rapidã dar nu
dã rezultate la fel de bune. Ultima, denu-
mitã "Nearest Neighbor" nu foloseºte anti-
aliasing-ul ºi nu modificã pixelii în funcþie
de cei din jur, adãugând o valoare fixã ºi
rezultând deseori un rezultat asemãnãtor
unor "trepte" de culoare.

La deschiderea unei imagini în
Photoshop, în cãsuþa de dialog [Image Size]
poate apãrea uneori rezoluþia liniarã 1 în
loc de 72. Aceastã situaþie se datoreazã fap-
tului cã programul nu poate citi din fiºierul
respectiv informaþia legatã de rezoluþia
liniarã a imaginii ºi plaseazã implicit în
cãsuþa respectivã valoarea 1. Aceasta deter-
minã schimbarea dimensiunii imaginii în-
tr-una egalã cu numãrul de pixeli de pe ori-
zontalã sau de pe verticalã. Pentru ima-
ginea de mai sus am avea o lãþime de 2.560
de inci, care poate fi adusã la normal prin
tastarea rezoluþiei liniare dorite.

Câteva programe printre care IrfanView
(http://www.irfanview.com/), Qimage Pro
(http://www.ddisoftware.com/qimage/)
sau PhotoCleaner (http://www.photoclean-
er.com/) oferã alte metode de resampling
decât cele existente în Photoshop. Printre
acestea se numãrã Lanczos, B-Spline sau
Mitchell. Doar prin testare poþi observa
care metodã este mai bunã, þinând cont ºi
de faptul cã metodele se pot dovedi mai
bune în cazul folosirii unor anumite tipuri
de imagini. Altã imagine s-ar putea sã
obþinã rezultate mai bune cu un alt algo-
ritm, din aceastã cauzã este indicatã
testarea, folosind chiar imaginea de care ai
nevoie. S-a observat ºi faptul cã se pot
obþine rezultate mai bune la resampling
dacã este fãcut treptat, dacã mãreºti ima-
ginea cu puþin, dar de mai multe ori. În loc
sã mãreºti o imagine de la 100% la 300%, o
faci treptat de la 100% la 120%, de la 120%
la 140% ºi aºa mai departe, folosind un pro-
gram precum Adobe Photoshop. Alãturi de
aceste tehnologii, Genuine Fractals 2.0 ºi
Genuine Fractals Print Pro încearcã sã rupã
bariera limitãrii rezoluþiei. Programele
codeazã imaginea cu rezoluþie micã într-un
format scalabil numit StiNG (*.stn).
Fiºierele cu extensia .stn pot fi deschise la
orice rezoluþie doreºti, iar programele
funcþioneazã ca plugin-uri pentru Adobe
Photoshop. Când deschizi un fiºier cu
extensia .stn poþi alege mãrimea imaginii
precum în imaginea alãturatã. Aceastã
tehnologie s-a dovedit bunã în multe teste,
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situl produselor este www.lizardtech.com,
dar din pãcate aspectul negativ este costul
de achiziþie ridicat. 

Într-un joc realizat în trei dimensiuni,
mediul este alcãtuit din forme geometrice
acoperite de imagini bitmap (care reprezin-
tã texturile). Aceste texturi folosesc multã
memorie ºi multã vitezã de procesare a sis-
temului. Imagineazã-þi cum ai deschide în
acelaºi timp într-un program precum
Photoshop; 10 fiºiere cu imagini la o
rezoluþie foarte mare. Timpul lor de încãr-
care este extrem de mare ºi ar fi cu mult mai
mare dacã imaginile ar suferi transformãri
în timp real. Cu cât camera din care
priveºte cel care joacã se apropie mai mult
de un obiect, cu atât mai mult se vor evi-
denþia pixelii din care este alcãtuitã ima-
ginea folositã ca texturã pentru obiectul
respectiv. În realitate, cu cât te apropii mai
mult de un obiect, detaliile acestuia sunt tot
mai evidente, nu pixelii. Pentru a obþine un
rezultat cât mai apropiat de realitate se pot

folosi texturi la o rezoluþie mare, dar pentru
a simula miºcarea în timp real este necesarã
o putere de procesare foarte mare. În loc de
a folosi texturi la o rezoluþie foarte mare se
pot defini texturi prin formule matematice
(asemãnãtor cu formarea imaginilor vecto-
riale). Prin aceastã metodã se pot forma tex-
turi la o rezoluþie infinitã, limitate doar de
complexitatea formulelor matematice.
Acest fel de texturi poartã numele de "pro-
cedural textures" (texturi procedurale) ºi
sunt tot mai des folosite, în special pentru
generarea componentelor mediului încon-
jurãtor. La folosirea lor efectul de pixelare
dispare, formele fiind tot mai mari ºi mai
vizibile pe parcursul apropierii de obiect.
Poþi folosi o pensulã virtualã pentru a
"picta" cu aceste texturi sau modele prede-
finite, pe unde trasezi cu pensula pot
apãrea, de exemplu, pietre definite dupã
anumite formule matematice. Poþi combina
aceste pietre cu un alt fel de texturã proce-
duralã, precum zãpada. Cele douã nu

numai cã se vor combina în funcþie de
culori, ci ºi în funcþie de formulele mate-
matice. Dacã doreºti sã mãreºti o astfel de
imagine nu vei observa pixelii, aceste tex-
turi sunt calculate în timp real la fiecare
cadru afiºat pe ecran. Conceptul nu este
unul nou, el a mai apãrut în câteva aplicaþii,
de exemplu aplicaþia Xres de la
Macromedia, (aceasta nu a fost dezvoltatã
prea mult în ultimii ani), sau în aplicaþia
DarkTree (http://www.darksim.com/html/

darktree25.html). Oricum, mai trebuie sã
aºteptãm mult timp pânã când puterea de
procesare va depãºi limitarea la folosirea
unor imagini în spaþiul 3D la o rezoluþie
foarte mare sau a unor algoritmi care sã le
reproducã, însã pânã atunci ne rãmâne...
doar lupta care o purtãm zilnic cu pixelii.�
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Î
n paralel cu apariþia ºi rãspândirea
explozivã a programelor de partajare a
fiºierelor prin reþele de tip peer-to-

peer, a apãrut ºi o mare oportunitate de
afaceri. Numãrul de utilizatori reprezintã
prima ºi cea mai importantã condiþie pen-
tru o reclamã de succes, iar reþelele p2p o
satisfac din plin. Dar chiar mai mult,
Internetul, spre deosebire de televiziune,
oferã posibilitatea comunicãrii în ambele
direcþii. Prin Internet poþi afla mai multe
despre cei care îþi vizioneazã reclama, fie
dacã ei doresc sau nu acest lucru. Altfel
spus, marile companii pot spiona utiliza-
torii care navigheazã pe Internet pentru a
le observa preferinþele ºi pentru a-ºi mo-
dela reclama în funcþie de acestea.
Programele folosite în astfel de scopuri
sunt cunoscute sub numele de "spyware",
iar cu ajutorul lor se pot afla multe detalii

despre utilizatorul sau utilizatorii
care folosesc calculatorul infectat. Se poate
afla pe ce situri navigheazã, la ce ore, pro-
gramele folosite mai des, adresele de e-mail
utilizate, se pot redirecta cuvintele cãutate
cãtre un anumit motor de cãutare, ºi multe
alte informaþii personale. Totuºi pro-
gramele trebuiesc instalate pe calculatoare
cu acordul utilizatorului pentru cã
reclamele nu sunt secrete, sunt publice. Cu
toate cã acest acord pare a fi un lucru greu
de câºtigat, spyware-ul este rãspândit pe
aproximativ 70% din calculatoarele conec-
tate la Internet. Majoritatea utilizatorilor
nu citesc acest acord care trebuie acceptat
pentru instalarea programului însoþit de
aºa-zisul parazit, iar dupã instalare acesta
devine invizibil ºi extrem de greu de înlã-
turat. Programele gratuite sunt mediile cele
mai des întâlnite pentru ataºarea spyware-

ului. La programele gratuite (sau free-
ware), nimeni nu îºi asumã responsabili-
tatea pentru daune, ºi în plus, dacã un ast-
fel de program este folosit de un numãr
mare de utilizatori, devine mediul prielnic
pentru alãturarea unui spyware. Dacã vei
avea nevoie de program, vei neglija amã-
nuntele - acesta este modul în care gândesc
companiile implicate, adevãratul motiv
pentru care spyware-ul este atât de rãspân-
dit. Programele de partajare a fiºierelor
prin reþele tip peer-to-peer sunt gratuite,
sunt printre cele mai descãrcate programe
ºi reprezintã unul din principalele puncte
de rãspândire ale programelor spyware.

De exemplu, gator.exe este un astfel de
program. Acesta monitorizeazã navigarea
utilizatorului pe Internet ºi trimite datele
companiei Gator. În plus reclamele de pe
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siturile vizitate sunt înlocuite cu reclamele
acestei companii. Programul este instalat
pe sistem alãturi de programe ca Limewire,
AudioGalaxy, eWallet, Kazaa, alãturi de
câteva programe legate de ceasul din tray-
bar, alãturi de programele care se instaleazã
direct de pe Web ºi alãturi de multe apli-
caþii de partajare a fiºierelor prin p2p.
Fiºierul cmesys.exe va urmãri adresele vi-
zitate pentru a le trimite serverelor com-
paniei Gator. The Gator Adveritising
Information Network, prescurtat GAIN,
foloseºte un alt fiºier numit gmt.exe pentru
afiºarea reclamelor, acesta putând fi folosit
pentru a instala ºi alte programe fãrã inter-
venþia utilizatorului (fãrã posibilitatea de a

opri instalarea). Pânã acum compania Gator
a fãcut reclame multor firme printre care:
1-800 Flowers, Allstate Insurance, Apple
Store, Avon, CapitalOne Mastercard,
Chrysler, Columbia House, Disneyland
Resort, Dollar Rental Car, Expedia, First
Premier Bank, FTD.com, Hooked on
Phonics, ING Direct, LoJack, Movielink,
Orbitz, Palm, Priceline, Radisson, Rail
Europe, Sun Microsystems, Thrifty Rental
Cars, Time-Life, Travelocity, uBid, Verizon
DSL ºi Western Union Bidpay. Când
Internet Advertising Bureau (IAB) a
început sã acuze compania Gator de
metodele practicate, compania Gator a dat
în judecatã IAB-ul pentru a preveni blo-
carea reclamelor. În prezent procesul nu 

s-a terminat iar Compania Gator continuã
sã foloseascã respectivele metode. În plus,
compania a fãcut un efort pentru a-ºi
dezlega numele asociat cu spyware-ul ºi l-a
schimbat în Claria Corporation. Recent
compania s-a asociat cu câteva motoare de
cãutare pentru a trimite reclamele prin
intermediul barelor de cãutare care sunt
uºor de instalat (Overture, Terra Lycos,
FindWhat). Utilizatorii care instaleazã noua
barã de cãutare SearchScout vor fi asaltaþi
de reclamele tip pop-up din reþeaua GAIN,
care vor fi afiºate în funcþie de cuvintele
cãutate sau cu siturile pe care navigheazã
utilizatorul. 

Programul Bearshare, dezvoltat de Free
Peers Inc. este un program pentru parta-
jarea fiºierelor prin p2p, bazat pe proto-
colul Gnutella. Programul a fost descãrcat
de 20 de milioane de ori într-o singurã sãp-
tãmânã a lunii octombrie, ºi este disponibil
în douã variante: BearShare Pro ºi
BearShare Free. Varianta BearShare Pro
este versiunea care costã ºi care nu vine
însoþitã de alte programe, fapt ce intervine
în cazul versiunii gratuite. Pe pagina Web a
programului este precizat cã alãturi de ver-
siunea gratuitã, pe calculator nu va fi insta-
lat nici un program spyware, iar în alt con-
text este explicat cum compania nu consi-
derã programul SaveNow a fi un program
spyware. Existã multe discuþii în jurul aces-
tui program, multã lume îl considerã spy-
ware în timp ce dezvoltatorii lui susþin cã
este doar un program adware, adicã
afiºeazã, doar, reclame. S-a demonstrat cã
programul monitorizeazã ºi activitatea uti-
lizatorului pe Web ºi trimite înapoi infor-
maþii serverelor companiei. SaveNow
ruleazã chiar ºi dupã oprirea programului
alãturi de care a fost instalat. Din multe
surse s-a afirmat cã programul urmãreºte ºi
informaþii legate de genul ºi de vârsta uti-
lizatorului, þara ºi codul poºtal, sau adrese-
le ºi cuvintele cãutate pe Internet.
Programul stocheazã pe disc informaþiile
criptate în fiºierul savenow.db din direc-

My REPORT|SECURITATE|SPYWARESPYWARE

44|noiembrie 2004                                                                                                                                                     www.myc.ro   

RReeþþeeaauuaa  GGAAIINN  --  TThhee  GGaattoorr  AAddvveerriittiissiinngg  IInnffoorrmmaattiioonn  NNeettwwoorrkk  --  www.gainpublishing.com

VVeerrssiiuunneeaa  ggrraattuuiittãã  aa  pprrooggrraammuulluuii  BBeeaarrSShhaarree  vviinnee  îînnssooþþiittãã  ddee  aallttee  pprrooggrraammee

NNoouull  ssiitt  aall  ccoommppaanniieeii  GGaattoorr

www.gator.com ssaauu  www.claria.com



torul SaveNow ºi le trimite serverelor com-
paniei. Dacã tastezi "job" în motorul de
cãutare programul îþi poate afiºa informaþii
despre o ofertã specialã a sitului
Hotjobs.com sau dacã tastezi ceva legat de
cuvântul "buy" îþi poate afiºa o ofertã spe-
cialã din domeniul care îþi prezintã interes.
Aplicaþia verificã din trei în trei secunde
dacã a fost deschisã o nouã paginã Web, ºi
foloseºte putere de procesare pentru acest
lucru, puþinã dar întreþinutã. Unele vari-
ante ale programului pot fi înlãturate din
Control Panel - Add\Remove Programs, dar
existã ºi variante foarte greu de înlãturat.

Bittorrent-ul este un program open-
source distribuit sub o licenþã care permite
modificarea ºi redistribuirea sub altã formã.
Dupã modificare, produsul rezultat trebuie
sã fie tot open-source, adicã sã poatã fi
modificat în continuare de oricine. O com-
panie sub numele Unify Media Ltd a
început distribuirea unui astfel de client
Bittorrent modificat ºi infectat cu parazitul
C2Media/Lop. Lop (Live Online Portal)
este o familie de programe care modificã
pagina de start a Internet Explorer-ului la
una din adresele din imaginea alãturatã.
Acesta adaugã ºi un proces la pornirea
Windows-ului care seteazã automat
aceastã paginã de start din Internet
Explorer. În variantele mai noi ale progra-
mului, dacã reschimbi pagina de start, pa-
gina nouã va fi trecutã printr-un set de
frame-uri, rezultãnd o barã de cãutare în
partea de jos a paginii introduse de tine ca
paginã de start. ªi acest program este greu
de înlãturat manual, dar prin folosirea unui
program special pentru înlãturarea spy-

ware-ului nu va mai prezenta o problemã.
Un alt program care însoþeºte aplicaþii

precum LimeWire, Grokster sau Kazaa,
numit DlDer (denumit ºi ClickTillUWin)
este o combinaþie troian-spyware. Pro-
gramul îºi descarcã ultimele îmbunãtãþiri
ale codului, se conecteazã la un anumit sit
(www.2001-007.com) ºi trimite adresa IP a
calculatorului, alãturi de o serie de infor-
maþii, printre care ºi adresele Web vizitate,
sub forma http://www.2001-007.com/

i ndex . sp?Use rURL=GET+/&Use r _

IP=10.0.0.1&Userid=127&User_Browser

=IE). Fiºierul dlder.exe, care reprezintã pro-
gramul spyware poate instala un troian pe
calculatorul infectat. Acesta descarcã
fiºierul Explorer.exe în directorul
C:\Windows\explorer\Explorer.exe (nu tre-
buie confundat cu fiºierul situat chiar în
directorul Windows) ºi ataºeazã o cheie în
Windows Registry (HKLM\SOFTWARE\
Games\Clicktilluwin) pentru rularea
automatã la pornire, în locul fiºierului nor-
mal. Acesta este detectat de multe pro-
grame antivirus, dar unele dintre ele l-au
scos din baza de date pentru cã nu se mul-
tiplicã (F-Secure). Compania care deþine

programul Grokster oferã un program spe-
cial pentru înlãturarea lui pe care îl poþi
gãsi la adresa http://www.grokster.com

/files/dlder-remove.exe.
Kazaalite ºi Groksterlite sunt versiuni

ale programelor Kazaa ºi Grokster din care
a fost înlãturat spyware-ul. Cele douã pro-
grame sunt gratuite, multã lume a fost
indusã în eroare crezând cã programele au
fost create de aceeaºi autori. Aceste versi-
uni "lite" sunt în fond modificãri ilegale,
pentru înlãturarea spyware-ului au fost
încãlcate acordurile de licenþã. Chiar dacã
folosirea versiunilor "lite" pare avantajoasã,
marile companii care deþin produsele spy-
ware au numai de câºtigat. Conectându-te
la servere creºte numãrul de utilizatori,
lucru care este în favoarea clienþilor com-
paniei de spyware. Un numãr de peste 1
milion de utilizatori conectaþi, cu siguranþã
impresioneazã un posibil client al unei
companii de spyware, chiar dacã un pro-
cent de 20% ar folosi versiunea din care
spyware-ul a fost înlãturat.

Multe companii care distribuie pro-
grame spyware alãturi de produsele gratu-
ite îºi prezintã serviciul oferit din punctul
lor de vedere ºi de multe ori pare corect.
Nu este recomandatã folosirea nici unui
produs care conþine programe spyware
încorporate, în genenral companiile care
oferã acces la jocuri de noroc sau agenþiile
turistice îºi fac astfel de reclame.
Companiile care dezvoltã programele spy-
ware plãtesc mulþi bani dezvoltatorilor de
programe gratuite pentru a le alãtura pro-
dusul. Singura metodã prin care poate fi
descurajatã acceptarea ataºãrii unui pro-
gram spyware de cãtre dezvoltatorul pro-
gramului gratuit rãmâne refuzul în masã
pentru folosirea programului respectiv. �
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C
ombinaþia de elemente 2D ºi 3D
realizate de fostul student Ricardo
Biriba, ca proiect de diplomã pen-

tru Universitatea Academy Of Art din San
Francisco, a uimit specialiºtii din întreaga
lume. Scopul urmãrit de autor pe parcursul
lucrãrii a fost îmbunãtãþirea modului de
animare a personajelor precum ºi a celui
prin care a fost realizatã povestirea acþiunii.
Dragonul, care reprezintã centrul atenþiei,
a fost realizat într-o manierã foarte simplã
ºi plãcutã. La acest proiect Ricardo a lucrat
singur opt luni, dar a lucrat între timp ºi la
alte proiecte. Majoritatea muncii
(desenarea) a fost realizatã în programul
Adobe Photoshop, asamblarea fiind rea-
lizatã în Adobe After Effects. Elementele 3d
au fost proiectate în Maya, dar modelarea a
fost redusã la doar 3 elemente: dragonul,
pãpuºa ºi cãºtile oamenilor, restul a fost
realizat în douã dimensiuni. Secvenþa a fost
nominalizatã la 3D Awards 2004, unde a
fost vizionatã de sute de profesioniºti din

domeniul animaþi-
ilor. 

Într-un interviu acordat
reprezentanþilor sitului www.

cgnetworks.com, Ricardo Biriba a explicat:
"întotdeauna am fost interesat de ilustraþii,
iar universul cãrþilor pentru copii mi-a
cucucerit mereu atenþia. Probabil din acest
motiv animaþia ºi ilustraþia sunt prezente în
filmul pe care l-am realizat. La început am
fost foarte îngrijorat de modul în care va
arãta ºi am revãzut de multe ori animaþiile
ºi desenele preferate, printre care Bugs
Bunny, Tom ºi Jerry, desenele realizate de
Disney ºi animaþiile realizate de Pixar. Am
studiat mult ºi am cules mult material pe
care am încercat sã îl prezint în cel mai plã-
cut mod posibil".

În procesul realizãrii unei animaþii, cel
mai important lucru este posibilitatea de a
învãþa ºi de a experimenta cu fiecare pas
fãcut. Cea mai mare problemã dupã spuse-
le lui Ricardo Biriba a fost realizarea unui

mediu destins, colorat, asemãnãtor cu cel
din cãrþile ilustrate pentru copii. Chiar dacã
întregul proiect a fost realizat doar de el,
Ricardo a menþionat "alt lucru pe care l-am
învãþat în acest proiect este cã, lucrând la
un proiect de unul singur, ajutorul priete-
nilor are un rol fundamental. O pãrere
diferitã te poate îndruma pe o cale extrem
de bunã, acest ajutor în majoritetea
cazurilor este foarte util pentru rezultatul
final. Am fost foarte norocos pentru cã am
avut câþiva sfãtuitori care m-au ajutat mult,
care au discutat cu mine mult timp pentru
a ajunge la un rezultat bun ºi la o soluþie
simplã. "

Ricardo Biriba a lucrat ca animator pen-
tru departamentul de publicitate al unei
televiziuni din Brazilia. Dorind sã pãtrundã
în domeniul animaþiei 3D s-a mutat în San
Francisco unde a studiat la Universitatea
Academy Of Art ºi a terminat prin
realizarea acestui proiect. Animaþia o puteþi
urmãri pe unul dintre CD-urile revistei, iar
în final un sfat dat de la Ricardo Biriba pen-
tru cei care doresc sã realizeze astfel 
de proiecte: "Pãstreazã simplitatea!". �
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F
iecare dintre proiectele de ani-
maþie 3D realizate pânã acum de
Studioul Dreamworks au avut o

caracteristicã comunã - atenþia pentru
detaliile din fundal. În cele douã filme
Shrek ºi Shrek 2 personajele din basme au
fost integrate într-o lume comunã. Fiind
atent la detaliile din fundal, poþi identifica
o mulþime de basme, de locuri ºi de per-
sonaje specifice acestora. Fãcutã într-un
mod comic, atenþia pentru detalii este
punctul forte al acestui studiou ºi este vi-
zibilã din plin ºi în filmul Shark Tale
(rechinii trãiesc pe epava vaporului Titanic,

peºtii se identificã cu diferitele tipuri de
oameni). Chiar dacã nivelul aprecierii stu-
dioului Dreamworks este cu mult mai
redus decât al studioului Pixar, se pare ca
Dreamworks nici nu doreºte o rivalizare
directã, concentrându-ºi atenþia asupra
unei audienþe care înþelege parodia. În
Shark Tale acþiunea se petrece într-un
mediu subacvatic, atenþia cade asupra unui
peºte numit Oscar (vocea lui Will Smith)
situal la limita inferioarã a lanþului trofic,
transformat în erou printr-o mare minci-
unã. În majoritatea animaþiilor realizate de
Dreamworks vocile peºtilor sunt realizate
de actori celebri. În Shark Tale îi vom auzi
pe Robert De Niro, Renee Zellweger, Jack
Black sau Angelina Jolie.  Prezentarea fil-
mului poate fi  vizionatã pe unul dintre
CD-urile revistei la secþiunea Video. �
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3
Dtotal a lansat un DVD care
cuprinde o colecþie cu animaþii
scurte ºi trailere la calitate mare,

realizate în anul 2004. Studenþii, animatorii
independenþi ºi studiourile comerciale se
pot afirma prin intermediul acestui DVD.
Dintre cei care au trimis proiectele realizate
în anul 2004, doar cei mai buni au fost aleºi
pentru prezentarea pe DVD. Cei de la
3DTotal au conceput acest DVD astfel încât
sã ofere un pachet de animaþii la o rezoluþie
mare, alãturi de informaþii ºi imagini din
timpul realizãrii, sau de secvenþe bonus.
Printre acestea se aflã si cunoscutul film de
scurt metraj "Bath Time" realizat de Carlos
Fernandez, filmul "Dronez" realizat de un
grup de studenþi de la German Film
School, "Freaky bird" (un film inspirat dupã
"For The Birds" realizat de Pixar ºi dupã
Scrat realizat de studioul Blue Sky) ºi multe
altele. Pe unul dintre CD-urile revistei
puteþi urmãri un trailer care cuprinde câte-
va secvenþe din animaþiile incluse pe acest

DVD. 
Dupã lansarea DVD-ului pentru anul

2004 a început preselecþia animaþiilor pen-
tru anul 2005. Pentru a participa, trebuie sã
trimiþi un e-mail la adresa ben@3dtotal.

com cu un link de unde poate fi descãrcatã
animaþia ºi informaþii despre modul în care
a fost realizatã, o scurtã explicare a acþiunii,
timpul realizãrii. Animaþia trebuie sã fie la o
calitate cât mai mare, preferabil ar fi for-
matul mpeg2 PAL 720x576. �
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C
ãuta ºi vei gãsi! Un verset de când
lumea, iar problema (a cãuta ºi a
gãsi) îºi are rãdãcini în toate

domeniile ºi a devenit începând cu anii '90
un subiect de mare interes ºi în lumea IT.
Mai ales cã informaþia pe Internet (ºi nu
numai) a luat proporþii imense în ultimii 5

ani. Trebuie sã ne aducem aminte de
începutul anilor '90 când hard discul calcu-
latorului rareori depãºea 40 MB. Dupã ce
au trecut mai bine de 14 ani, pe zi descãr-
cãm de pe net în medie 40 MB, fie prin na-
vigãri pe Internet, fie prin simple down-
loaduri de pe diferite situri. Ideea este clarã,

cã informaþia este din ce în ce mai multã ºi
creºte în progresie geometricã nu aritme-
ticã în zilele noastre; din aceastã cauzã este
din ce în ce mai greu sã gãsim ceea ce
dorim fãrã a avea o bazã de date, fãrã a
cãuta cu binecunoscutul Google, fãrã a
folosi un motor de cãutare etc. În acest arti-

ªªii  îînnvvaaþþãã  ccuumm  ssãã  oo  ffoolloosseeººttii!!ªªii  îînnvvaaþþãã  ccuumm  ssãã  oo  ffoolloosseeººttii!!
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col voi trata crearea
bazei de date, arhivarea
volumelor în baza de date,
securizarea bazei de date,
setãrile (suplimentare)
oferite de programul respec-
tiv, cãutarea pe hard discul
propriu, CD-urile ºi DVD-urile
proprii. Cu toþii deþinem cel
puþin câteva CD-uri, sau DVD-
uri , ºi/sau poate mai multe hard
discuri (partiþii). De obicei, la un
moment dat trebuie sã cãutãm
ceva pe aceste discuri optice ºi
imagineazã-þi ce greu e sã cauþi pe
fiecare CD sau DVD în parte un
anume fiºier/director. Însã, cu o bazã
de date, în care se aflã câte o imagine
cu conþinutul fiecãrui CD sau DVD
(partiþie) pe care îl/o deþii, lucrurile devin
mult mai simple ºi mai eficiente. Cu aju-
torul motorului de cãutare al progra-
mului de catalogare poþi sã cauþi
ceva anume simultan pe
toate CD/DVD-urile/par-
tiþiile pe care le deþii,
sau cel puþin cele
pe care le-ai
înregistrat
în baza de date a pro-
gramului respectiv. 

I. Crearea bazei de
date

Lucrurile sunt simple, numai cã totul are
un început: în programul de catalogare
creezi un fiºier (numit bazã de date) în care
înregistrezi imaginea fiºierelor ºi direc-
toarelor de pe fiecare CD/DVD pe care îl
deþii, iar dupã aceasta în noua baza de date
pe care ai creat-o poþi sã: a) gãseºti uºor
ceea ce cauþi; b) reînnoieºti imaginea
CD/DVD-ului existent în baza de date; c)
adaugi volume noi (CD, DVD-uri, partiþii
ale unui hard disc, dischete, etc.) d) adaugi
comentarii pentru fiecare volum; e) execuþi
un fiºier mp3, vizualizezi un film, vizua-
lizezi o imagine, prin simpla selectare a
fiºierului ºi introducerea volumului (discu-
lui optic) pe care se aflã acesta.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Adãugarea unui volum nou de obicei nu
constituie o problemã, majoritatea pro-
gramelor dedicate au un buton care per-

mite imediat adãugarea unui nou volum în
baza de date. 

Pe lângã acestea însã poþi seta unele
opþiuni de adãugare, adicã de exemplu, sã
nu adauge directoarele al cãrui conþinut
este de 0 biþi, sã scaneze ºi interiorul
fiºierelor compresate etc. 

Oricum setãrile se pot opta în funcþie de
necesitãþile fiecãruia. 

Pentru a cunoaºte mai bine programul
prezentat aici am explicat amãnunþit
setãrile considerate de mine mai impor-
tante incluse în programul de catalogare.

III. Cãutarea unui fiºier
anume sau director în baza
de date

Cãutarea este la fel de uºoarã ca ºi adãu-
garea, însã ºi aici poþi seta diferiþi para-
metri, ca de exemplu: cãutarea în
descrierea fiºierelor, cãutarea acelor fiºiere
care sunt asemãnãtoare sau care au o anu-
mitã mãrime în MB etc.

IV.Securizarea bazei de
date

Poate cã nu vrei ca toþi sã aibã acces la
baza ta de date! Sau poate ai nevoie de mai
multã siguranþã. Majoritatea programelor
de catalogare includ un sistem de
securizare cu ajutorul unei parole. Din
pãcate aceastã parolã nu poate constitui o
problemã pentru profesioniºti, însã pentru
oamenii simpli, aceastã criptare a bazei de
date cu o parolã este de bun augur. Oricum
pentru mai multã siguranþã îþi recomand sã
pãstrezi baza de date pe un suport care nu
este accesibil oricui. 

Prezentarea mai multor
programe de catalogare ºi
utilizarea lor

Un program de catalogare trebuie sã
îmbine mai multe aspecte, adicã sã fie uºor
de utilizat, sã integreze multe funcþii de
cãutare, sã aibã un aspect plãcut , sã secu-
rizeze baza de date creatã, sã asigure back-
up în orice moment etc.
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Advanced Disk Catalog (ADC) este un
program uºor de utilizat cu o interfaþã sim-
plã, foarte asemãnãtoare cu Explorer din
Windows. Programul îþi permite sã adãugi
în baza de date unitãþi precum dischete,
hard discuri (inclusiv cele din reþeaua
localã), discuri optice, discuri ZIP ºi ale
medii. Programul Advanced Disk Catalog
este scris complet în C++, iar bazele de
date pe care le genereazã sunt foarte com-
pacte.

I. Crearea bazei de date

Crearea bazei de date se face din meniu,
de la File>New, sau de la butonul [Create
new catalog] care se gãseºte pe a doua barã
a lui ADC. Denumirea catalogului se face în

momentul salvãrii acestuia, iar redenu-
mirea se poate face din Explorer.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un nou volum fie el
orice mediu de stocare, ar fi bine sã vedem
ce setãri ne oferã programul ADC. De la

Options>Preferences>General poþi ajus-
ta: sã se deschidã automat ultima bazã de
date; sã salveze layout-ul; sã afiºeze
iconurile asociate respectivelor programe;
în navigatorul de proprietãþi sã treacã
automat la urmãtorul fiºier; sã reþinã ulti-
mul loc de unde a deschis/salvat baza de
date; sã caute în fiºierele arhivate; sunete;
stilul vechi al toolbar-ului; sã creeze backup
în momentul salvãrii bazei de date; sã mi-
nimizeze programul în sistem tray; sã nu
afiºeze logo-ul la pornire; care program sã
se utilizeze în locul explorerului; care pro-
gram de antivirus sã se utilizeze; când se
executã dublu clic pe un fiºier, sã fie:
deschis fiºierul sau sã fie afiºate propri-
etãþile acestuia; sã calculeze mãrimea direc-
toarelor; sã calculeze mãrimea subdirec-
toarelor; sã afiºeze spaþiul ocupat în KB
(MB); sã salveze automat baza de date când
programul este neutilizat timp de "n"
minute ("n" poate sã aibã o valoare de la 0

la 60 min.). Options>Preferences>Scan -
poþi ajusta: sã scaneze în fundal; sã
pãstreze în cazul unui update descrierea
discului; schimbare/setare de numãr unic
(serie) al unui disc; analizarea fiºierelor
compresate; analizarea arhivelor SFX,
extragerea comentariilor din arhivã;

extragerea descrierilor fiºierelor din arhivã
(file_id.diz); ignorarea fiºierelor ascunse ºi
a directoarelor; sã ejecteze mediul optic
dupã scanare; extragerea automatã de pe
internet a titlurilor în cazul CD-urilor audio
(CDDB).
Options>Preferences>Descriptions -

de aici poþi seta de unde sã extragã
descrierea fiºierelor ºi a directoarelor.
Options>Preferences>Arhives - poþi seta
care extensii de arhive sa fie scanate sau nu.
Options>Preferences>Language - poþi
seta limba în care sã fie afiºat meniul. 

Adãugarea se face din meniu de la
Edit>Add volume, de asemenea tot

de acolo poþi updata sau ºterge volumul
selectat. 

III. Cãutarea unui fiºier 
sau director în baza 
de date

Motorul de cãutare din ADC se
porneºte din meniul Tools>Search sau cu
ajutorul iconului specific care se aflã pe a
doua barã a programului. Cãutarea în ADC
se poate face dupã nume, comentariu, data
care poate seta în intervale sau dupã acce-
sare, mãrime.

IV. Securizarea bazei de
date

ADC nu include nici o posibilitate de
securizare a bazelor de date, în consecinþã
baza ta de date este vulnerabilã. Singura
protecþie pe care o poþi aplica este sã o
arhivezi cu parolã ºi sã o depozitezi pe un
disc optic care nu poate fi accesat de cãtre
oricine.
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Advanced File Organizer are o interfaþã
deosebitã care îmbinã plãcutul cu utilul.
Este uºor de utilizat ºi nu este nevoie sã
navighezi prin meniul acestuia ca sã gãseºti
de unde se adaugã un nou volum în cata-
log, pentru cã designul iconurilor vorbeºte
de la sine. Advanced File Organizer îþi per-
mite sã adaugi în baza ta de date orice fel
de mediu care conþine informaþii digitale,
inclusiv memorii flash.

I. Crearea bazei de date

Crearea bazei de date se poate face din
meniu de la File>New sau cu ajutorul
scurtãturii Ctrl + N. Redenumirea cata-
logului se poate face cu tasta F2.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou în
catalogul proaspãt creat e bine sã vedem ce
setãri ne oferã Advanced File Organizer v.

2.4. Astfel, din meniul Tools>Options -

General poþi sã setezi Interfaþa: salvarea
layout-ului în momentul pãrãsirii progra-
mului, deschiderea automatã a ultimului
catalog utilizat, afiºarea fiºierelor ºi a direc-
toarelor în format compact, creare de back-
up a catalogului (.bak), când se face dublu clic

pe fiºier sã: afiºeze proprietãþile fiºierului,
lanseze Explorer în directorul respectiv, sã
deschidã fiºierul cu programul asociat

(NOTÃ: Alt + dublu click - afiºeazã propri-
etãþile fiºiserului/directorului).  Opþiuni de
scanare: sã pãstreze în cazul unui update
descrierea discului, sã ignore fiºierele ºi
directoarele ascunse, sã extragã conþinutul

fiºierelor arhivate (Zip, Rar, Ace), sã
ejecteze discul optic dupã scanare.
Tools>Options - Descriptions poþi seta: de
unde sã extragã descrierea fiºierelor/direc-
toarelor, sã importe descrierile CD-urilor
audio de pe Internet, sã importe descrierile
documentelor, sã importe descrierile
fiºierelor MP3. Tools>Options - Language

poþi seta: limba cu care sã se afiºeze meniul
programului.

Adãugarea unui nou volum se face din
meniu de la Edit>Add Disk sau
cu tasta F6 sau clic pe icoana
care se aflã pe a doua barã din
interfaþa programului. În

momentul în care se afiºeazã dialogul de
scanare, putem selecta unitatea pe care
dorim sã o scanãm; opþional putem alege
ejectarea unitãþi optice ºi numai adãugarea
directoarelor.

III. Cãutarea unui fiºier 
sau director în baza de date

Motorul de cãutare se aflã în meniu la
Tools>Find (Ctrl + F) sau iconul de forma
unei lupe din bara a doua a programului.
Advanced File Organizer poate cãuta:
dupã majusculã, numai directoare, în
descrieri, în categorii de nume, numai pe
un volum specificat sau în toatã baza de
date, pe categorii, fiºierele modificate în-
tr-un anume interval de date, fiºierele mo-
dificate în ultimele zile (luni, ani), fiºierele
cu mãrimi cuprinse între un minim sau
maxim.  

IV. Securizarea bazei de
date

Advanced File Organizer nu include
nici o posibilitate de securizare a bazelor de
date, în consecinþã baza ta de date este vul-
nerabilã. Singura protecþie pe care o poþi
aplica este sã o arhivezi cu parolã ºi sã o
depozitezi pe un disc optic care nu poate fi
accesat de cãtre oricine.
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Programul de catalogare Argentum
MyFiles a primit mai multe premii ºi are o
interfaþã destul de asemãnãtoare cu cea lui
Advanced File Organizer, însã spre deose-
bire de celelalte programe de catalogare,
acesta poate genera automat un index
HTML care poate fi publicat pe un site sau
poate fi trimis respectivul HTML unui pri-
eten care nu dispune de programul
Argentum pentru a putea vizualiza baza ta
de date. Cu toate aceste avantaje, progra-
mul Argentum este ciudat când vine vorba
de operarea unei baze de date create de el
însuºi!

I. Crearea bazei de date

Crearea bazei de date este simplã, ea se
face din meniu File>New unde se
genereazã o aºa numitã rãdãcinã, care este
de fapt baza de date. Dupã denumirea ei,
în interfaþa programului o sã observi cã,
baza ta de date se numeºte "New tree", pare
ciudat însã, programul considerã noua
bazã de date cu numele X (de exemplu)
având o rãdãcinã nouã (New tree). Pentru a

nu confunda noua bazã de date se poate
face recent creatã, îþi recomand sã schimbi
ºi numele rãdãcinii cu numele bazei tale de
date. Astfel, trebuie sã editezi numele aces-
teia cu ajutorul butonului drept al mouse-
ului sau cu tastele Alt + E. Dupã care
schimbi numele acesteia, iar cu ajutorul
combinaþiilor de teste Alt + S salvezi noul
nume al bazei de date.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou în
catalogul proaspãt creat, e bine sã vedem ce
fel de setãri ne oferã Argentum MyFiles v.

2.30. Din meniul de configurare care se
lanseazã destul de neobiºnuit, din
View>Options poþi sã setezi: Interfaþa: aici
poþi seta tipul de font, mãrimea acestuia
care o sã se afiºeze în meniurile programu-
lui.

Scanarea: sã scaneze arhivele, sã adauge
o etichetã unicã de verificare a fiecãrui
fiºier, sã extragã descrierea fiºierelor audio.

Publicarea bazei de date se poate face în
format: HTML, XML ºi CVS. Proprietãþi:
poþi seta ce fel de informaþii sã se afiºeze
sau nu despre fiºiere/directoare, de exem-
plu: data, momentul creãrii, mãrimea etc.
Adãugarea unui nou volum se poate face
din meniu, de la Files>Scan. Tot din acest
meniu poþi re-scana un anume volum. 

Adãugarea unui nou volum se poate
face în interiorul bazei cu numele "X" sau în
exteriorul acesteia, însã acestea vor fi
cuprinse tot în fiºierul de tip bazã de date,
creat iniþial. Diferenþa va fi modul de
afiºare. În imaginea de jos poþi sã observi
douã volume care sunt identice, numai cã
unul este în interiorul rãdãcinii ºi celãlalt în
exteriorul rãdãcinii, bineînþeles ambele dis-
curi aparþinând unei singure baze de date.

III. Cãutarea unui fiºier
anume sau director în baza
de date

Motorul de cãutare poate cãuta dupã
urmãtoarele criterii: proprietãþi textuale,
toate proprietãþile, timp, nume, eticheta de
verificare (check), mãrime, comentariu,
descriere, notã, categorie, cuvânt cheie,
ratã, gen, data, etc. De asemenea, cãutarea
se poate restricþiona, numai la directoare.

Motorul se poate deschide din meniul
Tree>Search sau cu ajutorul combinaþiilor
de taste Ctrl + F.

IIVV..  SSeeccuurriizzaarreeaa  bbaazzeeii  ddee  ddaattee

Argentum MyFiles nu include nici o
posibilitate de securizare a bazelor de date,
în consecinþã baza ta de date este vulnera-
bilã. Singura protecþie pe care o poþi aplica
este sã o arhivezi cu parolã ºi sã o
depozitezi pe un disc optic care nu poate fi
accesat de cãtre oricine.

AArrggeennttuumm  MMyyFFiilleess  vv..  22..3300

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 35 EURO

Contact: www.argentuma.com

MMeenniiuull  ddee  ccoonnffiigguurraarree

NNOOTTÃÃ: programul nu are opþiune de

salvare a bazei de date, el salvând

automat ºi permanent orice operaþie

efectuatã.



BAZE DE DATEBAZE DE DATE|SOFTWARE| My HANDS

www.myc.ro noiembrie  2004|53

CD Storage Master are o interfaþã
pãtrãþoasã. Cu toate cã nu este la fel de plã-
cut ca restul programelor prezentate pânã
acum, CD Storage Master în versiunea
standard este de la bun început împãrþit pe
cinci categorii care îþi simplificã
cãutarea/adãugarea în baza ta de date, cât
ºi organizarea ei.

I. Crearea bazei de date

Crearea bazei de date în CD Storage
Master se face din meniu, de la
Storages>New Storage. Redenumirea cata-
logului o poþi face în Explorer ca la oricare
alt fiºier de pe hard disc.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou ca,
de obicei, sã vedem ce fel de setãri ne oferã
CD Storage Master. Configurarea se face
din Tools>Options. Din meniul de configu-
rare, sub-meniul General (setãri generale)
poþi sã setezi: sã se lanseze (sau nu)
automat programul la pornirea sistemului
de operare, fereastra programului sã fie
minimizatã automat la pornire, sunet de
notificare (fiºierul wav de notificare poate fi
personalizat), setarea numãrului de
favorite care sã se afiºeze în meniu. În
Internet Connection poþi sã setezi: sã fie

folosit setãrile browserului Internet
Explorer, sã fie utilizate sau nu un server
Proxy, acest sub-meniu afecteazã doar
funcþia CDDB! În Compressed files: poþi
seta extensiile de fiºiere arhivate din care sã
extragã (sau nu) descrierea lor, poþi seta
extensiile de fiºiere arhive auto-extractabile
din care sã extragã (sau nu) descrierea lor.
În Files supported poþi seta: sã afiºeze
informaþii sumare despre fiºierele selectate
de utilizator. Colors settings: poþi seta:
culoarea discurilor online, culoarea dis-
curilor deschise, culoarea background-ului

listei, culoarea informaþiilor sumare,
culoarea informaþiilor generale.

Adãugarea unui nou volum se face din
meniu de la Discs>Open Driver Discs

(Ctrl+O), dupã care se selecteazã driverul
care urmeazã sã fie adãugat ºi se apasã
butonul LOAD. Dupã aceastã execuþie se
selecteazã categoria în care sã fie adãugat
discul ºi se începe procedura de adãugare
cu butonul Save into storage.

III. Cãutarea unui fiºier 
sau director în baza 
de date

Motorul de cãutare este compus din
douã module de cãutare: Search>Search

discs, (motorul poate fi pornit ºi cu tasta
F7) cautã numai titluri (în special discuri),
criteriul de cãutare simplificându-se dupã
tipul discului (audio, date, video etc.), dupã
care categoria (spre exemplu: dacã discul
este de date putem cãuta dupã categoriile:
documente, programe, jocuri etc.).
Search>Search files and folders (motorul
poate fi pornit ºi cu tasta F3), acesta cautã
dupã numele directoarelor ºi fiºierelor
(opþional în funcþie de tipul discului ºi de
categoria acestuia). De asemenea, poate
cãuta ºi numai dupã documente create  în

Microsoft Office, MP3-uri, programe exe-
cutabile, în funcþie de versiunea fiºierului,
fiºiere video, fiºiere audio de tot felul,
imagini, filme create în flash, fiºiere MIDI,
fiºiere arhivate, fiºiere auto-extractabile,
fiºiere PDF, fiºiere IFO, fiºiere RM, fiºiere
HTML ºi piste audio. Lista nu se terminã
aici, se mai poate cãuta în funcþie de:
numele fiºierului (unde se poate selecta sã
afiºeze ºi numele directoarelor cu acelaºi
nume al fiºierului), mãrimea fiºierului

(unde mãrimea fiºierului poate fi mai micã
sau mai mare în funcþie de valoarea nume-
ricã setatã de utilizator sau sã fie inclusã în
intervalul a douã mãrimi), data creãrii

fiºierului (unde data la care a fost creat
fiºierului este dupã sau înainte de data
specificatã de utilizator, sau este cuprinsã
într-un interval de timp, de la data X la data
Y), data modificãrii fiºierului (similar ca la
data creãrii fiºierului). 

IV. Securizarea bazei de
date

CD Storage Master nu include nici o
posibilitate de securizare a bazelor de date,
în consecinþã baza ta de date este vulnera-
bilã.  Singura protecþie pe care o poþi aplica
este sã o arhivezi cu parolã ºi sã o
depozitezi pe un disc optic care nu poate fi
accesat de cãtre oricine.

CCDD  SSttoorraaggee  MMaasstteerr  vv..  33..0033

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 29,95 USD

Contact: www.cdstorager.com

AAtteennþþiiee!! Pentru a putea cãuta în baza

de date trebuie sã selectaþi unul din

modurile de cãutare descrise mai sus!
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Disk Explorer Professional este un pro-
gram simplu la prima vedere, însã dupã ce
începi sã te obiºnuieºti cu el, îþi dai seama
cã oferã multe posibilitãþi de organizare a
bazelor de date ºi un sistem minim de secu-
ritate cu o parolã de acces a bazei de date.

I. Crearea bazei de date

Crearea bazei de date se face din
File>New (sau Ctrl+N), iar în primul dialog
poþi sã specifici numãrul maxim de volume
(32000, cred sunt suficiente pentru oricine)
pe care sã-l permitã baza de date ºi parola
de acces cãtre aceasta, în al doilea dialog
specifici numele bazei de date, care va avea
extensia .ded.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou, vom
studia ca de obicei, ce setãri ne oferã Disk
Explorer Professional. Configurarea se face
din Options. Aici gãseºti patru sub-meni-
uri: Filtres, Profiles, Options, ºi Fast Filter
Configuration. Filtres (se poate executa ºi
cu tasta F6): permite sã citeascã sau nu
descrierea extensiilor uzuale (DOC, WMA,
MP3, AVI etc.) ºi în plus la unele formate de
fiºiere poate sã afiºeze o imagine reprezen-
tativã (Thumbnail) a lui (fie el document/
program/imagine/etc.), iar prin intermediul
acestui filtru poþi seta mãrimea (în pixeli)
de afiºare a imaginii (Thumbnail). 

Profiles (se poate accesa ºi cu tasta F7):

aici se poate configura care fiºiere sã fie
adãugate în baza de date ºi care nu, spre
exemplu: poþi sã permiþi ca în baza ta de
date sã fie adãugate numai fiºiere text, sau
numai directoare etc. Options (se poate
apela ºi cu tasta F11): În sub-meniul
Display poþi seta sã se afiºeze fiºierele
dupã: nume, mãrime, tip, datã; sã fie sor-
tate în ordine ascendentã sau descendentã;
sã afiºeze da/nu: fiºierele, directoarele,
arhivele, descrierile (Thumbnail); sã se
afiºeze numele fiºierelor ºi a directoarelor:
exact cum sunt stocate de cãtre sursã, cu
litere mici, cu majuscule, mixat, fiºierele cu

litere mici ºi directoarele cu majuscule,
OPÞIONAL: sã afiºeze iconurile de sistem
ºi tipul fiºierelor în ordine descrescãtoare,
sã afiºeze mãrimea doar în octeþi, sã nu
afiºeze fiºierele votate cu 5 puncte;
vizualizarea tipului de fiºier/director sã fie
fãcutã cu: iconuri mari/mici, listã sau
detalii. Sub-meniul Volume Analysis: este
exclusiv pentru CD-urile audio care se
adaugã în baza de date, astfel în acesta se
poate seta sã descarce direct de pe Internet
lista pieselor înregistrate pe CD-ul audio
(CDDB). Sub-meniul Miscellaneous: este
unul general în care poþi seta limba în care
sã se afiºeze meniurile, sã deschidã bazele
de date folosite în sesiunea anterioarã etc.    

Adãugarea unui nou volum se face
din meniu, de la Tools>Add Volume

(sau tasta Insert), sau prin simpla
apãsare a iconului din a doua barã a pro-
gramului. Dupã care se deschide fereastra
de adãugare, în care poþi selecta ce anume
sã înregistrezi în baza de date, adicã un
CD,DVD, hard disc, director, sau un server
FTP. Însã, înainte de a începe procedura de
înregistrare a noului volum poþi seta anu-
mite condiþii. Spre exemplu: sã nu scaneze
anumite extensii de fiºiere arhivate, sã
foloseascã anumite filtre de scanare, sã
ejecteze sau nu discul optic dupã scanare
etc.

III. Cãutarea unui fiºier
anume sau director în baza
de date

Motorul de cãutare este complex, pen-
tru cã include ºi un mod de cãutare string,
pe lângã clasicele moduri. De asemenea,
poate cãuta dupã: atributele fiºierelor, data,
mãrimea, ora, votul acordat fiºierelor sau
directoarelor. Poate cãuta numai în vo-
lumele selectate, sau fiºierele/directoarele
care nu corespund setãrilor efectuate în
motorul de cãutare. De asemenea, poate
cãuta în comentariile ºi în conþinutul
fiºierelor.

IV. Securizarea bazei de
date

Disk Explorer Professional vã permite
sã vã protejaþi baza de date cu ajutorul unei
parole de 21 de caractere care cred cã este
suficientã sã dea bãtãii de cap unui hacker!

DDiisskk  EExxpplloorreerr  PPrrooffeessssiioonnaall  vv..  33..6600..0000

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 29 USD

Contact: www.diskexplorerpro.com
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DriveScan Plus nu este un program
complex, însã scaneazã destul de repede
orice mediu. DriveScan a înlocuit comanda
de salvare ºi deschidere cu importarea ºi
exportarea bazelor de date de la alþi utiliza-
tori sau cãtre alþi utilizatori. Practic, prin
aceasta, el îngreuneazã procesul de copiere
al bazelor de date ºi de salvare. De fiecare
datã când adaugi un nou volum, este bine
sã-þi faci back-up cu ajutorul comenzii de
exportare, doar de siguranþã! 

I. Crearea bazei de date

Practic DriveScan îþi creeazã o singurã
bazã de date în care poþi salva volumele
ordonat pe categorii: fiecare CD audio, cu
filme, cu MP3-uri, etc. Ideea e cã nu poþi
avea o bazã de date total independentã
cum permit alte programe de catalogare.
Poþi doar sã îþi creezi categoriile din meniul
Category>Add. Dupã acest pas poþi sã
începi sã iþi adaugi CD-urile/DVD-
urile/partiþiile hard discului în categoria
corespunzãtoare. Pentru a salva baza de
date separat de salvarea permanentã pe
care o face DriveScan poþi exporta baza de
date sub forma unui fiºier.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou ca de
obicei sã vedem ce fel de setãri ne oferã
DriveScan Plus. Configurarea se face din
meniu de la View. Aici, întâlnim în prima
fazã opþiunea de afiºare (view) care ne per-
mite sã setãm cum vor fi afiºate
fiºierele/directoarele: cu simboluri mari,
mici, sub formã de listã sau detaliat. În
urmãtorul sub-meniu (Sort), poþi seta
ordinea în care sã fie sortatã baza de date:
dupã numele fiºierului, dupã mãrime,
dupã datã, dupã extensie, ºi dupã nota
explicativã. Sub-meniul files and folders pro-

perties (se poate activa ºi cu combinaþia de
taste Ctrl + E) are rolul de a afiºa propri-
etãþile directoarelor sau fiºierelor pe care te
poziþionezi cu cursorul. 

În Preferences - General: poþi seta în
care director sã fie creatã baza de date, în
interfaþa programului sã se afiºeze (sau nu)
interfaþa cu rândurile ei complete ºi liniile
de ghidare. - Double-click: poþi seta sã
afiºeze sau nu conþinutul unui fiºier zip
fãrã al deschide într-un program dedicat.
Dupã dublu clic, conþinutul fiºierului zip
poate fi temporar exportat imediat în direc-
torul temp al programului DriveScan unde:
se poate despacheta conþinutul acestuia, sã
afiºeze un dialog de interogare în cazul
suprascrierii fiºierelor existente, sã ºteargã
fiºierele din directorul temp (temporar)
dupã ieºirea din program. - Other:
prezentarea notei explicative: sã afiºeze

numãrul volumului, sã afiºeze descrierea
volumului, sã nu afiºeze nimic; altele: sã
porneascã DriveScan odatã cu pornirea sis-
temului de operare, sã-l minimizeze în tray
la pãrãsirea programului.

Scan Options: poþi seta în ce mod sã
scaneze extensiile ZIP, MP3 ºi dacã sã
descarce de pe Internet numele pieselor
audio de pe CD-uri.    

Adãugarea unui nou volum se face din
meniul Medium>Scan, iar la apariþia primei
ferestre de dialog poþi selecta partiþia sau
CD/DVD-ul care vrei sa fie adãugat, dupã
care în urmãtoarea fereastrã poþi seta în
care categorie sã se adauge volumul care va
fi scanat, din nou aici poþi seta opþiunile de
scanare, ºi în ultima fereastrã poþi adãuga
notiþe/comentarii respectivului volum,
dupã care începe scanarea propriuzisã.

III. Cãutarea unui fiºier 
sau director în baza 
de date

Cãutarea se poate face din meniu de la
Medium>Search sau F3 sau printr-un sim-
plu clic pe iconul în formã de lupã din a
doua barã. 

Motorul de cãutare al lui DriveScan este
simplu, astfel putând cãuta dupã: numele
fiºierelor, directoarelor, iar modul extins
mai poate cãuta dupã: nota explicativã,
numele volumelor, descrierea volumelor,
sau poate cãuta în fiºierele zip. 

De asemenea, mai poate cãuta un anu-
mit fiºier cu o anumitã mãrime specificatã
de utilizator.

IV. Securizarea bazei de
date

DriveScan Plus nu include nici o posi-
bilitate de securizare a bazelor de date, în
consecinþã baza ta de date este vulnerabilã.
Singura protecþie pe care o poþi aplica este
sã o arhivezi cu parolã ºi sã o depozitezi pe
un disc optic care nu poate fi accesat de
cãtre oricine.

DDrriivveeSSccaann  PPlluuss  vv..  33..3333

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 9,90 USD

Contact: www.diginvent.com/drivescan
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Cu un design revoluþionar Haxial Disk
Catalog îþi conferã o plãcere nemaiîntâlnitã
în momentul utilizãrii! Pe lângã faptul cã
adaugã extrem de repede un volum în ca-
talog, Hexial Disk Catalog cautã ceea ce
doreºti, imediat. Este uºor de utilizat ºi
oricând doreºti poþi sã îi schimbi interfaþa
cu una pe gustul tãu.

I. Crearea bazei de date

Practic nu poþi crea o bazã de date, însã
fiecare volum adãugat este stocat într-un

fiºier separat pe care îl poþi exporta ca ºi
text dacã doreºti sã-l vizualizeze altcineva
care nu dispune de acest program. Fiºierul
în care stocheazã date despre volumul
adãugat se poate salva ºi într-un alt direc-
tor, pentru a fi sigur cã baza ta de date nu
va fi ºtearsã de cineva! 

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de adãugrea unui volum nou, ca

de obicei, sã vedem ce fel de setãri ne oferã
Haxial Disk Catalog. Setãrile se gãsesc în
meniu la settings (vezi imaginea 1 din
partea de jos a imaginii). 

Aici nu o sã gãseºti mare lucru, practic îi
lipsesc multe lui Haxial Disk Catalog, însã
cu toate acestea nu le vei simþi lipsa! Deci în
meniul settings poþi seta: fontul cu care sã
fie afiºat numele volumelor ºi poþi selecta
aspectul interfeþei dintr-o listã de 16 skin-
uri. Redenumirea unui volum se face prin
apãsarea butonului în dreapta al mouse-
ului ºi selectarea "Rename Item". (Vezi
imaginea 2). De asemenea, ºtergerea unui
volum se face tot din acest sub-meniu
("Delete Item").

Adãugarea unui nou volum se face din
meniu de la Add. Existã ºi o a doua posibi-
litate de a adãuga volume, fiind special cre-
atã pentru CD sau DVD-uri. Ea se numeºte
Batch Add ºi adaugã automat un nou volum
când detecteazã în unitatea opticã un nou
CD sau DVD.

III. Cãutarea unui fiºier 
sau director în baza 
de date

Motorul de cãutare gãseºte instantaneu
ceea ce cautã ºi îl poþi porni din meniu, de
la Find. De asemenea, poþi cãuta ºi într-un
singur volum prin apãsarea butonului
drept de la mouse, pe volumul dorit din
interfaþa programului. Motorul poate cãuta
dupã mãrimea fiºierului, data la care a fost
creat sau modificat, sau dacã acesta conþine
o frazã specificatã de utilizator. 

IV. Securizarea bazei de
date

Haxial Disk Catalog nu include nici o
posibilitate de securizare a bazelor de date,
în consecinþã baza ta de date este vulnera-
bilã. Singura protecþie pe care o poþi aplica
este sã o arhivezi cu parolã ºi sã o
depozitezi pe un disc optic care nu poate fi
accesat de cãtre oricine.

HHaaxxiiaall  DDiisskk  CCaattaalloogg  vv11..33

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 20 USD

Contact: www.haxial.com
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Super Cat are o interfaþã compactã în
care gãseºti imediat tot ce îþi trebuie.
Interfaþa nu este plãcutã, însã este suficient
de utilã încât sã îþi creezi o bazã de date ºi
sã o gestionezi dupã bunul plac. 

I. Crearea bazei de date

În Super Cat nu poþi crea o bazã de date
într-un fiºier anume unde sã adaugi anu-
mite volume sau sã personalizezi respecti-
va bazã de date! Cei care au conceput acest
program au considerat ca volumele sã se
numeascã catalog, aºa cã nu trebuie sã con-
fundaþi “catalog” cu “volum”. Practic, când
adaugi un nou volum, Super Cat îl salveazã
automat pe acesta sub forma unui fiºier cu
extensia idx., pe care îl poþi copia la prie-
teni, pentru ca aceºtia sã poatã avea acces la
baza ta de date.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou, sã
vedem ce fel de setãri ne oferã Super Cat.
Configurãrile sau diversele setãri se pot
face din meniu de la File>Options sau direct
cu ajutorul tastei F8. În tabul General poþi
seta sã: adauge Super Cat-ul în meniul
pop-up al Explorer-ului, la minimizare sã

fie afiºat în Tray, sã salveze poziþia ferestrei,
sã foloseascã un utilitar intern de despa-
chetare al fiºierelor zip, sã confirme ºter-
gerea fiºierelor, sã afiºeze conþinutul
fiºierelor de tip arhivã, sã renunþe cãutarea
dupã ce a gãsit x fiºiere cu numele cãutat
(unde x are valoare de la 10 la 9999), afiºeze
ultimele x cãutãri efectuate în motorul de
cãutare (unde x are valoare de la 1 la 30). 

În tabul Display poþi seta sã afiºeze
mãrimea fiºierelor în KB, sã afiºeze icoanele
implicite, sã schimbi fontul ºi mãrimea
acestuia, sã schimbi culoarea de afiºare a
fiºierelor comprimate etc. 

În tabul Autocomments and

Checksums poþi seta sã fie inserate comen-
tarii automat fiºierelor cu extensia: zip, tif,
jpg, psd, mpg, exe, dll etc. În meniul view
din prima barã, poþi seta sã afiºeze: linii de
ghid, toolbar-ul, icoane etc.  

Adãugarea unui nou volum se face din
tabul Create catalog, de unde în naviga-
torul programului poþi selecta unitatea
opticã sau partiþia ce urmeazã sã fie adãu-
gatã. Înainte de a începe adãugarea noului
volum poþi exclude adãugarea anumitor
fiºiere cu extensii (zip, exe, jpg, tif etc.), sã
incluzi sau nu sub-directoarele etc. Pentru a
începe adãugarea trebuie apãsat butonul
Catalog.

III. Cãutarea unui fiºier 
sau director în baza 
de date

Motorul de cãutare se gãseºte în tabul
Search. El poate cãuta dupã: tipul discului
(CD-ROM, partiþie etc.), descrierea fiºieru-
lui, locaþie, etc. De asemenea, poate cãuta ºi
numai într-un anumit volum, poate sorta
lista în ordine alfabeticã sau, dupã caz, poþi
sã alegi sau nu sã afiºeze numai direc-
toarele gãsite. Pe lângã cãutarea tradiþio-
nalã în baza de date, Super Cat mai poate
cãuta pe partiþiile locale ºi fiºierele-dupli-
cate.

IV. Securizarea bazei de
date

Super Cat nu include nici o posibilitate
de securizare a bazelor de date, în con-
secinþã baza ta de date este vulnerabilã.
Singura protecþie pe care o poþi aplica este
sã o arhivezi cu parolã ºi sã o depozitezi pe
un disc optic care nu poate fi accesat de
cãtre oricine.

SSuuppeerr  CCaatt  44..44
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WhereIsIt este dupã pãrerea mea cel
mai uzual program din aceastã categorie
(care se foloseºte pentru crearea ºi ges-
tionarea bazelor de date). Eu îl folosesc din
1998 dacã îmi aduc bine aminte, chiar
dinainte?!? Programul este bine structurat,
are un aspect obiºnuit la prima vedere, însã
este ideal pentru a-þi crea o bazã de date ºi
a o gestiona ca la carte.

I. Crearea bazei de date

Crearea bazei de date se face din meniul
principal de la File>New Catalog (sau Ctrl +
N). WhereIsIt nu are limitã de creare de ca-
taloage (baze de date). Poþi sã creezi câte
doreºti, pentru cã fiecare bazã de date este
de fapt un fiºier cu extensia ctf creat de
WhereIsIt. De asemenea, poþi crea baze de
date ºablon sau o bazã de date personaliza-
tã.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Iatã ce setãri ne oferã WhereIsIt: în
prima linie se gãseºte meniul Options care
se împarte în alte cinci sub-meniuri:
General Settings, User Interface Setup,

File List Settings, Disk Image Settings ºi
Description Settings, iar pentru cei care nu
doresc sã se complice prea mult cu setãrile
existã ºi o opþiune Wizard rapidã, care se
efectueazã în zece paºi. În General Settings

(General) poþi seta sã afiºeze sau nu logo-ul
WhereIsIt la pornirea programului, sfaturi
la pornirea WhereIsIt-ului, ultimele baze
de date deschise (poate afiºa minim 4 sau
maxim 16 catalog-uri), sau sã minimizeze
programul în tray când nu este utilizat etc.
În General Settings  (Catalogs) poþi seta sã
fie deschise automat ultimele baze de date

utilizate sau bazele de date specificate de
utilizator sau sã nu se deschidã nici o bazã
de date, sã se creeze back-up într-un direc-
tor specificat de utilizator, sã se salveze
automat baza de date la x minute (unde x
poate lua o valoare de la 2 la 240). În
General Settings  (External programs) poþi
seta sã foloseascã Notepad-ul pentru
vizualizarea fiºierelor text, sau programul
integrat în WhereIsIt pentru vizualizare, sã
foloseascã un alt program în locul
Explorerului din Windows, sã foloseascã
pentru scanarea fiºierelor un antivirus
specificat de cãtre utilizator. În General

Settings  (Temporary files) poþi seta direc-
torul în care sã se stocheze fiºierele tempo-
rare, care opþional pot fi ºterse la ieºirea din
program sau poþi fi interogat de program
dacã sã ºteargã sau nu. În User Interface

Setup poþi seta: limba în care sã se afiºeze
meniul, viteza de afiºare a descrierii ºi tim-
pul de afiºare a acesteia, de la 0 pânã la 15
secunde , sã afiºeze bara de stare, poþi mo-
difica bara cu intrumente, tipul fontului cu
care sã se afiºeze în fereastra programului,
poþi schimba culorile de afiºare a dispozi-
tivelor etc. În File List Settings (File Lists)

poþi seta cum sã fie afiºate fiºierele, direc-
toarele, cum sã fie sortate acestea, sã
ascundã anumite extensii, sã permitã direc-
toarelor extensie etc. În File List Settings

(Double-clicking) poþi seta: rolul dublului
clic, rolul clicului  ºi ce fel de comenzi sã  fie
executate în momentul în care apeºi con-
comitent tasta Alt + dublu clic, (de exem-
plu: poate lansa în execuþie un fiºier, poate
vizualiza respectivul fiºier, poate localiza
respectivul fiºier/director în baza de date
etc.). În Disk Image Settings poþi seta: sã
re-afiºeze dialogul de adãugare a unui nou
volum dupã înregistrarea unuia în baza de
date, sã ejecteze discul optic dupã ce a fost
adãugat ca volum în baza de date, sã ignore

adãugarea fiºierelor sau directoarelor speci-
ficare de utilizator, sã includã sau nu
conþinutul fiºierelor arhivate cu extensia x
(unde x include toate extensiile de tip
arhivã specificate de utilizator) etc. În
Description Settings poþi seta: pentru care
extensii de fiºiere sã citeascã sau nu
descrierea acestora etc.
Adãugarea ºi updatarea unui (nou) volum
se face din meniu de la Edit>Add/Update

Disk Image (sau Ctrl + D) sau de la
iconul specific din a doua bara a meni-

ului. În dialogul de adãugare mai poþi seta:
sã scaneze conþinutul fiºierelor arhivate, sã
salveze noul conþinut al catalogului dupã
scanarea volumului, sã ejecteze discul optic
scanat etc.   

III. Cãutarea unui fiºier
sau director în baza 
de date

Motorul de cãutare se gãseºte în meniul
Search>Search for Item sau Ctrl + F sau F3
sau prin simpla apãsare a icoanei în formã
de lupã din a doua barã a programului.
Motorul poate cãuta dupã: atributele
fiºierului, descrierea fiºierului, mãrimea
fiºierului, data fiºierului, categoria în care
este inclus etc. 

De asemenea, tot în acest meniu poþi
cãuta, fiºiere sau directoare duble (aseme-
nea), sau poþi compara douã cataloage între
ele.                

IV. Securizarea bazei de
date

Securizarea bazei de date se poate face
din meniu de la Actions>Proprieties. Aici
existã o icoanã de forma unui lacãt care se
aflã în partea de sus dreapta a ferestrei.
Limitarea accesului la baza de date poate fi
de douã feluri: doar pentru citire, ºi fãrã
nici un acces. Aceastã restricþionare se face
foarte simplu prin introducerea unei parole
care va fi ceruta de fiecare datã când se
deschide baza de date.

WWhheerreeIIssIITT  ??  33..6622  

IINNFFOORRMMAAÞÞIIII  GGEENNEERRAALLEE

Preþ: 39,95 USD

Contact: www.whereisit-soft.com



BAZE DE DATEBAZE DE DATE|SOFTWARE| My HANDS

www.myc.ro noiembrie  2004|59

Wincatalog copiazã fidel Explorer-ul ºi
motorul de cãutare din Windows. Seamãnã
aºa de bine încât le poþi confunda, dacã nu
eºti atent! Programul este uºor de utilizat ºi
este suficient pentru administrarea unei
baze de date.

I. Crearea bazei de date

Crearea bazei de date se face din meniul
principal de la File>New (sau Ctrl + N).
Fiecare catalog se poate salva ca ºi fiºier cu
extensia .wca. Fiecare bazã de date creatã
cuprinde trei categorii: My Collection, My
Contacts ºi My Keywords. Fiecare categorie
se poate personaliza dupã bunul plac. De
asemenea, redenumirea categoriei se poate
face cu ajutorul tastei F2 sau cu butonul 2 al
mouse-ului ºi clic pe Rename.

II. Adãugarea unui volum
nou în baza de date +
setãrile programului

Înainte de a adãuga un volum nou, te

invitam sã studiem setãrile pe care ni le
oferã WhereIsIt. Setãrile principale se gã-
sesc la Tools>Options, sau iconul în formã
de rotiþã zimþatã de pe bara a doua a fere-
strei principale. Aici sub-meniurile se gã-
sesc sub formã de tab-uri. Primul tab este
General în care poþi seta ca iconurile afiºate
sã aibã dimensiune mare, sã afiºeze liniile
de ghidaj, sã afiºeze locaþia fiºierului/direc-
torului în linia de stare, iar funcþia dublu
clic sã aibã rol de: afiºare a proprietãþilor
respectivului director/fiºier, sã deschidã
fiºierul cu programul asociat lui sau sã-l
deschidã în Explorer. În tabul Scanning

poþi seta: sã extragã descrierile fiºierelor
mp3, html etc., sã scaneze numai direc-
toarele, sã scaneze conþinutul fiºierelor
arhivate ZIP ºi RAR, sã salveze automat
dupã scanare volumul adãugat, sã ejecteze
discul optic dupã scanare, sã te atenþioneze
sonor când a terminat de scanat, etc. În
tabul Audio CD poþi seta: serverul CDDB,
de pe care sã copieze descrierile pieselor de
pe CD-ul audio. În tabul Additional poþi
seta: sã deschidã automat ultimul catalog

utilizat ºi sã compreseze fiºierul bazei de
date.   

Adãugarea unui nou volum se face din
meniul Edit>Add volume (sau cu tasta F11).
Pe lângã clasica adãugare a unui volum,
mai poþi adãuga separat în baza de date: un
director, un director virtual, un fiºier etc.
Pentru a actualiza un volum mai vechi tre-
buie sã selectezi volumul dorit ºi sã accesezi
din meniul Edit>Update. În dialogul de
adãugare mai poþi seta aceleaºi opþiuni care
se gãsesc în Tools>Options tabul Scanning.

III. Cãutarea unui fiºier 
sau director în baza 
de date

Motorul de cãutare se gãseºte în meniul
Tools>Search sau tasta F3 sau prin simpla
apãsare a iconului în formã de lupã din a
doua barã a programului. Cãutarea se
poate face dupã: mãrimea fiºierului, data
fiºierului, dupã comentariul fiºierului.
Motorul mai poate cãuta fiºiere sau direc-
toare duble, ºi de asemenea poate cãuta în
toatã baza de date sau numai într-un
volum specificat de utilizator.

IV. Securizarea bazei de
date

Wincatalog Standard nu include nici o
posibilitate de securizare a bazelor de date,
în consecinþã baza ta de date este vulnera-
bilã. Singura protecþie pe care o poþi aplica
este sã o arhivezi cu parolã ºi sã o
depozitezi pe un disc optic care nu poate fi
accesat de cãtre oricine. �
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re ºi rãspunsuri, aºtept sã-mi scrieþi
pe adresa de e-mail de mai sus.   
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M
ultã lume a auzit de servere
proxy, dar sunt puþini care înþe-
leg ce sunt acestea ºi care este

utilitatea lor într-o reþea. Existã mii de pro-
grãmele de tot felul care suplinesc câteva
din caracteristicile unui proxy profesional,
oferind în schimb interfeþe arãtoase ºi
diferite servicii, de multe ori nefolositoare.
Culmea este cã multe din aceste programe
costã bani ºi serviciile pe care le oferã sunt
de o calitate îndoielnicã. Eu aº vrea sã vor-
bim despre un proxy server care nu intrã în
aceastã categorie, un program profesional
care îndeplineºte exact sarcina pentru care
a fost creat. 

Squid, pe numele sãu complet (Squid
HTTP Caching Proxy Daemon), e un cache
proxy server foarte utilizat la scarã mondi-
alã, în special pe platformele UNIX, Linux
sau Free BSD. Serverul funcþioneazã ca un
proxy cache, iniþiind un proces care
primeºte cereri de la clienþi, în acest caz
browsere, ºi le trimite spre serverul specifi-
cat. Când obiectele cerute ajung la desti-
naþie, sunt pãstrate ca ºi copii într-un cache
virtual pe disc, sub forma unor fiºiere log.
Când un client apeleazã un sit deja vizitat,
obiectele obþinute vor fi acelea stocate de
Squid în memorie, ceea ce mãreºte foarte
mult viteza de accesare a unor situri
folosite des. În cazul unei reþele mai mari
de calculatoare, toþi utilizatorii vor benefi-
cia de multe avantaje, economisind astfel,
transfer, lãþime de bandã ºi timp. De exem-

plu, dacã avem o reþea de 100 de calcula-
toare care sunt conectate la Internet ºi be-
neficiazã de serviciile Squid, iar un singur
utilizator acceseazã domeniul www.

google.com, imaginile ºi informaþiile
obþinute vor fi stocate în cache, astfel încât,
în momentul când ceilalþi utilizatori conec-
taþi la aceeaºi reþea vor accesa acel sit, nu
vor mai aºtepta datele de pe serverul
Google, ci vor accesa în realitate calcula-
torul din camera alãturatã.

Squid nu este un server proxy tradiþio-
nal. El intermediazã doar între conexiuni

HTTP. Suportã deasemenea alte protocoale,
cum ar fi FTP, Gopher, SSL ºi WAIS, dar nu
oferã suport pentru Real Audio, news, sau
videoconferinþe, lucru care e lesne de înþe-
les, din moment ce aceste tipuri de infor-
maþii se modificã foarte repede. Totuºi
Squid oferã suport pentru UDP, dar numai
pentru interconexiuni cu alte rezerve de

cache, astfel cã multe programe de multi-
media nu vor funcþiona on line dacã Squid
e instalat.  

Squid ºi securitatea

Squid poate fi folosit împreunã cu un
firewall pentru a opri accesul spre exterior
fãrã permisiunea serverului. Firewall-ul
respinge toate cererile clienþilor exceptând
acelea care au permisiunea Squid. Toate
conexiunile la internet se vor face astfel
prin proxy. Dacã în configurarea firewall-
ului este inclus un DMZ (Demilitarized
Zone), setaþi proxy-ul acolo. În acest caz,
este important ca toate computerele din
DMZ sã trimitã fiºierele log spre hosts în
interiorul reþelei securizate.

Cache Multiplu 

Unele proxy-uri pot fi configurate în aºa
fel încât sã poatã interschimba obiecte,
reducând astfel nevoia de resurse ºi mãrind
posibilitatea gãsirii unui obiect chiar în
cadrul reþelei interne. Squid poate crea ie-
rarhii de cache, ceea ce înseamnã cã poate
face legãturi cu alte servere pe care ruleazã,
poate transmite cereri pentru obiecte cãtre
acestea sau un server principal. Poate primi
obiecte din alte fiºiere cache, aflate în
reþeaua localã sau direct de la sursã.
Alegerea unei topologii adecvate pentru
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ierarhia cache este foarte importantã,

deoarece aceasta poate sã mãreascã sau sã

scadã traficul generat în reþea. De exemplu,

într-o reþea foarte vastã, este posibil sã con-

figurãm un server proxy pentru fiecare

sub-reþea ºi sã-l conectãm la un proxy prin-

cipal, legat la rândul sãu la proxy-ul furni-

zorului de servicii (ISP). Toatã aceastã legã-

turã e controlatã de ICP (Internet Cache

Protocol) care ruleazã deasupra protocolu-

lui UDP. Transferul de date între mai multe

fiºiere cache e manevrat de HTTP, la rândul

sãu bazat pe protocolul TCP.

Pentru a gãsi cea mai bunã sursã de

unde sã ia obiectele, un cache va trimite o

cerere ICP cãtre toate serverele învecinate.

Acestea vor rãspunde cu un cod special

numit HIT în cazul în care obiectul este

gãsit, sau MISS dacã obiectul lipseºte. Dacã

se primesc mai multe HIT-uri, serverul

proxy va decide de unde sã copieze, acest

lucru depinzând de mai mulþi factori, cum

ar fi viteza rãspunsului primit sau care

server este mai apropiat. Dacã nici unul din

serverele învecinate nu trimite un rãspuns

satisfãcãtor, Squid va contacta serverul

principal.

Caching în cazul obiectelor

Evident, nu toate obiectele de pe

Internet sunt statice. Existã o mulþime de

pagini web generate cu CGI, contoare pen-

tru numãrul de vizitatori ºi documente care

conþin encriptare SSL. Obiectele de acest

gen nu sunt reþinute în cache, deoarece se

vor modifica de fiecare datã când sunt acce-

sate. Se naºte astfel întrebarea referitoare la

cât de mult ar trebui sã rãmânã un obiect în

cache. Pentru a determina acest lucru

fiecãrui obiect i se alocã un anumit statut.

Squid determinã statutul fiecãrui obiect

prin adãugarea unei titulaturi cum ar fi

"Last modified" sau "Expires" ºi data co-

respunzãtoare. Alte titulaturi care specificã

faptul cã un obiect nu trebuie reþinut în

cache sunt de asemenea folosite. Obiectele

din cache sunt înlocuite în mod normal,

din cauza spaþiului limitat pe hard disk,

folosind algoritmi ca LRU (Last Recently

Used). Acesta consistã în înlocuirea

obiectelor care sunt accesate mai rar.

Cerinþe de sistem

Cel mai important lucru este stabilirea

plafonului maxim de solicitare a sistemului.

Dacã ai dubii în acest sens este mai bine sã

supraestimezi cerinþele, deoarece dacã

Squid lucreazã aproape de limitele maxime

pot apãrea pierderi în calitatea serviciilor.

Viteza joacã un rol important în procesul

de caching. La hard disk îi revine para-

metrul descris ca "random seek time",

mãsurat în milisecunde. Cu cât cãutarea

este mai scurtã, deci viteza hard discului

mai mare cu atât mai bine. O posibilitate

este sã ne folosim de mai multe discuri

dublate prin RAID.

Dimensiunea 
memoriei cache

Aceasta depinde de mai mulþi factori.

Cu cât valoarea este mai mare cu atât ai mai

multe posibilitãþi de a gãsi informaþia pe

care o cauþi memoratã în cache. 

Deoarece Squid citeºte ºi scrie în general

pãrþi mici de date de pe disc, timpul de

accesare este la fel de important ca ºi

mãrimea memoriei cache. Discurile cu

viteze mari, de exemplu cele cu 7200 sau

10000 de rotaþii pe minut sunt de preferat.

Cantitatea de RAM

Lucrurile sunt simple: deoarece Squid se

foloseºte în special de RAM pentru a pãstra

memoria cache, iar accesul memoriei RAM

se face mult mai rapid decât accesul datelor

de pe un disc, cantitatea de RAM trebuie sã

fie cât mai mare. Pentru un server care

deserveºte o companie sau o instituþie cu

mai multe computere valoarea minimã este

de 512 MB.

CPU

Squid nu este un program care are

nevoie de un procesor rapid, de aceea nu

existã limite inferioare pentru aceastã cate-

gorie de hardware. Pentru creºterea efi-

cienþei, cum am precizat ºi mai sus, ai

nevoie doar de niºte discuri rapide si multã

memorie RAM.

Instalare

Squid este încorporat în majoritatea dis-

tribuþiilor Linux, de aceea poate fi instalat,

dezinstalat, updatat cu uºurinþã. Dacã dis-

tribuþia ta nu conþine Squid sau vrei tu sã fii

ºeful sistemului tãu, iatã cum trebuie s-o

faci:

Trebuie sã downloadezi o arhivã de tipul

"squid-x.y.z-src.tar.gz" (ex. squid

-2.5.STABLE4.tar.gz) de la www.

squid-cache.org sau de pe situl FTP. 

Acestea sunt comenzile de instalare:

tar xzf squid-2.5.STA-

BLE4.tar.gz

cd squid-2.5.STABLE4

./configure

make

make install

Pentru a compila Squid vei avea nevoie

CCoonnffiigguurraarreeaa  uunnuuii  pprrooxxyy  îînn  bbrroowwsseerruull  NNeettssccaappee
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de un compilator ANSI C, integrat în toate
distribuþiile de Linux ºi alte sisteme de
operare bazate pe UNIX moderne. Pe lângã
acestea vei avea nevoie de Perl instalat pe
sistemul tãu.

Pentru a face un upgrade, ai nevoie de
un patch. De exemplu, dacã vrei sã faci un
upgrade de la squid-1.1.10 la squid-1.1.11,
scrie urmãtoarele comenzi:

cd squid-2.5.STABLE3

mkdir ../squid-

2.5.STABLE4

find . -depth -print

| cpio -pdv ../squid-1.1.11

cd ../squid-1.1.11

patch -p1 < /tmp/squid-

2.5.STABLE3-STABLE4.diff

sau urmãtoarele:
cp -rl squid-2.5.STABLE3

squid-2.5.STABLE4

cd squid-2.5.STABLE4

zcat /tmp/squid-

2.5.STABLE3-STABLE4.diff.gz |

patch -p1

Dupã ce ai aplicat patch-ul trebuie sã
refaci Squid ca în cazul unei instalãri:

make distclean

./configure ...

make

make install

Nu uita cã acesta e doar un exemplu ºi
înlocuieºte datele menþionate mai sus cu
cele aferente sistemului tãu!

Porneºte Squid

Dacã Internetul îþi merge, reþeaua þi-e
configuratã ºi Squid a fost instalat fãrã
erori, tot ce trebuie sã faci este sã deschizi o
consolã ºi sã tastezi "rcsquid start"
pentru a porni programul. Pentru a opri
Squid tasteazã "rcsquid stop". Cu
"rcsquid status" vezi dacã Squid
funcþioneazã corect.

Fiºierul de configurare
"squid.conf"

Squid.conf defineºte configuraþia

serverului. Acest fiºier conþine toate infor-
maþiile de care ai nevoie pentru a configu-
ra porturile HTTP, ICP, cererile ºi rãspun-
surile, informaþii despre accesul prin fire-
wall, fiºierele log ºi multe alte informaþii
utile. Dupã instalare vei gãsi acest fiºier în
/etc/squid/squid.conf. Squid.

conf este un fiºier de configurare, dar ºi
un manual pentru începãtori ºi nu numai,
fiecare opþiune fiind explicatã foarte amã-
nunþit. Pentru a porni Squid pentru prima
oarã nu este nevoie sã modifici acest fiºier,
dar în aceastã fazã toate cererile venind de
la clienþi externi vor fi respinse. Proxi-ul tre-
buie sã fie configurat în browsere, pentru
portul 3128 care este standard sau 8080, de
asemenea un port foarte des folosit. Pentru
informaþii suplimentare citeºte documen-
taþia de pe situl oficial Squid - www.squid-

cache.org.

Configurarea unui proxy
transparent

Modul normal în care se lucreazã cu un
proxy server este urmãtorul: browserul
trimite cereri spre un anumit port pre-con-
figurat, iar proxy-ul asigurã primirea
obiectelor cerute, indiferent dacã acestea se
aflã sau nu în cache. Cînd lucrezi într-o
reþea, pot apãrea diverse situaþii, de aceea
este necesar sã aplici unele reguli:

Din motive de securitate, e recomandat
ca toþi clienþii sã foloseascã un proxy pentru
a naviga Internetul.

Toþi clienþii sã foloseascã un proxy,
indiferent dacã ei sunt sau nu conºtienþi de
acest fapt.

Chiar dacã proxy-ul este mutat în reþea,
clienþii existenþi trebuie sã-ºi pãstreze con-
figuraþia iniþialã.

În toate aceste cazuri, se foloseºte un
proxy transparent. Principiul este foarte
simplu: proxy-ul intercepteazã ºi rãspunde
la cererile browserelor, în aºa fel încât aces-
tea primesc obiectele cerute fãrã sã ºtie de
unde provin acestea. Acest proces dã iluzia
de transpatenþã, de unde ºi numele.

Configurarea kernelului

Prima datã, trebuie sã te asiguri dacã ai
suport pentru un proxy transparent,
deoarece modulele kernelului se modificã
de la o versiune la alta. Pentru a afla aceastã
informaþie viziteazã (www.tldp.org/

HOWTO/mini/TransparentProxy-3.html)
sau, dacã foloseºti SuSE Linux, citeºte doc-
umentaþia aflatã în /usr/share/

doc/howto/en/html/mini/Transpar

entProxy-3.html

Opþiuni de configurare în
/etc/squid/squid.conf 

Opþiunile de activare a unui proxy
transparent în squid.conf sunt:

" httpd_accel_host virtual 

" httpd_accel_port 80 # portul

serverului HTTP 

" httpd_accel_with_proxy on 

" httpd_accel_uses_host_head-

er on 

Squid ºi alte programe

Squid poate interacþiona cu diverse pro-
grame pentru configurare ºi întreþinere. În
exemplele urmãtoare vom vedea trei dintre
ele: cachemgr.cgi, care te poate ajuta sã
decizi valoarea memoriei folositã pentru a
menþine obiecte in cache, squidGuard, care
filtreazã paginile web ºi Calamaris, un pro-
gram care creeazã rapoarte referitoare la
funcþionarea serverului.

cachemgr.cgi 

Cache managerul (cachemgr.cgi) e un
utilitar CGI folosit pentru a obþine statistici
despre memoria utilizatã de procesul
Squid. Oferã de asemenea o metodã con-
venabilã pentru managementul memoriei
cache ºi suport pentru vizualizarea statisti-
cilor fãrã conectarea la server.

squidGuard

SquidGuard e un filtru, redirector ºi
controller de acces pentru Squid. Îþi oferã
posibilitatea de a defini reguli pentru acces
multiplu cu restricþii diferite pentru
grupuri de utilizatori cu acces la un cache
Squid.

Generare de statistici
cache cu Calamaris

Calamaris e un script Perl folosit pentru
a genera rapoarte ºi statistici ale activitãþii
serverului în format ASCII sau HTML.
Lucreazã cu fiºierele log ale serverului
Squid. Pagina oficialã a lui Calmaris este
http://Calamaris.Cord.de/ �

DDaarriiuuss  MMaarrttiinn

contact@myc.ro
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U
nii dintre noi nu se opresc sã-ºi
supratacteze doar procesorul sis-
temului ºi memoria, ci vor ºi mai

multã performanþã! Astfel, însãºi sistemul
de operare Windows XP se mai poate 
tuning-a, supratacta, oricum i-am spune tot
despre o “forþare” ar fi vorba. Aici însã nu e
ca ºi cum þi-ai supratacta procesorul ºi ar
trebui sã îþi achiziþionezi un cooler mai bun,
ci trebuie sã ºtii care programe sunt create
special pentru a-þi îmbunãtãþi performanþa
sistemului. De aceea, în acest numãr am sã
prezint un program mai des utilizat pentru
îmbunãtãþirea funcþionãrii Windows-ului
XP fie el PRO sau HOME edition. În

numãrul viitor, am sã prezint WinBoost, un
program cu opþiuni pe gustul fiecãruia!

TuneXP 1.5

Este un program uºor de utilizat, fãrã
prea multe setãri, TuneXP acoperã toate
opþiunile principale care îþi fac Windows-ul
XP sã ruleze mai rapid ºi mai stabil. Atenþie!
Programul nu vã rezolvã problemele sis-
temului de operare cauzate de programe
fantomã sau ale unor setãri fãcute în
necunoºtinþã de cauzã! Dupã cum
spuneam, acesta ajutã sistemul de operare
sã funcþioneze mai ordonat ºi mai bine

decât pânã acum. Programul este gratuit, ºi
a fost inclus pe CD-ul nr.9/2004 al revistei
noastre, însã la cererea ta vom include o
eventualã versiune viitoare pe CD-urile
revistei. Programul TuneXP 1.5 a fost testat
la noi în redacþie pe diverse configuraþii ºi a
funcþionat fãrã nici o eroare încât nu a
cauzat nici un fel de probleme pe o
perioadã destul de îndelungatã. Totuºi, nu
ne putem asuma rãspunderea în cazul în
care prin instalarea acestuia vei fi pãgubit
în vreun fel! Interfaþa programului TuneXP
1.5 este simplã, aici vei gãsi un meniu în
care poþi seta sau nu respectivele opþiuni
de tuning care consideri cã îþi vor
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îmbunãtãþi performanþa sistemului de
operare ºi nu numai. 

În primul meniu “File” existã opþiunea
“Exit” care îþi permite sã pãrãseºti progra-
mul.

În al doilea meniu (“Memory and file
system”) existã mai multe opþiuni pe care le
voi descrie în ordinea în care apar: 

ACCELERATE DLL UNLOADING -
opþiunea garanteazã ºtergerea completã
din memoria RAM a fiºierelor DLL de
fiecare datã când este nevoie. Activarea
acestei opþiuni ar putea sã îmbunãtãþeascã
performanþa în teste, ar fi posibil sã
încetineascã aplicaþiile mici instalate în sis-
temul de operare. “Accelerate DLL unload-
ing” este recomandatã pentru teste (bench-
marking). 

CLEAR PAGEFILE ON SHUTDOWN -
opþiunea ºterge pagefile-ul din sistem în
momentul opririi calculatorului (shut-
down). Opþiunea va încetini procedura de
oprire a calculatorului, însã va accelera
ulterior viteza de bootare, iar  memoria vir-
tualã a sistemului va avea un acces mai mic.
Clear Pagefile On Shutdown nu este reco-
mandatã. 

DISABLE PAGING EXECUTIVE - opþi-
unea dezalocã fiºierele sistemului pe care
Windows-ul încearcã sã le încarce în swap.
Datoritã acestei opþiuni, ele vor fi încãrcate
în RAM. “Disable Paging Executive” uti-
lizeazã puþinã memorie, însã sistemul de
operare va fi mai rapid ºi mult mai sensibil
la comenzi. Aceastã opþiune necesitã 512
MB RAM sau chiar mai mult. 

FASTER SHUTDOWN - opþiunea
reduce viteza de oprire a calculatorului de
la 20 de secunde la 5, astfel sistemul de
operare se va opri de 4 ori mai repede.
Faster Shutdown este recomandatã pentru
orice sistem. 

FILE ALLOCATION SIZE TWEAK -
opþiunea altereazã mãrimea alocatã fiºieru-
lui de memorie. Efectul nu este drastic, însã
majoritatea persoanelor vor observa un
rãspuns ceva mai bun al Windows-ului la
comenzi. File Allocation Size Tweak este
recomandatã pentru orice sistem. 

OPTIMIZE PREFETCH - opþiunea opti-
mizeazã modul de încãrcare prealabilã a
cache-ului ºi astfel aplicaþiile se vor încãrca
mai repede, mai ales cele mari. Opþiunea
este recomandatã tuturor. 

INCREASE NTFS PERFORMANCE -
opþiunea dezalocã din toate fiºierele "Last
Access Stamp". Opþiunea îmbunãtãþeºte
viteza hard discului, însã este recomandatã
celor care folosesc sistemul de fiºiere NTFS. 

IO PAGE LOCK LIMIT - opþiunea
reduce mãrimea alocatã în memorie de
swap-ul IO. Cu cât dispui de mai multã
memorie cu atât poþi seta o limitã mai mare.
IO Page Lock Limit îmbunãtãþeºte perfor-
manþa generalã a sistemului, în special
când lucrezi cu aplicaþii mari; opþiunea este
recomandatã pentru orice tip de sistem. 

CLEAR PREFETCH FOLDER - opþi-
unea goleºte toate directoarele de tip cache
alocate de Windows. Aceastã "curãþare" este
recomandabil sã o efectuezi sãptãmânal
pentru a îmbunãtãþi performanþa per
ansamblu a sistemului de operare. 

DEFRAG BOOT FILES - opþiunea
defragmenteazã rapid fiºierele de boot.
Îmbunãtãþind viteza de iniþializare. 

DISABLE ZIP FOLDERS - funcþia
dezinstaleazã capacitatea sistemului de
operare de a manipula fiºierele ZIP. Aceasta
dezinstalare elibereazã din resursele sis-
temului, însã dacã doreºti sã despa-
chetezi/împachetezi trebuie sã foloseºti o
altã aplicaþie ca WinZIP sau WinRAR.
Opþiunea este recomandatã celor care ºi-au
instalat o aplicaþie de împachetare/despa-
chetare! 

ULTRA-FAST BOOTING - Opþiunea
mutã fiºierele de bootare la sfârºitul discu-
lui, dupã care îl defragmenteazã. Poate
spori viteza de iniþializare cu peste 300%.
Opþiunea este recomandatã tuturor.

În al treilea meniu Hardware poþi sã-þi
îmbunãtãþeºti viteza sistemului la nivel
hardware: 

CD-BURNING - opþiunea dezac-
tiveazã/activeazã capacitatea sistemului de
operare de a scrie CD-uri. Dacã foloseºti
alte programe de scriere a CD-urilor este
recomandat sã dezactivezi aceastã opþiune
pentru a salva resurse. Opþiunea este reco-
mandatã tuturor. Enable UDMA-66 - opþi-
unea activeazã funcþia UltraDMA-66 a
chipseturilor Intel; este recomandatã tutu-
ror celor care dispun de plãci de bazã cu
chipset Intel. 

INCREASE CPU PRIORITY - opþiunea
schimbã modul de operare al Windows-
ului cu resursele microprocesorului.
Aceasta opþiune îmbunãtãþeºte perfor-
manþa aplicaþiilor primare ºi este utilã pen-
tru teste (benchmarking). 

INCREASE USB POLLING INTERVAL -
schimbã latenþa porturilor USB de la 1ms la
5ms. Opþiunea este idealã pentru cei care
testeazã performanþele sistemului pentru
cã reduce sesizabil din atribuþiile proce-
sorului ºi este idealã ºi pentru cei care folo-

sesc un laptop. 
SPEED-UP WINDOWS IRQ HANDLING

- Optimizeazã modul de administrare IRQ
al Windows-ului, ºi astfel sistemul de ope-
rare va rula mult mai repede. Opþiunea
este recomandatã tuturor. 

În meniul Internet, poþi sã-þi
îmbunãtãþeºti viteza navigãrii pe Internet
ºi nu numai: 

IP SETTINGS - este un utilitar mic care
îþi permite sã reînnoieºti adresele IP. 

INCREASE DNS CACHE - opþiunea
îmbunãtãþeºte cache-ul DNS din Windows,
astfel încât accesul la situri va fi mai rapid.
Opþiune recomandatã tuturor.

În meniul “Services” poþi sã îmbu-
nãtãþeºti calitatea serviciilor din Windows: 

FAST USER SWITCH - aceastã opþiune
permite mai multor utilizatori sã fie logaþi
în acelaºi timp. Atenþie, serviciul foloseºte
considerabil de mult procesorul ºi memoria
RAM a sistemului. Dacã vrei mai multã per-
formanþã, este recomandat sã opreºti acest
serviciu. 

MESSENGER - dacã activezi aceastã
opþiune, nu vei mai primi popup-uri
nedorite! 

THEMES - acest serviciu controleazã
toate temele din Windows; dacã îl dezac-
tivezi, procesorul va fi scutit sã mai lucreze
în plus ºi astfel sistemul tãu va opera mai
repede, însã interfaþa frumoasã a
Windows-ului va fi înlocuitã cu cea clasicã. 

În meniul Miscellaneous s-au adãugat
scurtãturi cãtre principalele utilitare care
sunt recomandate a fi utilizate mai des: 

CHECK DISK - binecunoscutul utilitar
din Windows care verificã hard discurile.

DEFRAGMENT - cu ajutorul acestui
utilitar îþi poþi defragmenta partiþiile hard
discului. 

SYSTEM FILE CHECKER - verificã
integritatea fiºierelor de sistem. 

WINDOWS UPDATE - lanseazã  apli-
caþia Windows Update. �

DDoorreell  PPuucchhiiaannuu  jjrr..

dorel@myc.ro

IInntteerrffaaþþaa  TTuunneeXXpp
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Î
n afarã de elementele despre care am
vorbit în numãrul trecut (imagini,
margini, culori, fundaluri), fonturile

utilizate sunt un alt aspect important care
trebuie luat în considerare atunci când
creezi pagini web.

(Pentru cei care nu au avut posibilitatea
sã citeascã prima parte a acestui articol care
a fost prezentatã în numãrul trecut al revis-
tei, am sã spun cã pentru a putea testa
exemplele prezentate în continuare nu vor
avea nevoie de altceva decât de un editor
de text, gen "notepad" ºi un browser care sã
afiºeze paginile. Exemplele se salveazã ca
fiºier .html).

Revenind la ideea anterioarã, folosirea
unui font lizibil de dimensiune potrivitã
este indicatã în dauna folosirii unui font
pretenþios de dimensiune prea mare sau
prea micã. Nu existã niºte "standarde" pen-
tru utilizarea fonturilor, însã este bine sã
foloseºti fonturi ºi dimensiuni echilibrate. 

În CSS proprietatea care defineºte tipul
fontului este font-family. De exemplu, dacã
doresc ca paragrafele dintr-o paginã sã
aparã scrise cu font "verdana", voi avea
urmãtoarea declaraþie:

P { font-family: Verdana}

Este posibil ca unele browsere sã nu
gãseascã un anumit font instalat pe un sis-
tem. În acest caz, ca o precauþie, este bine sã
specifici în declaraþie mai multe fonturi, pe
care trebuie sã le desparþi prin virgulã (cel
mai bine este ca ultimul font din listã sã fie
unul generic, de genul "sans-serif"). 

P { font-family: Arial, Times

New Roman, Verdana, sans-serif}

În cazul de mai sus, browserul va ana-
liza sistemul ºi va cãuta pe rând sã vadã
dacã sunt instalate fonturile "Arial", "Times
New Roman" sau "Verdana". În cazul în
care nu este gãsit nici unul, va fi folosit
orice font generic de tip "sans-serif".

Probabil cã ai constatat cã ºi în cazul în
care nu vei specifica nici un font (nici în
documentul HTML ºi nici în declaraþiile
CSS), browserul va afiºa oricum pagina,
folosindu-se de fonturile implicite.

Am sã fac o parantezã, pentru a-þi atrage
atenþia asupra unui fapt. Spuneam data

trecutã cã declaraþiile CSS sunt cuprinse
între semnele care în HTML reprezintã un
comentariu ce nu va fi afiºat de cãtre
browser. Aceste comentarii sunt destul de
benefice în momentul în care se creeazã
pagini mai mari ºi simþi nevoia sã scrii
notiþe care sã-þi aminteascã de faptul cã în
locul respectiv trebuie sã mai adaugi ceva
sau sã faci o modificare. Bineînþeles cã
aceastã facilitate se regãseºte ºi în CSS
numai cã de data aceasta se foloseºte
schema "/* comentariu */". De exemplu:

P { font-family: Arial} 

/* eventual sa incerc sa folo-

sesc Verdana*/

NNoottãã::  Tot în numãrul trecut spuneam

cã este bine ca atunci când scrii codul

CSS/HTML sã apelezi la indentare

pentru o mai bunã lizibilitate (uti-

lizarea tastei [TAB] te va ajuta foarte

mult în acest sens). Din motive de

spaþiu, nu am utilizat aceastã metodã

la codurile pe care le-am scris în

revistã.
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Referitor la stilul în care poate fi afiºat
un text, CSS-ul are proprietatea font-style,
care poate avea valorile "normal" (valoarea
implicitã), "italic" sau "oblique".

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana; font-style: oblique;}

p {font-style: italic;}

/* nu vad sa existe vreo

diferenta intre cele doua sti-

luri*/

-->

</style>

<head>

<body>

Aceasta este doar o pagina de

test

<p>Aceasta este doar o pagina

de test</p>

</body>

</html>

Valoarea "normal" poate fi folositã de
exemplu în cazul în care ai setat ca fontul
pentru selectorul <body> sã fie "italic", dar
doreºti ca o porþiune a paginii sã fie afiºatã
cu font normal. Dacã nu vei specifica acest
lucru, porþiunea respectivã va moºteni va-
lorile proprietãþilor asociate etichetei-
pãrinte, în cazul acesta textul va fi afiºat tot
cu italice. 

Obiºnuiþi probabil cu Office-ul com-
paniei Microsoft ne-am fi aºteptat ca va-
loarea "bold" sã fie datã proprietãþii font-
style. Nu este însã aºa. Dacã doreºti sã
modifici grosimea unui font va trebui sã
foloseºti proprietatea font-weight. Aceasta
poate avea patru valori fixe ("normal" - va-
loarea implicitã, "bold", "bolder" ºi
"lighter"), sau o valoare variabilã exprimatã
în numere de la 100 la 900.

Dacã "normal" este valoarea iniþialã, aºa
cum apare aceasta dacã nu suferã nici o
modificare, iar "bold" este valoarea stan-
dard de îngroºare a fonturilor, celelalte
douã sunt mai intensã ("bolder") sau mai
puþin intensã decât cea implicitã ("lighter").

Pentru o setare mai exactã a grosimii
poþi sã apelezi la valorile cuprinse între 100
(cel mai subþire) ºi 900 (cel mai gros). În
exemplul urmãtor poþi sã observi diferenþa
între diferitele tipuri de grosimi.

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

p.normal {font-weight: normal;}

p.bold {font-weight: bold;}

p.bolder {font-weight: bolder;}

p.lighter {font-weight:

lighter;}

p.osuta {font-weight: 100;}

p.nouasute {font-weight: 900;}

/* diferenta intre

tipurile de grosimi*/

-->

</style>

<head>

<body>

<p class="normal">Aceasta este

un paragraf normal</p>

<p class="bold">Aceasta este un

paragraf ingrosat</p>

<p class="bolder">Aceasta este

un paragraf si mai ingrosat</p>

<p class="lighter">Aceasta este

un paragraf mai putin

ingrosat</p>

<p class="osuta">Pentru acest

paragraf am folosit grosimea

100</p>

<p class="nouasute">Pentru

acest paragraf am folosit

grosimea 900</p>

</body>

</html>

Înainte de a vedea cum stabilim
mãrimea fontului am sã-þi reamintesc doi
termeni despre care am vorbit data trecutã:
"absolut" ºi "relativ". Primul face referire la o

unitate fixã, iar celãlalt este în legãturã cu
altceva, depinde de un alt element.

Pentru a stabili mãrimea unui font avem
la dispoziþie proprietatea font-size. Aceasta
poate fi absolutã sau relativã (în funcþie de
fontul absolut mediu). Valorile absolute
sunt în puncte (pt) sau pixeli (px), iar cele
relative pot fi la rîndul lor fixe sau variabile.
Pentru cele absolute mai existã ºi valori fixe,
însã din cauza unor incompatibilitãþi cu
browserele nu am sã abordez aceastã pro-
blemã, fiind suficientã cunoaºterea celor-
lalte valori. Valorile relative fixe sunt "small-
er", "normal" (implicitã), "larger", iar cele
relative variabile sunt exprimate în pro-
cente. Urmãtorul exemplu te va ajuta sã
vezi exact modul în care se exprimã
mãrimea fonturilor în CSS.

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

p.puncte {font-size: 10pt;}

p.pixeli {font-size: 10px;}

p.smaller {font-size: smaller;}

p.normal {font-size: normal;}

p.larger {font-size: larger;}

p.procente {font-size: 80%;}

/* diferenta intre

tipurile de marimi*/

-->

</style>

<head>

<body>

<p class="puncte">Marimea este

exprimata in puncte</p>

<p class="pixeli">Marimea este

exprimata in pixeli</p>

www.csszengarden.com --  uunn  ssiitt  ccaarree  mmeerriittãã  vviizziittaatt
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<p class="smaller">Marimea este

exprimata prin valoarea small-

er</p>

<p class="normal">Marimea este

exprimata prin valoarea normal

(implicita)</p>

<p class="larger">Marimea este

exprimata prin valoarea larg-

er</p>

<p class="procente">Marimea

este exprimata in procente</p>

</body>

</html>

CSS îþi permite sã controlezi cu uºurinþã
distanþa dintre rânduri apelând la propri-
etatea line-height care poate sã aibã valori
în pixeli sau în ems. În exemplul care ur-
meazã vei putea observa acelaºi para-
graf,  avînd spaþierea dintre rânduri dife-
ritã.
<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

p.larg { line-height: 22px;}

p.ingust { line-height: 14px;}

/* diferenta intre

tipurile de marimi*/

-->

</style>

<head>

<body>

<p class="larg">Prima impresie pe
care mi-a creat-o acest browser a fost una
destul de buna: simplu si compact, parca
totusi nu la fel de finisat ca si Avantul.
Bineinteles ca urmatorul lucru pe care am
vrut sa-l aflu a fost daca aceasta interfata
este usor customizabila si daca pot fi apli-
cate skinuri. Daca asupra primului aspect
voi mai reveni putin mai incolo, trebuie sa
spun ca am fost placut impresionat de posi-
bilitatile pe care le ai daca doresti sa 
schimbi "look-ul" navigatorului. </p>

<p class="ingust">Prima impresie pe
care mi-a creat-o acest browser a fost una
destul de buna: simplu si compact, parca
totusi nu la fel de finisat ca si Avantul.
Bineinteles ca urmatorul lucru pe care am
vrut sa-l aflu a fost daca aceasta interfata
este usor customizabila si daca pot fi apli-
cate skinuri. Daca asupra primului aspect
voi mai reveni putin mai incolo, trebuie sa
spun ca am fost placut impresionat de posi-
bilitatile pe care le ai daca doresti sa 
schimbi "look-ul" navigatorului.</p>

</body>

</html>

Ar mai fi de amintit în ceea ce priveºte
setarea fonturilor, proprietatea font-variant
care poate avea valorile "normal" ºi "small-
caps", precum ºi scurtãtura prin care se pot
înºira toate proprietãþile aplicabile fon-
turilor. Ordinea de înºiruire a proprietãþilor
este urmãtoarea: "style", "variant", "weight",
"size/line-height", "font-family". De exem-
plu:

p { font: normal small-caps

bolder 13px/20px Verdana }

Existã ºi alte proprietãþi care-þi permit sã
deþii un bun control asupra modului de
aranjare a textului în paginã. Una dintre
acestea este text-indent, cu ajutorul cãreia
vei seta distanþa de indentare a primului
rând dintr-un paragraf. Valorile pot fi în
pixeli/ems sau în procente (de asemenea
valorile pot fi ºi negative).

p { text-indent: 20px }

p { text-indent: 35% }

p { text-indent: -20px }

O altã proprietate de control asupra tex-
tului este text-align care stabileºte modul în
care este aliniat textul în raport cu rîndul: la
dreapta, la stânga, centrat sau întins pe tot
rândul (valorile "left", "right", "center", "jus-
tify").

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

p.stanga {text-align: left;}

p.centrat {text-align: center;}

p.dreapta {text-align: right;}

p.intins {text-align: justify;}

/* diferitele

tipuri de aliniere*/

-->

</style>

<head>

<body>

<p class="stanga">Aceasta este

un paragraf aliniat la 

stanga</p>

<p class="centrat">Aceasta este

un paragraf aliniat pe 

centru</p>

<p class="dreapta">Aceasta este

un paragraf aliniat la 

dreapta</p>

<p class="intins">Aceasta este

un paragraf intins pe tot 

randul. Ceea ce inseamna ca

ambele limite vor fi atinse,

atat in partea dreapta cat si

in cea stanga</p>

</body>

</html>

Am lãsat pentru finalul prezentãrii fon-
turilor în CSS, câteva modalitãþi de

http://jigsaw.w3.org/css-validator

PPee  aacceesstt  ssiitt  ppooþþii  ssãã

vveerriiffiiccii  iinntteeggrriittaatteeaa

ccoodduulluuii  CCSSSS



CSSCSS|DESIGN WEB| My HANDS

www.myc.ro noiembrie  2004|69

"împopoþonare" a textului care se realizeazã
cu ajutorul proprietãþii text-decoration.
Aceasta poate avea valorile: "none" (ceea ce
înseamnã cã dacã textul este subliniat,
linkurile de exemplu, acesta se va transfor-
ma într-unul normal, nesubliniat), "under-
line" (subliniat), "overline" (o linie deasupra
textului), "line-through" (textul este tãiat cu
o linie pe orizontalã), "super" (textul este "la
putere") ºi "sub" (textul este la bazã). O va-
loare mai puþin utilizatã (din cauzã cã este
foarte enervantã:)) este "blink" (efectul de
apariþie-dispariþie a textului).

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

p.subliniat { text-decoration:

underline;}

p.liniedeasupra { text-decora-

tion: overline;}

p.taiat { text-decoration:

line-through;}

p.laputere { text-decoration:

super;}

p.labaza { text-decoration:

sub;}

p.clipire { text-decoration:

blink;} 

/* detest

ultimul efect :) */

-->

</style>

<head>

<body>

<p class="subliniat">Aceasta

este un paragraf subliniat</p>

<p class="liniedeasupra">

Aceasta este un paragraf care

are o linie deasupra</p>

<p class="taiat">Aceasta este

un paragraf taiat</p>

<p class="laputere">Aceasta

este un paragraf "la

putere"</p>

<p class="labaza">Acesta este

un paragraf "la baza"</p>

<p class="clipire">Acest para-

graf clipeste</p>

</body>

</html>

Dacã ai pus în practicã exemplul de mai
sus, probabil cã ai constatat urmãtorul
lucru: valorile "sub", "super" ºi (parþial)
"blink" nu au funcþionat. Într-adevãr, nu

ºtiu care este problema cu primele douã
(probabil nu existã suport pentru ele din
partea browserelor). Cu valoarea blink însã,
(de aceea am spus "parþial"), lucrurile stau
altfel. Browserul Firefox are, de exemplu
suport pentru aceastã valoare, pe când IE 6
nu are. De aceea spuneam ºi data trecutã cã
înainte de a utiliza anumite proprietãþi ºi
valori este bine sã le testezi cu mai multe
browsere pentru a vedea ce anume trebuie
ºi ce nu trebuie sã foloseºti.

Linkuri

Linkurile au fost ºi sunt "inima"
paginilor de Internet. Ele au fost cele care
au dat posibilitatea creãrii de legãturi între
documente aflate la mii de km distanþã. În
CSS existã proprietãþi care-þi dau posibili-
tatea de a transforma ºi colora linkurile
dupã bunul plac. 

Totuºi am sã fac din nou o scurtã paran-
tezã pentru a spune câte ceva despre clase-
le "false" (pseudo-classes) din CSS. Aceste
pseudo-clase nu sunt altceva decât niºte
clase generate automat de CSS pentru a te
scuti de muncã suplimentarã. Diferenþa
faþã de clasele create de cãtre tine þine de
sintaxã, ºi anume, în loc de punctul de
dinaintea numelui clasei vei avea semnul
":".

Referitor la linkuri, selectorul cãruia îi
vei aplica diferite pseudo-clase ºi propri-
etãþi pentru acestea este "a".

a:link { proprietate:

valoare;} - link nevizitat;

a:visited { proprietate: val-

oare;} - link vizitat;

a:hover   { proprietate: val-

oare;} - cu mausul deasupra;

a:active  { proprietate: val-

oare;} - cu mausul apãsat;

Vei înþelege mai bine cum stau lucrurile
din exemplul urmãtor:

<html>

<head>

<title>Pagina de test</title>

<style type= "text/css"> 

<!-- body { font-family:

Verdana;}

a:link { color: red;}

a:visited { color: green;}

a:active { text-decoration:

none;}

a:hover { color: magenta;} 

-->

</style>

<head>

<body>

<a href="http://www.nba.com">

Aici se gaseste pagina celui

mai puternic baschet din

lume</a>

</body>

</html>

Dupã cum ai observat, culoarea textului
se va schimba în fiecare dintre cele 4
ipostaze. Pentru starea "active" am stabilit o
altã proprietate, ºi anume am dictat
browserului cã doresc ca în momentul în
care dau un clic pe link, acesta sã nu mai fie
subliniat (a:active { text-decoration:
none;}).

Din pãcate ºi aici browserul IE deza-
mãgeºte, deoarece nu oferã suport deplin
pentru aceastã pseudo-clasã ("active"). ªi
anume, "schema" nu funcþioneazã decât
prima datã. Dupã ce am dat un clic pe link,

bbrroowwsseerree  ººii  ssuuppoorrtt  CCSSSS
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toate ipostazele devin nesubliniate (chiar
dacã am reîncãrcat pagina, lucrurile nu 
s-au schimbat). În schimb, lucrurile au
funcþionat perfect în Firefox.

Dacã þi se pare cã pagina ta este puþin
interactivã, atunci poþi sã apelezi la pseudo-
clasele pe care le pomeneam anterior pen-
tru a da viaþã paginii tale (de exemplu
crearea unui meniu ca în exemplul urmã-
tor).

Am creat o paginã pe care o poþi vedea
în imaginea alãturatã. Din cauzã cã spaþiul
nu-mi mai permite o analizã mai atentã a
codului, am sã fac doar câteva remarci în
legãturã cu acesta. 

Am pornit iniþial de la un layout bazat
pe tabele. Dupã cum observi ºi în imagine,
pagina nu este foarte complexã, însã este
realizatã exclusiv în HTML ºi CSS (adicã nu
ai nevoie de altceva decât de un editor de
text ºi unul-douã browsere pentru testare). 

Nu am operat prea multe modificãri
asupra codului HTML, am creat doar niºte
clase. În ce priveºte declaraþiile CSS am
apelat la proprietãþi care sã schimbe aspec-
tul fonturilor, aranjarea în paginã sau culo-
rile fundalurilor. Poþi sã experimentezi cu
acest cod dupã bunul plac ºi, nu uita sã
testezi rezultatele cu mai multe browsere.  

<html>

<head>

<title>Pagina de test</title>

<style type="text/css">

<!-- body  { font-family:

Verdana;

color: white;

background-color: gainsboro;

margin: 95px;margin-top: 0px;}

td { font-size:14px;color:

black;text-align: left;}

.alt { background-color: dark-

gray;font-size: 12px;padding:

5px;}

a { text-decoration: none;

font-size: 12px;font-variant:

small-caps;font-weight: bold;}

a:link { color: black;}

a:hover { background-color:

goldenrod;color: white;}

table { background-color:

gray;}

.copy { font-size: 10px;color:

white;}

.stiri { background-color:

linen;color: black;padding:

10px;font-family: Verdana;font-

size: 11px;width: 258px;}

H4 { color: red;}

.imagine { background-color:

white;width: 360;padding:

10px;}

.col { width: 182px;font-size:

12px;color: red;background-

color: white;padding: 10px;}

-->

</style>

</head>

<body>

<table width="800">

<tr>

<td colspan="3"><imgsrc=

"c:/logo.jpg"></td></tr><tr>

<td colspan="3"

class="alt">&nbsp;&nbsp;

<a href="c:/index.html">

Home</a>&nbsp;&nbsp;&nbsp;

&nbsp;

<a href="c:/index.html">

Produse</a>&nbsp;&nbsp;&nbsp;&n

bsp;

<a href="c:/index.html">

Linkuri</a>&nbsp;&nbsp;&nbsp;

&nbsp;

<a href="c:/index.html">

Oferte</a>&nbsp;&nbsp;&nbsp;

&nbsp;

<a href="c:/index.html">

Diverse</a>&nbsp;&nbsp;&nbsp;

&nbsp;

<a href="c:/index.html">

Contact</a><hr></td></tr><tr>

<td rowspan="2"class="stiri">

<H4>Noul telefon cu tastatura

culisanta</H4>Samsung a anuntat

oficial [...] la sfarsitul

acestui an.

<a href="c:/index.html">

(...)</a><HR><H4>Plugin-uri noi

[...]imaginile personale.

<a href="c:/index.html">(...)

<HR></a><H4>Linux costa cu 30%

mai putin decat Windows</H4>Un

studiu independent [...] e

plat.

<a href="c:/index.html">(...)

</a></td>

<td class="imagine"

valign="top">

<a href="c:/index.html">

Monitoare</a><br><img

src="c:/image.jpg"><br></td>

<td class="col" valign="top">

<a href="c:/index.html">

Telefoane mobile</a><br>

<img src="c:/sony.jpg"><br><i>

Ultimele modele de telefoane

mobile aparute in anul

2004!</i><hr></td></tr><tr>

<td colspan="2"

class="copy">Copyright © 2004

Priority.com (Laurentiu Bancu).

Toate drepturile

rezervate.</td>

</tr>

</table>

</body>

</html> 

LLaauurreennþþiiuu  BBaannccuu  

laurentiu@myc.ro  
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C
u siguranþã, cea mai bunã soluþie

pentru inscripþionarea CD-urilor

sub Linux este K3B. Este un pro-

gram pe care pot sã-l asemuiesc cel mai

bine cu Nero Burning ROM de sub

Windows. De la crearea de CD-uri audio ºi

pânã la ISO-uri, K3B îþi oferã toate posibi-

litãþile.

Programul, care se aflã acum la versi-

unea 0.11.1%, dispune de o interfaþã graficã

atrãgãtoare ºi poate lucra - desigur - ºi cu

CD-uri ºi cu DVD-uri.

Suportã modurile DAO ºi TAO simula-

rea unei sesiuni, crearea de fiºiere de ima-

gine, realizarea de mai multe copii, crearea

de fiºiere DivX din DVD-uri ºi de MP3-uri

din CD-uri audio. Practic, tot ce ai nevoie

atunci când vrei sã scrii un CD.

K3B este un frontend pentru mai multe

utilitare de sub linie de comandã, cel mai

important dintre ele fiind cdrecord.

Acesta este necesar oricãrei aplicaþii Linux

care poate inscripþiona CD-uri. Printre cele-

lalte de care K3B face uz se numãrã

mkisofs, growisofs, normalize, readcd, 

cdrdao ºi pachetul transcode. 

Aplicaþia poate prelua titlurile melodi-

ilor de pe CD-urile audio de pe freedb.org,

poate decoda melodii în formatele OGG,

MP3, FLAC ºi WAV, ºi coda fiºiere OGG

direct din interfaþã. Asta ca sã nu mai

vorbesc de faptul cã suportã skinuri ºi

diverse pluginuri.

O opþiune extrem de binevenitã sub o

astfel de aplicaþie Linux este posibilitatea

evitãrii erorilor de gen "buffer underrun".

Da, K3B are ºi "Burnfree".

DDaattaa  CCDD

Exact ca ºi în cazul utilizãrii Nero

Burning ROM din Windows, scrierea unui

CD cu date se face extrem de simplu. Se

alege modul "New Data CD Project", tragi

KK33BB  llaa  pprriimmaa  ppoorrnniirree
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cu mouse-ul fiºierele dorite în fereastra din
stânga-jos ºi apeºi pe "Burn" :). Putem selec-
ta modurile DAO sau TAO, viteza de
scriere, modul "Data Track" 1 sau 2, setãrile
multisession dacã acestea existã, un nume
de volum ºi opþiuni extra din tab-ul
"Advanced" (dacã aplicaþia sã foloseascã
symlink-uri, mai multe caractere speciale
într-un nume de fiºier, nume de fiºiere
Joliet de 103 caractere sau dacã sã
foloseascã ISO Level 1, 2 sau 3).

Dacã dãm clic-dreapta pe un nume de
fiºier avem posibilitatea de a-l ascunde în
modurile Rockridge sau Joliet selectând
"Properties".

Tot la "Data CD" ar fi de menþionat sin-
gurul plugin inclus în K3B: cel de redenu-
mire a fiºierelor audio. MP3-urile pe care le
scrii în modul "Data" pot fi redenumite
dupã bunul plac chiar înainte de scriere,
urmând un model predefinit.

AAuuddiioo  CCDD

La realizarea unui CD audio putem
alege între o sursã CDA sau una MP3. K3B
pãstreazã tag-urile fiºierelor MP3 astfel
încât acestea vor fi afiºate la redarea cu un
player capabil sã le prezinte. Implicit, pro-
gramul insereazã o secvenþã de 2 secunde
înaintea fiecãrei melodii. Deoarece mulþi
dorim continuitate pe un CD audio, odatã
ce am tras cu mouse-ul fiºierele în ecranul
"AudioCD" le putem selecta, accesa meniul
contextual ºi accesa "Properties". Din caseta
care apare, în tab-ul "Options" putem selec-
ta un "pregap" de 0 secunde în loc de 2. 

În partea din dreapta-jos a ecranului
putem trage cu mouse-ul fiºiere audio pen-
tru ascultare. Da, K3B are încorporat ºi un
player.

Din meniul "Burn" (accesibil cu Ctrl+B)
ni se permite sã selectãm aparatul de
inscripþionare (în caz cã dispunem de mai
multe), viteza de inscripþionare, un text
pentru CD (pentru playerele cu afiºaj) ºi
putem opþional ascunde primul track al

CD-ului.

MMoodd  mmiixxtt

K3B suportã pe lângã CD-uri cu mai
multe sesiuni ºi modul mixt de scriere al
datelor. Asta înseamnã cã putem realiza un
CD care sã aibã o sesiune de date ºi una
audio inscripþionatã pe el. În acest mod,
fereastra drag-and-drop va prezenta douã
tab-uri, unul audio ºi unul pentru date.
Putem alterna între acestea adãugând pe
rând fiºierele de care avem nevoie. 

ªªtteerrggeerreeaa  uunnuuii  CCDD//DDVVDD

Se realizeazã de la Tools / CD / Erase CD-
RW respectiv Tools / DVD / Format DVD-
RW/DVD+RW. În cazul unui CD, avem
mai multe moduri de ºtergere: Fast,
Complete, Erase Last Track, Unclose Last
Session ºi Erase Last Session. Putem schim-
ba ºi viteza de ºtergere în limitele suportate
de unitatea noastrã. Ca ºi în cazurile de mai
sus, am testat ºtergerea unui CD rein-
scriptibil ºi nu am întâmpinat probleme.
K3B se bucurã de 90% din viteza maximã la

PPrroopprriieettããþþiillee  uunnuuii  ffiiººiieerr

IInnssccrriippþþiioonnaarreeaa  uunnuuii  CCDD

PPuutteemm  iinnttrroodduuccee  oo  ppaauuzzãã  îînnttrree  ppiieesseeIInnssccrriippþþiioonnaarreeaa  MMPP33--uurriilloorr  ppee  uunn  CCDD  aauuddiioo

ªªtteerrggeerreeaa  uunnuuii  CCDDRRWW
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care funcþioneazã Nero, ºi se pare cã acesta

este singurul neajuns pe care l-am putut

gãsi programului. Având în vedere vitezele

la care ajung writerele în ziua de azi nu

cred cã cele câteva secunde în plus ar putea

sã deranjeze pe cineva.

VViiddeeooCCDD//eeMMoovviixx

Desigur cã programul ne permite sã

creãm Video Cd-uri, dar ºi mai interesantã

este opþiunea de a crea CD-uri eMoviX. Un

CD eMoviX este un CD cu fiºiere multime-

dia (audio, video sau ambele) de diferite

formate, bootabil, care la inserarea în uni-

tate ºi bootarea de pe el redã, rând pe rând,

toate piesele. Practic, nu mai e nevoie de un

sistem de operare ci doar de un PC. O

modalitate ieftinã de a-þi transforma PC-ul

într-o clonã DVD-player ce oferã un output

de calitate DivX. Convenabil. De menþionat

cã vei avea nevoie ºi de pachetul eMoviX

instalat. K3B, aplicaþiile de inscripþionare

pe care programul le foloseºte, cât ºi

pachetul eMoviX le gãseºti în directorul

OPEN-SOURCE de pe CD-ul din aceastã

lunã.

IImmaaggiinnii  IISSOO

K3B suportã imagini de tip ISO,

CUE/BIN, fiºiere TOC (cdrdao). Suportã -

ca ºi în cazul CD-urilor ºi DVD-urilor - si-

mularea scrierii ºi verificarea ulterioarã a

conþinutului.

DDVVDD

Modul de inscripþionare DVD nu diferã

mult de cel folosit la inscripþionarea CD-

urilor. Dacã dispui de un DVD-Writer

(preþurile au scãzut mult în ultima vreme)

poþi sã foloseºti K3B la inscripþionarea

DVD-urilor tale.

CCoonncclluuzziiee

La testarea programului am folosit un

writer Teac 24x, modelul TEAC CD-W524E,

K3B versiunea 0.11.36 ºi Slackware 10 ca

distribuþie. Vreau sã vã spun cã folosesc

K3B de multã vreme ºi nu am întâmpinat

probleme. Nu am "stricat" nici un CD. Asta

ca sã spulber mitul referitor la Linux ºi CD-

burning. �

RRããzzvvaann  TT..  CCoolloojjaa

razvan@myc.ro

IInnssccrriippþþiioonnaarreeaa  uunnuuii  IISSOO

UUnn  pplluuggiinn  ddee  rreeddeennuummiirree  aa  ffiiººiieerreelloorr  aauuddiioo

CCooppiieerreeaa  ddee  ppee  aalltt  CCDD

SSeessiiuunnii  ddee  ssccrriieerree
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Î
n Maya, la fel ca în viaþa realã, obiectele
sunt alcãtuite din materiale. Aceste
materiale pot fi distinse dupã modul în

care reflectã lumina. Când lumina ajunge la
obiect, o parte este absorbitã ºi o parte este
reflectatã. Un obiect din metal va reflecta
mai multã luminã decât un obiect de lemn.
O sferã poate reflecta lumina identic în
toate direcþiile, sau poate avea o suprafaþã
lucioasã care rãmîne fixatã în timp ce sfera
se învârte. În Maya, substanþa din care este
alcãtuit un obiect ºi care are proprietatea de
reflexie sau de absorbþie a luminii poartã
numele de material sau "shader". Implicit,
în Maya este asociat unui obiect materialul
"Lambert", care nu prezintã zone lucioase ºi
reflectã lumina identic în toate direcþiile.
Alãturi de aceste materiale, obiectele sunt

caracterizate în principal de culoare, tex-
turã ºi transparenþã. Definirea materialelor
are loc într-o fereastrã specificã care poartã
numele Hypershade, accesibilã din meniul
[Window] - [Rendering Editors] -
[Hypershade]. În aceastã fereastrã, pentru
a încadra cât mai bine conþinutul, poþi mãri
sau micºora imaginea apãsând tasta [Alt] ºi
butonul din dreapta al mausului, poþi muta
în lateral conþinutul apãsând butonul [Alt]
ºi butonul din mijloc al mausului, dar nu
poþi roti camera în jurul materialului
definit, pentru cã aceastã fereastrã foloseºte
doar douã dimensiuni pentru afiºare.  

Când deschizi fereastra [Hypershade] în
partea stângã este afiºat meniul de creare al
materialelor. Existã mai multe categorii
principale folosite în Maya pentru simula-
rea comportamentului real al luminii în
raport cu diferitele suprafeþe existente, ast-
fel avem acces la [Volumetric Materials]
sau la [Displacement Materials] precum ºi
alte categorii. Pentru a crea un nou materi-

al selecteazã din meniul
ferestrei [Hypershade] -

[Create] - [Materials] -
[Lambert]. Pentru a asocia acest material cu
un obiect din scenã trebuie sã apeºi
butonul din mijloc al mausului pe material,
sã-l tragi ºi sã-i dai drumul pe suprafaþa
obiectului într-una din ferestrele în care
acesta este vizibil. Poþi obþine aproximativ
acelaºi rezultat dacã efectuezi un dublu clic
cu butonul din dreapta al mausului pe
material ºi selectezi din meniu [Asign
Material To Selection]. Dacã efectuezi un
click dublu asupra materialului creat se
deschide fereastra de caracteristici pentru
materialul respectiv. Aici poþi defini
culoarea, textura ºi multe alte atribute ale
materialului. În partea dreaptã a butonului
de unde are loc definirea culorii este situat
butonul [Create Render Node] care
deschide dialogul pentru definirea texturii.
Aici poþi selecta una dintre texturile prede-
finite sau poþi importa o texturã nouã dintr-
un fiºier apãsând butonul [File] ºi selelec-
tând imaginea doritã. În program sunt
incluse multe astfel de texturi, pentru piele

FFeerreeaassttrraa  [[HHyyppeerrsshhaaddee]]  aacccceessiibbiillãã  ddiinn  mmeenniiuull  [[WWiinnddooww]]  --  [[RReennddeerriinngg  EEddiittoorrss]]  --  [[HHyyppeerrsshhaaddee]]
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sau diferite roci, fapt care ajutã la o definire
rapidã ºi la conturarea unei idei despre
modul în care ar trebui sã arate o scenã. Poþi
alcãtui singur aceste texturi cu aparatul
foto, pentru a le importa apoi în Maya.
Pentru a observa rezultatul aplicãrii texturii
pe obiectul respectiv trebuie sã apeºi
butonul [6] pe tastaturã (acesta determinã
afiºarea obiectelor din scenã cu texturile
aplicate). În fereastra [Hypershade] poþi
muta materialele, texturile, le poþi grupa
sau izola ºi poþi observa legãturile de
dependenþã. În Maya operaþiile efectuate
asupra datelor dintr-o scenã, ºi raportul
dintre ele este reprezentat prin noduri
interconectate. Fiecare astfel de nod este
reprezentat printr-un icon care îi reprezin-
tã caracteristicile. Mai multe astfel de

noduri pot fi conectate pentru a obþine
efectul dorit, formând o reþea denumitã
[Shading Network]. Din graficul de depen-
denþã al nodurilor îþi poþi forma o idee
despre cum va arãta un obiect. 

Dupã definirea ºi asocierea texturilor are
loc încadrerea lor pe suprafaþa obiectului.
Aceste texturi pot fi rotite, alungite sau
îngustate, ajustarea lor fiind posibilã în fe-
reastra [UV Texture Editor] accesibilã din
meniul [Panels] - [Panel] - [UV Texture
Editor] sau din meniul [Window] - [UV
Texture Editor]. Aici sunt desfãºurate feþele
obiectului ºi pot fi modificate texturile în
aºa fel încât sã se potriveascã cu feþele
obiectului respectiv. Textura este dispusã pe
o grilã notatã de la 0 la 1 (suprafaþa totalã a
texturii este 1x1), iar pe orice faþã a obiectu-
lui care depãºeºte în lungime sau în lãþime
valoarea 1, textura se va repeta (în confor-
mitate cu plasarea în continuare a unei alte
grile identice cu prima). Dacã apeºi butonul
din dreapta al mausului pe suprafaþa aces-
tei ferestre ºi selectezi [UV] poþi modifica
forma feþelor în funcþie de textura definitã
(totul se va modifica în timp real în fereas-
tra în care observi modificarea obiectului).
Aici poþi efectua comenzile obiºnuite de
scalare, de rotire sau de mutare pentru a
obþine rezultatul dorit. Dacã selectezi doar
o faþã a obiectului, doar acea faþã va apare
pe grilã, iar dacã selectezi tot obiectul, feþele
vor fi desfãºurate ºi vor fi plasate pe grilã.
Dacã apeºi tasta [Ctrl] ºi butonul din dreap-
ta al mausului accesezi un meniu din care
poþi selecta uºor pãrþile componente ale

obiectului respectiv. Selectând meniul din
categoria [Modeling] - [Poligons] - [Planar
Maping] poþi ajusta textura direct pe faþa
unui obiect. Punctele albastre au rolul de a
scala textura, din centru având posibilitatea
sã o miºti, iar linia albastrã care înconjoarã
centrul are rolul de a o roti. Poþi efectua ace-
leaºi comenzi ºi din fereastra [UV Texture
Editor], dar la început metoda de încadrare
a texturii direct pe obiect prin comanda
[Planar Maping] este mult mai uºoarã. 

Procesul de texturare a obiectelor din-
tr-o scenã are un rol foarte important
asupra modului în care este perceputã o
scenã. Multã lume îºi concentreazã atenþia
doar asupra realizãrii animaþiilor, sau doar
asupra modelãrii. Cunoºtinþele de bazã
asupra proceselor înrudite cu texturarea
ajutã la conturarea unei concepþii ºi a unui
mod de gândire în abordarea unei scene
noi. Dar pentru aprofundarea cu-
noºtinþelor de bazã este necesarã multã
muncã ºi mult intereres, iar cei interesaþi
vor fi rãsplãtiþi pe mãsurã. �

RReemmuuss  ZZooiiccaa

remus@myc.ro

SSeelleeccttâânndd  ddiinn  mmeenniiuull  [[MMooddeelliinngg]]  --  [[PPoolliiggoonnss]]  --  [[PPllaannaarr  MMaappiinngg]]  ppooþþii  aajjuussttaa  
tteexxttuurraa  ddiirreecctt  ppee  ffaattaa  uunnuuii  oobbiieecctt

MMaatteerriiaalleellee  aacccceessiibbiillee

BBuuttoonnuull  [[CCrreeaattee  RReennddeerr  NNooddee]]    

ddeesscchhiiddee  ddiiaalloogguull  ppeennttrruu  ddeeffiinniirreeaa  

tteexxttuurriilloorr
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S
puneam în prima parte a articolu-

lui care a fost prezentatã în

numãrul trecut al revistei cã

dependenþa de jocurile pe calculator a fost

ºi este un fenomen demonstrat. Dar care

sunt persoanele care considerã, ca sã spun

aºa, cã acest fenomen este unul negativ

sau, mai exact, când devine obsesia pentru

jocuri un impediment în dezvoltarea nor-

malã a unui individ? Se poate vorbi despre

o dependenþã "controlatã"?

Am încercat sã vãd ce pãrere are despre

acest fenomen un gamer înrãit, poate una

dintre persoanele cea mai în mãsurã sã

rãspundã la aceste întrebãri, Ciprian

Coroianu, redactor-ºef al revistei PC Games

4 Fun.

Laurenþiu Bancu: Consideri cã existã

un sâmbure de adevãr în expresia "depen-

denþã de jocuri pe calculator"?

Ciprian Coroianu: Nu, ºi nu mã mai privi
aºa cã scot silexul! 

Existã pasiune pentru jocuri, dar depen-
denþã... poate în cazul unor persoane cu pro-
bleme psihice! Îþi mai aminteºti celebrul logo al
defunctei reviste Computer Games: "jocuri care
vã ruineazã viaþa socialã, vã distrug cariera, vã

mãnâncã tot timpul"? Cred cã aceastã nebunie
frumoasã care se numeºte, repet, pasiunea de a
juca jocuri pe calculator a fost cel mai bine
definitã în acest genial logo.  

Laurenþiu Bancu: Poþi sã delimitezi o

graniþã între divertisment ºi dependenþã?

Ciprian Coroianu: Este clasica delimitare
dintre uz ºi abuz: mi-e greu sã înþeleg un puºti
de 14 ani care joacã 14-16 ore neîntrerupt...
ehm, Counter-Strike, la fel cum altul, de aceeaºi
vârstã care citeºte acelaºi numãr de ore pe zi 
nu-mi spune prea multe lucruri bune! Cred cã
totul depinde de cel care joacã. Acum câþiva ani
buni, RPG-urile erau denumite "LSD" datoritã
unei aºa-zise dependenþe pe care o provocau. În
Baldur's Gate, însã, îþi apare din când în când
urmãtorul text: "Adu-þi aminte cã dacã perso-
najele tale nu au necesitãþi fiziologice, tu trebuie
sã mãnânci etc... nu vrem sã pierdem jucãtori
devotaþi"! 

Laurenþiu Bancu: Este dependenþa de

jocuri mai periculoasã în cazul tinerilor

sau în cazul adulþilor?

Ciprian Coroianu: Dependenþa, în cazul
în care se manifestã, îi atinge ºi pe cei cu tâmple
sure ºi pe cei cãrora abia le-a mijit puful în
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barbã. Imagineazã-þi un tip de 40 + care a prins
gustul jocurilor pe calculator, sã zicem strategii,
cã-s mai bãtrâneºti, ºi care lâncezeºte pe calcula-
torul lui fiu-su pânã la cântatul cocoºilor! Brrr,
sper sã nu ajung aºa niciodatã! Sau un puºti
care-ºi dã ultima bancnotã de 10000, în Internet
cafe-uri, chiuleºte la greu de la ºcoalã, este
exmatriculat... Apocalyps now, nu alta!  

Laurenþiu Bancu: Care crezi cã sunt

pãrþile bune ºi cele mai puþin bune ale

dependenþei de jocuri? 

Ciprian Coroianu: Nici o dependenþã nu
poate avea "pãrþi bune sau pãrþi mai puþin
bune". Cred cã deja ai devenit dependent de
atâta dependenþã! Reformuleazã întrebarea cã
nu-þi mai scap nici o perluþã pe taburet!

Laurenþiu Bancu: Ce sfaturi le dai

gamerilor "înrãiþi" (asta ca sã nu abuzez de

termenul "dependent")?

Ciprian Coroianu: În sfârºit, putem respi-
ra... Singurul sfat pe care-l pot adresa gamerilor
este sã încerce sã regãseascã factorul fun în
jocurile actuale ºi sã se implice mai mult, prin
criticile lor, în industria de jocuri, care nu stã
deloc pe roze în ceea ce priveºte PC-ul. Sã nu
uitãm cã numai prin jocuri bune devii cu ade-
vãrat gamer!

Am fost acuzat dupã scrierea primei
pãrþi cã am exagerat puþin lucrurile ºi cã
bag sperieþii în pãrinþi ºi bunici fãrã a avea
motive bine întemeiate... Într-adevãr cred
cã ar fi bine dacã toatã lumea ar putea
înþelege ºi combina autocontrolul cu pasi-
unea, "feeling-ul" pe care-l trãieºte un jucã-
tor.

Nici nu am de gând sã-l contrazic pe
Cipri, este de mult "în meserie", însã

cazurile în care apar probleme din cauza
lipsei autocontrolului sunt nenumãrate,
existând situaþii în care cei implicaþi au avut
de suferit fizic de pe urma nenumãratelor
ore petrecute în faþa PC-ului, fãrã "pâine ºi
apã". În consecinþã am sã mã refer la
dependenþã ca fiind "o pasiune exageratã
pentru un joc care a dus la pierderea auto-
controlului ºi influenþeazã negativ compor-
tamentul ºi relaþia celui în cauzã cu per-
soanele din jur" (cam pompos, dar pe
aproape...).

Am citit odatã undeva cã o femeie ºi-a
uitat copilul într-o spãlãtorie deoarece era
nerãbdãtoare sã ajungã la urmãtorul nivel
din Sims; sau, mai grav, un tânãr care a
decedat dupã ce a petrecut non-stop mai
mult de trei zile în faþa calculatorului jucân-
du-se. 

Pânã unde poatã sã meargã pasiunea
pentru o lume care nu existã decât în ima-
ginaþia jucãtorului? Greu de rãspuns la
aceastã întrebare...

Realizez oricum cã este vorba despre un
cerc vicios. Nici una dintre cele douã cate-
gorii (cei foarte pasionaþi ºi cei foarte puþin
pasionaþi) nu va înþelege "de ce?" sau "de ce
nu?".

Personal, cred cã un gamer adevãrat este
persoana care poate sã trãiascã normal în
ambele lumi, atât în cea realã cât ºi în cea
imaginarã. Aceste universuri paralele se
influenþeazã reciproc.

Recunosc cã este posibil sã fi exagerat
când am spus "pãrþile bune ale depen-
denþei". Sau poate nu m-am exprimat
foarte corect. Ar fi trebuit sã spun: "pãrþile
bune ale faptului cã mã joc pe calculator
pânã mi se umezesc ochii în timp ce soarele
se va fi învârtit de 3 ori în jurul casei".

Aspectele benefice ale maniei de a te
juca pe calculator sunt de netãgãduit.
Specialiºtii americani recomandã anumite
jocuri tinerilor recruþi. Studenþii la
chirurgie sunt sfãtuiþi sã joace diverse
jocuri. Spiritul de echipã, atenþia, concen-
trarea, ambiþia sunt câteva dintre calitãþile
care se dezvoltã în urma practicãrii acestei
"meserii".

Gamerii înrãiþi sunt persoane foarte
pasionale ºi din aceastã cauzã foarte puter-
nice. Dar, pe de altã parte, lipsa autocon-
trolului genereazã acþiuni care, dupã cum
spuneam, influenþeazã comportamentul ºi
viaþa celor implicaþi.

Dacã pânã acum am vorbit pe limba
gamerilor, ºi le-am dat apã la moarã (sper sã
nu fiu prin zonã când va citi Cipri arti-
colul...) într-o notã mai glumeaþã, este tim-
pul acum sã trec de partea celor  mai scep-
tici, sã iau o atitudine mai serioasã ºi sã
vedem eventual cum poate fi tratatã
aceastã "manie".   

În special, bãieþii sub 18 ani sunt per-
soanele care pot sã cadã uºor în capcana
dependenþei.   

Am sã ating din nou un punct sensibil ºi
pot sã fiu sigur cã-mi voi ridica în cap cu
aceastã ocazie o grãmadã de "jucãuºi", dar
ce sã fac, acestea sunt riscurile meseriei...

Violenþa din jocuri... îþi vei spune cã nu
prea are legãturã cu ce se discutã aici, dar
eu am sã insist totuºi. Mi-aduc aminte când
eram ºi noi tineri cã ne uitam la "Tom ºi
Jerry", "Pantera Roz" sau "Nils Holgerson".
Copiii din ziua de azi au parte însã de
"Batman vs. the forces of evil", "Horrible
and terrifying Superman" sau mai ºtiu eu
ce desene animate care de care mai violente
ºi sângeroase. Nici în ceea ce priveºte

ÎÎnn  lloocc  ssãã  jjooccii  uunn  jjoocc  îînn  ccaarree  ssâânnggeellee  eessttee  îîmmpprrããººttiiaatt  ppee  ttooþþii  ppeerreeþþiiii,,  mmaaii  bbiinnee  iieeii  oo  mmiinnggee  ººii  iinnttrrii  îînn  ppiieelleeaa  lluuii  TTrraaccyy  MMccGGrraaddyy
ººii--þþii  ppiieerrzzii  ttiimmppuull  ppee  tteerreennuull  ddee  bbaasscchheett..  
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jocurile lucrurile nu stau mai bine.
Nu demult a fost lansat Doom3, proba-

bil unul dintre cele mai "îngrozitoare"
jocuri. Adepþii genului vor da din mânã ºi
vor spune cã jocul nu este recomandat
celor sub 18 ani. Sã fim serioºi: care este
pãrintele care poate sã-ºi supravegheze
non-stop odrasla de 7 ani care a ascuns
jocul în c:/Windows/Registration/CRMLog
(ºi nu mã refer aici la pãrinþii care ºtiu
despre ce este vorba în propoziþie, ci la
aceia care nu ºtiu de unde se þine mausul).
În cazul în care un tânãr devine dependent
de un astfel de joc ºi nu se dã bãtut pânã nu
terminã toate nivelele "pe hard", nu ºtiu de
ce ne mai mirãm de ce trãim într-o atmos-
ferã de violenþã ºi nesiguranþã.

Nu voi mai insista pe aceastã temã, nefi-
ind foarte elocventã pentru ceea ce discu-
tam aici, însã nu am vrut sã las nespecificat
un asemenea aspect care mi se pare foarte
important.

"Strânºi cu uºa!"

Aceasta este o "vorbã de duh" foarte su-
gestivã atunci când cineva trebuie sã
impunã sau sã oblige o altã persoanã sã
procedeze într-un anume fel. Bineînþeles cã
este folosit sensul figurat însã, în mare, cam
asta ar fi ideea: pãrinþii trebuie sã fie cât mai
stricþi cu copiii care întrec mãsura. ªi fac
referire aici la o supraveghere foarte atentã,
iar în cazul în care acest lucru nu este posi-
bil, îndepãrtarea obiectelor în cauzã pânã
se restabileºte echilibrul între timpul petre-
cut în faþa PC-ului ºi restul activitãþilor,
pare sã fie soluþia cea mai eficientã. 

Nu mã îndoiesc cã aceste soluþii extreme
se vor lãsa cu ceva certuri, dar pãrinþii tre-
buie sã fie conºtienþi cã nu au de a face cu o
situaþie ineditã. Trebuie sã procedeze exact
ca în cazul în care copilul este dependent
de TV, de exemplu.

Pe de altã parte, existã o anumitã cate-
gorie de pãrinþi care cred cã totul se poate
rezolva luând PC-ul ºi fãcându-i vânt pe
geam... nepunând la socotealã fatul cã se
întâlnesc cu copiii o datã pe sãptãmânã ºi,
eventual, dacã se concentreazã puþin, îºi

amintesc ºi ce ºcoalã frecventeazã aceºtia.
Dar sã încerc totuºi sã-mi pãstrez simþul
obiectiv...

Pãrinþii au responsabilitate ºi în ceea ce
priveºte gãsirea unor activitãþi pentru copii
care sã compenseze nevoia de materi-
alizare a creativitãþii, imaginaþiei ºi con-
sumare a energiei. 

Iatã în continuare o soluþie aparent
banalã pe care o propune L.C., însã care a
dat roade în cazul fiului sãu.

"Calculatorul devenise pâinea ºi apa lui.
Fãrã acestea nu se poate trãi. Am vrut totuºi
sã-i demonstrez cã se poate. Am luat PC-ul
din camerã ºi nu i l-am înapoiat decât în
weekend. La început frustrarea a fost mare,
însã i-am dat oportunitatea sã ia decizii
mature în legãturã cu administrarea timpu-
lui. ªi aºa s-a întâmplat." 

O "aventurã" ºi mai reprezentativã:
"Singurul lucru care funcþioneazã este

îndepãrtarea fizicã a calculatorului. Am
încercat multe alte tactici. Am spus:<<cal-
culatorul dupã teme>>, însã ne-a spus cã
nu are teme de fãcut. Am încercat sã-i luãm
calculatorul pânã se vor îmbunãtãþi notele
de la ºcoalã, acestea s-au îmbunãtãþit, a
primit calculatorul înapoi, iar notele 
<<s-au prostit >>din nou. Am luat tas-
tatura ºi am închis-o în portbagaj (a fãcut
rost de alta), am deconectat PC-ul de la
Internet (l-a conectat înapoi dupã ce ne-am
culcat), am scos placa video din PC (a
împrumutat alta de la un prieten)... Atunci,
m-am hotãrât: am luat PC-ul ºi l-am închis
într-un dulap. M-am simþit ca un cãpcãun,
fiindcã ºtiu ce importante sunt e-mail-ul ºi
mesageria instantanee pentru adolescenþi,
ºi mi-a displãcut enorm cã trebuie sã-l
privez de aceste facilitãþi. Însã a fost o acþi-
une reuºitã, fiindcã a ajuns sã recunoascã
faptul cã nu se poate controla ºi cã trebuiau
luate mãsuri drastice."

Nimeni nu poate sã garanteze cã aceastã
metodã va funcþiona în fiecare caz. Sau cã
este modalitatea cea mai eficientã. În cele
din urmã, fiecare se cunoaºte cel mai bine
pe sine, iar pãrinþii sunt cei care îºi cunosc
cel mai bine copiii ºi ºtiu cum sã-i punã la
punct.

În final, recomand totuºi multã mode-
raþie ºi înþelepciune din partea pãrinþilor în
tratarea acestei probleme, iar gamerilor -
jocuri cât mai incitante ºi mai puþin vio-
lente! ;) �

LLaauurreennþþiiuu  BBaannccuu  

laurentiu@myc.ro  



Când ne chemi sã-þi mutãm calcula-
torul, asigurã-te cã l-ai lãsat

îngropat sub o juma' de tonã de cãrþi
poºtale, poze de-ale copiilor, animale
împãiate, flori prãfuite, cornuri uscate ºi
dosare pãtate cu cafea. Noi nu avem o
viaþã personalã ºi suntem adânc miºcaþi
când putem trage o ocheadã fugarã prin
viaþa ta.

Nu nota nimic. Niciodatã. Putem sã
redãm mesajele tale de eroare de la

noi.

Când un informatician spune cã vine
la tine, du-te bea o cafea. În felul

acesta nu vei fi acolo când vom avea
nevoie de parola ta. Pentru noi, memo-
rarea a 700 de parole de screen-saver e
floare la ureche. Când ne suni, spu-
ne-ne ce doreºti sã faci, nu ceea ce te
împiedicã sã faci acel lucru.

Nu avem nevoie sã ºtim cã nu poþi
folosi programul cutare, pentru cã

amãrâtul de calculator al tãu nici mãcar
nu porneºte. Sau mai bine: când ne
suni, nu ne spune deloc de ce ne chemi
la tine. La ce ne-ar putea folosi? 

Când un informatician e la biroul lui
si mãnâncã, intrã drept înãuntru ºi

varsã-þi of-ul. Existãm doar pentru a
sluji.

Când copiatorul nu funcþioneazã,
cheamã imediat informaticianul.

Doar conþine componente electronice!

Când un informatician îþi spune cã
imprimantele nu au cartuº în ele,

sustine-þi punctul de vedere. Savurãm
argumentele relevante.

Când un informatician îþi spune cã va
veni în scurt timp, rãspunde cu un

ton aspru: "ªi cam câte luni înþelegi tu
prin scurt?" Acest lucru ne motiveazã.

Când imprimanta nu vrea sã
tipãreascã, retrimite documentul de

cel puþin 20 de ori. Deseori, docu-
mentele dispar în gãurile negre. Dacã
imprimanta nu tipãreºte nici dupã 20 de
încercãri, trimite documentul la toate
celelalte 68 imprimante din instanþã.
Una din ele trebuie sã funcþioneze!

Nu învãþa nici un termen tehnic.
Când spui "Nu-mi merge chestia

aia", ºtim exact ce vrei sã spui. Dacã firul
de la mouse continuã sã îþi dea jos poza
înrãmatã a câinelui tau, ridicã calcula-
torul ºi înghesuie firul sub el. Firele de
mouse au fost fãcute sã reziste la 20 kg.

Când un informatician îþi trimite un
mesaj foarte important, ºterge-l

imediat. Erau doar teste. 

Dacã tasta spaþiu nu mai
funcþioneazã, aruncã vina pe vari-

anta nouã de program. De fapt, tasta-
turile savureazã foarte mult kilogramul
de firimituri ºi de unghii dinãuntru.

Dacã primeºti un mesaj care spune
"Are you sure ?", fã cât de repede

poþi clic pe butonul Yes. La naiba, dacã
n-ai fi sigur, atunci nu ai face ceea ce
faci, nu ?!

Simte-te liber sã spui lucruri de genul
"nu mã pricep la porcãriile astea de

calculatoare". Nu ne supãrãm când
auzim cã se face referire la domeniul
nostru de expertizã profesionalã ca fiind
porcãrie.

Când vrei sã schimbi cartuºul la im-
primantã, cheamã-þi informaticia-

nul. Schimbarea unui cartuº de impri-
mantã este o sarcinã extrem de com-
plexã ºi se recomandã ca ea sã fie execu-
tatã doar de un inginer licenþiat în fizica
nuclearã.

Nu nota nimic din ceea ce te
învãþãm. Ne place sã repetãm la

infinit aceleaºi lucruri.

Când ne semnalezi cã nu ai acces în
reþea, jurã-te cã ai introdus parola

corectã. Calculatoarele o iau razna dese-
ori.

În loc sã ne spui ce s-a întâmplat,
spune-ne doar cã "a disparut chestia

aia deºi n-am fãcut nimic".
Calculatoarele se aseamãnã cu
Triunghiul Bermudelor, iar nouã ne plac
misterele!
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CCee  ttee  rrooaaggãã  uunn

iinnffoorrmmaattiicciiaann::

Lucrezi, cumva, în departamentul informatic al firmei? Adicã, eºti “ããllaa  ccuu  ccaallccuullaattooaarreellee”? 

MyC îþi vine în ajutor ;-) Fã niºte fotocopii dupã aceastã paginã ºi afiºeazã-le la vedere prin birourile

colegilor tãi. Sau, pur ºi simplu, fã o copie în fomat MARE ºi afiºeaz-o pe uºa propriului tãu birou.














